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1 InPower™ Software License
Agreement
IMPORTANT NOTICE -- READ CAREFULLY: InPower software ("InPower") is owned by
Cummins Power Generations and is used to monitor and control power generation systems by
authorized users. This License Agreement ("License") governs the use of InPower which may
be provided via various mediums or in a downloadable form herefrom. By downloading,
installing, copying, or otherwise using InPower, You ("Licensee") agree to be bound by the
terms of this License. If you do not agree to the terms of this License, do not download, install,
copy, or otherwise use InPower in any manner or form.

RECITALS:

WHEREAS, Cummins Power Generation and Licensee desire to establish a relationship
pursuant to which Licensee will obtain certain rights from Cummins Power Generation with
respect to InPower, and Cummins Power Generation will provide certain information and
updates to Licensee, all for the mutual benefit of Cummins Power Generation and Licensee;
THEREFORE, in consideration of the above premise and the mutual covenants contained
herein, Cummins Power Generation and Licensee agree as follows:

1. License Grant and Restrictions

a. Cummins Power Generation hereby grants to Licensee a non-exclusive, non-
transferable and non-sublicensable license to use InPower to monitor and control
power generation systems manufactured or sold by Cummins Power Generation.
Each copy of InPower is specifically licensed for use in a single facility of Licensee for
its intended purpose, and it may not be sublicensed, sold, or otherwise distributed.

b. Licensee agrees to use InPower and any updates to InPower in strict accordance with
Cummins Power Generation's published service practices and/or product warranty
guidelines for the sole purpose of setting up, servicing and maintaining power
generation systems manufactured or sold by Cummins Power Generation.

c. Licensee acknowledges that Cummins Power Generation may, at its option and at no
cost to the Licensee, provide updates to InPower so that the most current version of
InPower is used to monitor and control power generation systems. Cummins Power
Generation may also offer for sale upgrades of InPower which the Licensee is under
no obligation to purchase.

d. All rights relating to InPower not specifically granted to Licensee pursuant to this
Agreement shall be retained by Cummins Power Generation.

e. Licensee acknowledges that InPower may include software that Cummins Power
Generation has obtained or licensed from a third party, and Licensee agrees that the
terms and conditions of this License shall be applicable to any such third party
software. Licensee agrees to abide by any additional or modified terms and conditions
with respect to such third party software if reasonably requested in writing by
Cummins Power Generation and/or the third party.

2. Markings

Licensee shall use its best efforts to preserve all copyright, trademark, ownership or other
notices, legends or markings on InPower as originally provided by Cummins Power
Generation. In the event InPower contains any copyright or other message imbedded
therein, Licensee shall not modify or remove such embedded message.
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3. Title

Title and full ownership rights to InPower and any updates thereto, including all copyrights
therein, shall remain with Cummins Power Generation and/or its subsidiaries. Cummins
Power Generation expressly retains all rights that it may have under U.S. or foreign laws or
international treaties relating to InPower, except for those rights expressly granted to
Licensee herein.

4. Licensee Expenses

Costs and expenses incurred by Licensee relating to any use of InPower, or any other
costs not specifically agreed upon by the parties in writing, shall be responsibility of
Licensee.

5. Payment

The Sales Price does not include any federal, state, local or other governmental taxes, or
other tariffs which may be imposed on the sale, transportation, production, storage, or
export of InPower. Any and all such taxes and costs shall be paid by Licensee and
Cummins Power Generation shall have no liability therefore.

6. Updates and Maintenance

a. Cummins Power Generation agrees to provide reasonable free support for the current
version and the latest prior version of InPower at hours, and or terms and conditions,
determined solely by Cummins Power Generation.

b. In the event of an error or defect in InPower or periodic update thereto, Cummins
Power Generation agrees to repair or remedy such errors or effects which Cummins
Power Generation deems necessary. Licensee shall, promptly upon discovery thereof,
notify Cummins Power Generation, in writing, of any errors or defects in InPower
and/or periodic update thereto. Cummins Power Generation shall use its best efforts
to remedy or repair such errors or defects, devoting reasonable resources to such
task in view of the particular business situation and customer need.

7. No Modification by Licensee

Licensee agrees not to reverse engineer, translate, reverse assemble, reverse compile,
adapt, alter, modify or change in any way InPower, or any update thereto, without the prior
written authorization of Cummins Power Generation.

8. Warranties

Cummins Power Generation warrants that InPower shall be delivered free of any rightful
claim of infringement of any copyright, trademark, trade secret or other proprietary right of
any third party, provided that prompt notice of, and control over, such claim is provided to
Cummins Power Generation by Licensee. In the event of such claim, Cummins Power
Generation may, at its sole option, defend the claim, procure for Licensee the continued
rights as described herein, modify InPower so the claim is avoided without reduced
functionality, or refund Licensee's sales price paid. Cummins Power Generation's option
shall be its sole obligation and Licensee's sole remedy in such event.

9. Warranty Disclaimer

InPower and any and all updates thereto are licensed “As Is" with the exception of the
warranties specifically provided herein. Cummins Power Generation does not claim and
does not warrant that InPower will run error free. WITH THE EXCEPTION OF THE
WARRANTIES PROVIDED HEREIN, CUMMINS POWER GENERATION DISCLAIMS ALL
WARRANTIES, EITHER EXPRESS OR IMPLIED, REGARDING INPOWER, ITS
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MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR PURPOSE, AND
CUMMINS POWER GENERATION WILL NOT OTHERWISE BE LIABLE FOR INDIRECT,
INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM LICENSEE'S USE
OF INPOWER OR FOR ANY ERROR OR DEFECT IN INPOWER. CUMMINS POWER
GENERATION'S NET LIABILITY TO LICENSEE SHALL NOT EXCEED THE TOTAL
AGGREGATE PAYMENTS BY LICENSEE TO CUMMINS POWER GENERATION WITH
RESPECT TO INPOWER.

10. Government Licensee

If Licensee is acquiring InPower as, or on behalf of, a unit of the United States
Government, the following provisions shall be applicable: The Government acknowledges
and agrees that InPower and documentation relating thereto were developed at private
expense and no part of InPower or documentation relating thereto is in the public domain.
The Government acknowledges Cummins Power Generation's representation that InPower
is “Restricted Computer Software" as that item is defined in Clause 52.227-19 of the
Department of Federal Acquisition Regulation Supplement (DFARS). The Government
agrees that:

a. If InPower is supplied to the Department of Defense (DOD), InPower is classified as
“Commercial Computer Software" and the Government is acquiring only “restricted
rights" in InPower and documentation relating thereto as that term is defined in Clause
252.227-7202-3 of the DFARS, and

b. If InPower is supplied to any unit or agency of the United States Government other
than the Department of Defense, the Government's rights in InPower and
documentation relating thereto will be defined in Clause 52.227-19(b)(2) of the FAR.

11. Confidentiality

a. Licensee hereby acknowledges that InPower and periodic updates thereto contain
valuable information belonging to Cummins Power Generation that Cummins Power
Generation considers “confidential". Consistent with the purpose of this License,
Licensee agrees to use its best efforts not to release, disclose or otherwise permit
unauthorized access to such confidential information.

b. Cummins Power Generation and Licensee agree to clearly mark written materials as
"confidential" if they are to be treated as confidential. Verbal communications that are
confidential in nature will be identified as so before, during or immediately after the
communication.

c. Licensee agrees to ensure that all individuals who are provided access to InPower
under this License are bound by this nondisclosure convenant.

12. Termination of Agreement

a. Cummins Power Generation may terminate this License at will for any reason
whatsoever, furthermore this License will automatically terminate if Licensee fails to
comply with any of the terms and conditions herein. In the event Licensee attempts to
continue to use InPower after termination of this License, Cummins Power Generation
reserves the right to restrict, limit, and otherwise void warranty claims associated with
any Cummins Power Generation product associated therwith and reserves its rights to
all other legal remedies.

b. Defensive Suspension. If Licensee commences or participates in any legal proceeding
against Cummins, then Cummins may, in its sole discretion, suspend or terminate all
license grants and any other rights provided under this License during the pendency
of such legal proceedings.
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c. In the event of termination of this License, all rights granted by this License shall
revert to Cummins Power Generation. Upon termination of this License, Licensee will
deliver to Cummins Power Generation all material furnished by Cummins Power
Generation pertaining to InPower and will also warrant that all copies thereof have
been returned to Cummins Power Generation or destroyed.

d. In the evnet of termination of this License, Licensee shall remain obligated with
respect to ther provisions of this License relating to confidentiality of information.

13. Completeness

Licensee and Cummins Power Generation agree that this License constitutes the complete
License and understanding between the parties relating to InPower and updates thereto.
This License supersedes all prior agreements, understandings, and negotiations whether
written or verbal with respect to the subject matter thereof. This License can only be
modified by a written agreement signed by both parties.

14. Export Regulations

Licensee understands that the Export Administration Regulations of the Department of
Commerce of the United States may prohibit the export of InPower to certain countries and
agrees to conform to those regulations. Licensee shall indemnify Cummins Power
Generation against any loss related to Licensee's failure to conform to those regulations.

15. Governing Law

This Agreement shall be governed by and construed in accordance with the laws of the
State of Indiana, United States of America and NOT the UNCISG. To the extent required in
order to comply with the laws and regulations of any country in which InPower is distributed
or used, the terms and conditions of this Agreement shall be construed to most nearly
effectuate the purposes of the License as set forth herein. If any provision of this License
shall be held to be unenforceable, such holding shall not affect the enforceability of any
other provision hereof.

16. Attorney's Fee's

In the event of any legal action or other proceeding that is brought about to enforce this
License, the prevailing or successful party shall be entitled to recover reasonable attorneys'
fees as well as other costs incurred in that action or proceeding in addition to any
compensation to which it may be entitled as a result.

17. Agreement Successors and Assigns

The terms and conditions of this License shall inure to the benefit of and enforceable by
Cummins Power Generation and the successors and assigns of Cummins Power
Generation's interest in this License and/or Cummins Power Generation's ownership of
InPower.
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2 Introduction

2.1 Warning
Electrical equipment and engines present hazards that can result in property damage, severe
personal injury or death. The InPower tool is for use by trained and experienced technicians
only. Refer to important Safety Instructions in the equipment's Operator and Maintenance
manuals.

WARNING: Electrical equipment and engines present hazards that can result in property
damage, severe personal injury or death. The InPower tool is for use by
trained and experienced technicians only. Refer to important Safety
Instructions in the equipment's Operator and Maintenance manuals.

2.2 InPower
InPowerTM is a Windows-based service, maintenance and diagnostic tool. This tool provides
electronic service functions including: adjustments for trims and settings, monitoring, strip chart,
data logging, viewing faults, and report capability.

NOTE: PowerCommand is a registered trademark of Cummins Inc.

The InPower tool also can be used to save a device's trims and settings to a file. The stored
settings can be viewed off-line and they can be used to configure multiple installations of the
same application controller type.

Each copy of InPower is packaged and installed separately. No more than one InPower product
can be installed on the same PC.

After successful completion of InPower version 9.5 and later versions, the tool must be
registered and set up before it can be used. The user is prompted to register the product the
first time InPower is started.

For detailed registration information, refer to the Registration and License Renewal Instruction
Sheet (A030X097).

2.2.1 Commercial Products
InPower is available in two kits, one with calibration download capability and one without
calibration download capability. Each product is packaged and installed separately, and each
one has a unique serial number and registration password, to provide software security.

Refer to the recommended system hardware and software. Installing and using InPower
requires experience using the Windows operating system.

The service PC, running InPower, is connected to the device via an RS-232 serial
communications null-modem cable. (With InPower, the term device is used to describe an
application controller, like a PowerCommand® genset control). Figure 1 illustrates the typical
method used to connect a service PC to different device types.

NOTE: The pin configuration for Cummins null-modem cables is included in Section
2.2.3. Be sure to use a null-modem cable that matches this configuration (the
9th pin on the DB9 female-to-female serial cable must not be connected).

901-0108 (Issue 10) 5
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The serial cable is connected to the (COM) port on the PC with a DB9 connector. The other end
of the serial cable is connected with either a DB9 connector or a 9-Pin Deutsch connector,
depending on the application.

FIGURE 1. TYPICAL INPOWER SERIAL CONNECTION METHODS

2.2.1.1 Interface Harness Kits for Commercial Products

Controller Required Kit/Part

PS 0500, PCC 1300, PCC 1301, PCC 1302, PCC 2300, PCC 3300, MCM 3320 541-1199

PCC 3100 3164721

PCC 1300, PCC 2100, PCC 3200 (DB9-to-DB9) 3163768

PCC 3200 (DB9-to-9-pin Deutsch) 3163156

NOTE: Your version of InPower may not support all of these devices.

2.2.2 Consumer Products
The service PC, running InPower, is connected to the genset control via an RS-232 serial
communications harness. Figure 2 illustrates a method used to connect a service PC to a RV
genset.

The harness is connected to the (COM) port on the PC with a DB9 connector. Some gensets
also require the use of an RS-232 to RS-485 converter. For RV installations, the other end of
the serial cable is connected to the device (for example, the generator set). For Marine
installations, the other end of the serial cable is connected with an 8-pin connector to the
generator set and an 8-pin connector to the remote connection.

6 901-0108 (Issue 10)
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FIGURE 2. TYPICAL INPOWER SERIAL CONNECTION METHOD

2.2.2.1 Interface Harness Kits for Consumer Products

TABLE 1. INTERFACE HARNESS KITS FOR CONSUMER PRODUCTS

RS-232 to RS-485Model/Device Fuel Type Required Kit Converter

HDKAx (Starting with Spec K) and Diesel 541-1374 YesHDKAW

810HQD, 1215HQD, and Diesel 541-1374 Yes1218HQD

DKHA Diesel 541-1374 Yes

HDKAx (Prior to Spec K), HDKBx, Diesel 541-1287 Noand HDKCx

HGJAA, HGJAB, HGJAC,
HCJAD, HGJAE, and HGJAF Gasoline/LPG 541-1287 No(Units with controls built in 2005
or later, up to Spec E)

HGJAA, HGJAB, HGJAD, HJGAE Gasoline/LPG 541-1374 Yes(Starting with Spec J)

HGJBB Gasoline/LPG 541-1374 Yes

MDKBH - MDKBS and MDDCx Diesel 541-1289 Yes

MGKBx (Starting with Spec C) Gasoline 541-1289 Yes

GSXX Natural Gas/Propane 541-1374 Yes

KY and MKY Gasoline/LPG 541-1287 No

MDDCx and MGKBx Gasoline or Diesel 541-1289 Yes

HQGMx Gasoline/LPG 541-1374 Yes

HJBAA NA 541-1374 Yes

MDKBx and MDDCx Diesel 541-1289 Yes

Network Interface Module (NIM) NA

PCC1301 NA 0541-1199 Yes

901-0108 (Issue 10) 7
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RS-232 to RS-485Model/Device Fuel Type Required Kit Converter

PCC1302 NA 0541-1199 Yes

HMI211RS NA 0541-1199 Yes

RV/CM Display NA 541-1374 Yes

Marine Display NA 541-1289 Yes

All Gasoline or Diesel 541-1389 Yes

2.2.3 Null Modem Cable Configuration

FIGURE 3. NULL MODEM CABLE CONFIGURATION

2.3 About This User's Guide
This User's Guide covers installation and operation of the InPower service tool. Last minute
software changes and corrections may be found in the InPower ReadMe file.

2.4 Supported Devices
This version of InPower supports the following devices:

· Dominion (PCC3200)

· PCC3200 with CAN

· Operator Panel

· PCC 3100

· ATS(PCATS)

· Dynasty (PCC2100)

· PCC1100
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· PCC1100 LCD(PCC 1100 User Interface)

· GCP PCS

· NonGCP PCS

· PCC1300

· PCC 1300 User Interface

· Annunciator(HMI 113)

· MCC3320

· PCC1301

· AUX101(Auxillary I/O Device)

· HMI 112

· HMECM(AUX105)

· PCC2300

· HMI211

· HMI3320(HMI211 MCM3320)

· ECM 850(Core II ECS)

· ECM 2150(Core II ECS)

· PCC1302

· HMI220(HMI320)

· HMI320(HMI320)

· HMI 114

· PS 0500

· PCC2300V2(PCC2300)

· HMI321

· AUX 101LBNG(Auxillary I/O Device)

· QD75_OTP(Read-only ConDvc)

· RavenValue_OTP(Read-only ConDvc)

· RavenPremium(Read-only ConDvc)

· Microquiet_OTP(Read-only ConDvc)

· Ranger & QDSA(Read-only ConDvc)

· Equinox/RVInverter(HJBAA)

· MerlinLCD

· Equinox LCD(HJBAA LCD)

· Marine

· NIM

· RaptorECM(HQDECM)

· RaptorTS(HQDTS)
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· RaptorLCD(HQDLCD)

· QD1012(HDKC)

· Marquis(Marquis Premium)

· Raven Commercial

· QD55

· HWSet_A(Generic)

· HQD Inverter(HQDInverter)

· QD75(HDKAJ)

· QDSA(HDCA)

· Raven485

· Generic device (Generic485)

· APU LCD

· GENERICINV4KW

· APU(DKHA)

· Stealth

· Stealth LCD(GSAALCD)

· APU DPF LCD(APUDPFLCD_96)

· Coyote

· Generic CommMobile(GeCommMobile)

· MARINE3LCD(MARINE3LCD)

· Razor(QG1012)

· EC30W Genset Module(EC30WGenmod)

· EC30W Display(EC30WDisplay)

· GENERICUMC3(GENERICUMC3)

· MARINE3(MARINE3)

· Annunciator

· CCMT

· CCMG

· DIM

2.5 System Requirements
2.5.1 Recommended PC

The following are the recommended laptop PC specifications.

· An IBM PC or 100% compatible PC
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· Recommended Operating System: Windows XP Pro, Windows Vista, Windows 7, or
Windows 8 (see details below)

· Windows Vista Capable or Windows Vista Premium Ready

TABLE 2. OPERATING SYSTEMS

Windows XP Pro Windows Vista Windows Vista Windows 8 or
Capable* Premium Ready* or windows 8.1

Windows 7**

Processor 500 MHz 800 MHz 1 GHz 1 GHz

Memory 256 MB RAM 512 MB RAM 1 GB RAM 1 gigabyte (GB) (32-
bit) or 2 GB (64-bit)

Graphics Card - DirectX 9.0 DirectX 9.0 capable Microsoft DirectX 9
and WDDM 1.0 driver graphics device with
support WDDM driver

Graphics Memory - 32 MB RAM 128 MB RAM (1920 x Up to 1792 MB (1366
1200 resolution) or x 768 resolution)
512 MB+ for greater recommended
resolution such as
2560 x 1600

Hard Drive Capacity 1.5 GB 20 GB 40 GB 40 GB

Hard Drive Free - - 15 GB 15 GB
Space

Other Drives - - DVD-ROM DVD-ROM

Audio - - Audio output Audio output

* Only 32-bit Windows Vista is supported. 64-bit Windows Vista is not supported.

** Both 32-bit and 64-bit Windows 7, windows 8 and 8.1 are supported.

· Microsoft Internet Explorer version 8.0 or higher

· SVGA (1024x768) color display

· Windows compatible pointing device and 101 key enhanced keyboard

· 16X CD-ROM

· One free serial communications port

· Serial to USB communications port

· Windows compatible printer (optional)

NOTE: Please note that InPower version 7.5 and higher does not support the
Windows 95, Windows 98, Windows 2000, or Windows NT operating systems.

NOTE: Windows Vista requires the use of Adobe Acrobat 8 or newer.

2.5.2 Administrative Rights
Administrative rights are required for every installation and uninstallation.
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2.6 Program Directories Installed with InPower
When InPower is installed, the InPower setup wizard creates several directories (folders) that
are used by various features in InPower. You might want to look in these directories as you use
the associated features.

The locations of these directories depend on two selections made during installation. If you do
not know what these selections were, the default locations are shown in the following table.

TABLE 3. DEFAULT LOCATIONS OF PROGRAM DIRECTORIES

Description Default Location

Folder in which InPower is installed D:\Program Files

Folder in which strip chart and monitor files are stored D:\Program Files\InPower

The strip chart and monitor directories are created in the folder that is selected during
installation. Other directories are created in the <selected folder>\Power Generation\Shared
folder.

The installation error message shown below is displayed if a restricted path is selected.

FIGURE 4. INSTALLATION ERROR MESSAGE

InPower cannot be installed in usage-restrictive folders on Windows 7 or Windows VISTA.
Usage-restrictive folders include:

· C:\

· C:\Program Files

· C:\Windows

If any of the above paths are slected for installation, the error message displayed includes
suggested alternate paths.
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If the D:\ drive, (the default location) is not available, another folder on the C drive can be used,
as long as it isn't one of those mentioned above. For example, InPower can be installed in one
of the following locations.

· C:\ETools

· C:\Cummins

· C:\InPowerPro

· C:\Service Tool

A folder with your preferred name will need to be created before installing InPower. When
installing InPower, the default installation path "D:\Program Files" is displayed as shown below.
To select a different location, click on the Browse button and navigate to the appropriate folder
and click OK.

FIGURE 5. INSTALLATION DESTINATION LOCATION DIALOG

InPower cannot be installed on an external drive. If there is an attempt to install InPower on an
external drive a message is displayed.
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FIGURE 6. MESSAGE FOR ATTEMPTED INSTALLATION ON EXTERNAL DRIVE

The user must have write access to the installation directory.

When the Tool Registration starts, the Welcome to the Tool Registration Wizard window
shows:

FIGURE 7. WELCOME TO THE TOOL REGISTRATION WIZARD WINDOW

If the user does not have write access to the installation directory when Next is selected for
Manual or Web Registration, then a message window shows.
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FIGURE 8. MESSAGE WINDOW FOR READ-ONLY ACCESS

2.6.1 Monitor
The Monitor folder contains the Target Parameter List files (.TPL). This folder will contain one or
more .TPL files. These files support the InPower software. The user will not need to view or
access any of these files.

2.6.2 Strip Chart
The Strip Chart folder contains one or more strip chart parameter listing files (.TPL).

The files contain chart design parameters, the user will not need to view or access these files.

2.6.3 Data
The two Data folders contain data files. These files support the InPower software. The user will
not need to view or access any of these files.

2.6.4 Captured Files
The Captured Files folder stores extracted (captured) device information. Initially this folder will
not contain any files. Files are created when the user chooses to Capture to File from a
connected device (Device menu). The user names the file and InPower appends a .CAP
extension.

Captured files are read-only files. You can connect to, and view these files, but you cannot
modify the file contents. Captured files can be copied (written) to a connected device, as long as
the captured file is from the same device type.

Example: The Captured file is from a Genset controller, this file can be written to another
(connected) Genset controller. This file cannot be written to a G-Drive controller.

2.6.5 Simulator
The Simulator folder contains Captured (.CAP) files that are used to simulate a connected
device. The files are read only; however, the user can simulate editing (the changes are not
actually written to the file). The Simulator feature does not allow for simulating Edit-Save
Adjustments operations.
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2.7 Start Menu Group Shortcuts
InPower installs Start-Menu shortcuts for the InPower applications. Clicking on any one of these
shortcuts will launch the selected application.

FIGURE 9. START MENU GROUP SHORTCUTS

2.7.1 Readme File
When InPower is installed, a Readme file is copied to the Power Generation group. This file
contains last minute instructions for using InPower. Open and review these instructions after the
initial software installation.

2.8 User Interface
The InPower software operates in the Windows graphical environment and is compatible with
Windows. You can access the system like any other Windows application. If you are unfamiliar
with Windows, or have questions, refer to the Microsoft Windows User's Guide for your specific
operating system, or click on Help, from the Windows Start menu, to view the Windows Help
Topics.

All system commands are accessible by mouse and keyboard. Frequently used commands
have keyboard shortcuts and tool bar access.

InPower uses the Windows Explorer tree hierarchy for navigating a connected file or device
(referred to as Device Explorer, in InPower).

The tool's main window displays a Menu Bar and a Toolbar for access to the tool's functions.
Only commands applicable to the current active window are enabled, all other commands from
the Menu Bar or Toolbar are grayed out.
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2.9 How to Get Service
If you are having a problem with the software, follow these steps.

1. Write down what you can about the problem.

2. Determine whether or not the problem can be repeated.

3. Write down the software version. (This can be found in the Help-About window.)

4. Contact your distributor.

Distributors should contact Cummins Power Generation using standard channels.

2.10 Notification of Tool Expiration
A tool expiry notification message is displayed to inform InPower users that their license is
about to expire. The message, such as "InPower Pro will exire on Mmmm dd, yyy," is
automatically generated by the InPower software. The message snoozes, based upon the
frequency set up by the user. When displayed, users should prepare for upgrading the
subscription.

FIGURE 10. TOOL EXPIRY NOTIFICATION MESSAGE

FIGURE 11. TOOL EXPIRY NOTIFICATION MESSAGE - 15 TO 30 DAYS
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FIGURE 12. TOOL EXPIRY NOTIFICATION MESSAGE - 15 OR FEWER DAYS

NOTE: This expiry notification is mainly intended for non-Cummins users because
they need to renew the InPower software license. All registered Cummins
users will automatically be upgraded to a new release of InPower by SCCM.
Any new Cummins users should request InPower from the Software Shelf.
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3 Setup
The Setup dialog allows the installer, or System Administrator, to set user preferences and
make changes to both Sites and Devices.

NOTE: If you attempt to access the Setup program while InPower is running, the
message “Initialization mode failed" is displayed. Make sure InPower is not
running before accessing the Setup program.

3.1 General Setup
The Setup feature can be accessed from the Start menu (Start -> All Programs -> Power
Generation -> Setup).

Four Setup tabs are displayed; the Unit of Measurement tab is the default tab selection. To
select another tab, click on the desired tab. When the Site Setup tab is selected, clicking on an
item from the Site List will add a button, named Device Setup.

The Communications tab is used in genset applications to configure the service PC for remote
communications.

If you need to set up another COM port, refer to Create Site.

3.2 Unit of Measurement
This feature allows selection of a list of pre-defined units of measure, based on their region or
country. InPower will convert and display values according to the units of measure selected
from the System Of Measurement drop down list.

Users can create their own list by entering a name in the System of Measurement dialog. To
customize a setup, select individual Unit Descriptions, by Unit Type, from the drop down lists.
Click on the Apply button to save the changes.
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FIGURE 13. SETUP DIALOG - UNIT OF MEASURE

3.3 User Setup - System Administration
The System Administration feature (User Setup) allows a person using the Windows logon (with
System Administrator privileges) to establish a user profile for each user on the system. After
the initial setup, only the System Administrator will have access to the User Setup dialog.

NOTE: By default, the user will be set up as system administrator the first time they
launch the program. After this intial launch, the user will have the ability to
change this setting to different access levels if desired.

Three access levels are available as follows:

Read Only: User can connect to a device and read all parameter settings, fault information and
history records.

Read/Write: User has full use of all InPower features, including making adjustments.

Administrator: Administrator has full use all InPower features and the ability to establish and
maintain user privileges for all users on this PC.

3.4 Capture File Options
The User Setup dialog allows the user to set their preference to either automatically create a
capture file each time they connect to a device or to be prompted before creating a capture file.
Click inside the checkbox next to the desired setting then click on the OK button. See Figure
14.
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FIGURE 14. USER SETUP

3.5 Site Setup
The Site Setup dialog allows the user to Add, Remove or edit either a port or a file (Figure
15).
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FIGURE 15. SITE SETUP DIALOG

To add a file or port, click on the Add button. The Create Site dialog is displayed. For more
information, see Section 3.6 on page 23.

To remove an item from the Site List, select the item and click on the Remove button. A popup
will be displayed to prompt you to continue (Yes) or cancel this operation (No) (Figure 16).
Click on the Yes button to remove the item, or click on the No button to cancel the removal.

FIGURE 16. REMOVE DEVICE DIALOG
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Selecting a site from the Site List enables the edit feature, allowing modifications to some item
properties. When a file is selected, the file location (path) is displayed. This feature allows the
user to edit the file location.

When a site is selected, the sites protocol and COM port can be edited. Also the Device Setup
button is enabled. This feature allows the user to add or remove devices.

Use the Apply button to save the data in the current dialog box to the InPower settings. Use the
Cancel button to close the Site Setup dialog without saving any changes made during this
session. Use the OK button to accept the existing settings. The Help button is used to access
help regarding the Site Setup dialog.

COM ports can be added or changed by clicking on Click here to view all available COM
ports on the Site Setup dialog. When the List of COM Port dialog is displayed, select a port
from the available list and click OK.

FIGURE 17. COM PORT LIST

3.6 Create Site
When the user selects the Add button, the Create Site dialog appears (Figure 18). This dialog
allows the user to select a Site Type, Site ID, Protocol, Location, and Name (or Device Type
and Path for files).

NOTE: All consumer devices will support generic device connections only. To create
a site as a 'consumer device' use the 'add site' menu provided in the 'Tools'
setup. Existing sites that were created previously will continue to be
supported.

Use each of the dialog fields as follows:
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Site Type - Use Physical for devices, File_A for capture files, or Network for connection to
multiple devices. Network sites are available only if the RS-485 adapter is used to connect to
the genset. A Physical connection connects to all devices and is the recommended site type for
basic tool operation.

NOTE: Initial and Update Calibration features are disabled when the Site Type =
Network.

Site ID - Typically use the name of the COM port for devices and the file name type (such as
Capture File) for files.

Protocol - Select goal as the protocol for all devices and Capture for files.

Location - Use Local.

COM Port/Path: - Enter the COM port for devices and the directory path for files. You can use
the link above it to look for available COM ports.

NOTE: To use COM3 or COM4 with InPower, use the following example to create
them and to add them to the Site List.

FIGURE 18. CREATE SITE DIALOG

The following example describes how to add a new COM port.

Example: To add a COM3 port, click on the Add button in the Site Setup dialog. Select
Physical from the Site Type drop-down list. Enter the Site ID.: COM3 and select the Protocol:
goal. Next enter Location: Local and the COM Port: 3. When finished click the OK button to
save the entries. The new port will be added to the Site List.

Once the port is established, you can setup a device for the port (Device Setup is covered on
the following page).
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For this example, Select COM3 in the Site List, click on the Device Setup button. Click on the
Add button to add a device for COM3. Enter the following information in the Create Device
dialog (Figure 21): Device ID: COM3, Device Name: COM3, Device Type: select pcf_dvc
from the drop-down list. Click on the OK button to enter the information.

When the OK button is selected, the new site is added to the Site List in the Site Setup dialog
and the message “Default device has been added to this site. Please click <Device Setup>
button to modify default settings" is displayed (Figure 19). Click OK to complete the setup.

FIGURE 19. DEVICE SETUP INSTRUCTIONS

FIGURE 20. DEVICE SETUP DIALOG

3.7 Device Setup
The Device Setup dialog allows the user to Add, Remove, or edit a device (Figure 20).

Selecting a device from the Device List allows the user to edit the Device Name and Type.
The dialog also displays the Site Name, that the Device is associated with.

Selecting the Add button displays the Create Device dialog (Figure 21). This dialog allows the
user to enter a new Device ID., Device Name and allows the user to select a Device Type
from a drop-down list.
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FIGURE 21. CREATE DEVICE DIALOG

Use each of the dialog fields as follows:

Device ID - Enter a name to identify the device.

Device Name - Use a generic term to describe the device (such as GCS).

Device Type - Select pcf_dvc (dominion based control system).

3.8 Communications Setup
The Communications Setup dialog (Figure 22) allows the user to have the system allow
incoming calls and to select a modem for incoming calls and remote connections.

If applicable, the user can also use this dialog to select local and remote LonWorks network
connections.

FIGURE 22. COMMUNICATIONS DIALOG

26 901-0108 (Issue 10)



12-2013 3. Setup

3.9 PCC 1300 and PCC 1301 InPower Setup
Refer to Setup for a general description of the Setup feature. Launch the Setup program from
the Start menu - Power Generation program group.

In this example, a new site will be created specifically for connecting to a PCC 1300 control.
(The PCC 1301 uses the same Site Type setting and Protocol settings.)

FIGURE 23. PCC 1300 SITE SETUP

Select the Site Setup tab and then click on the Add button, located below the Site List. Create
a new site for connecting to the PCC 1300 control. Select the Site Type: Physical, from the
drop-down list. Enter a Site ID. Select mon from the Protocol drop-down list. (PCC1301 select
PCF Device in the Protocol list.) Select Local for the Location and enter 1 (or the desired com
port) for the COM Port. Click on the OK button to create the new site.

With PCC1300 selected in the Site List, click on the Device Setup button, then click on the
Add button in the Device Setup window to create a new device.

Enter a Device ID and Device Name. Select PCC1300, from the Device Type drop-down list.
Click on the OK button to create the device. Click on the Device Setup OK button to exit the
Device Setup. Click on the Apply button to save the device setup.
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FIGURE 24. PCC 1300 DEVICE SETUP

3.10 PCC 1302 InPower Setup
Refer to Setup for a general description of the Setup feature. Launch the Setup program from
the Start menu.

In this example, a new site will be created specifically for connecting to a PCC 1302 control.

Select the Site Setup tab and then click on the Add button, located below the Site List. Create
a new site for connecting to the PCC 1302 control. Select the Site Type: Physical, from the
drop-down list. Enter a Site ID. Select mon from the Protocol drop-down list. (PCC1302 select
PCF Device in the Protocol list.) Select Local for the Location and enter 1 (or the desired com
port) for the COM Port. Click on the OK button to create the new site (Figure 25).
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FIGURE 25. PCC 1302 SITE SETUP

With PCC1302 selected in the Site List, click on the Device Setup button, then click on the
Add button in the Device Setup window to create a new device.

Enter a Device ID and Device Name (Figure 26). Select PCC1302, from the Device Type drop-
down list. Click on the OK button to create the device. Click on the Device Setup OK button to
exit the Device Setup. Click on the Apply button in the Setup dialog to save the device setup.

FIGURE 26. PCC 1302 DEVICE SETUP
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3.11 PCC 2300 and PCC 3300 InPower OEM Setup
To set up a generator set with a PCC 2300 or PCC 3300 control, select the control name from
the device list, right click and select Genset OEM Setup... to view the Genset OEM Setup
menus. An example for the PCC 2300 is shown in the following figure.

FIGURE 27. ACCESSING THE GENSET OEM SETUP MENUS FOR THE PCC 2300 CONTROL

The Genset OEM Setup menus consist of various tabs. Many parameters cannot be modified
without first clicking on the Enable Setup Mode button.

3.12 PCC 3100 InPower Setup
Refer to the information included earlier in this section for a general description of the Setup
feature. Launch the Setup program from the Start menu - Power Generation program group.

In this example a new site will be created specifically for connecting to a PCC 3100 control.

Select the Site Setup tab and then click on the Add button, located below the Site List. Create
a new site for connecting to the PCC 3100 control. Select the Site Type: Physical, from the
drop down list. Enter a Site ID. Selecting mon from the Protocol drop-down list. Select Local
for the Location and enter 1 (or the desired com port) for the COM Port. Click on the OK
button to create the new site (Figure 28).

With PCC_3100 selected in the Site List, click on the Device Setup button, then click on the
Add button to create a new device.
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Enter a Device ID and Device Name (Figure 29). Select pcc_dir, from the Device Type drop-
down list. Click on the OK button to create the device. Click on the Device Setup OK button to
exit the Device Setup. Click on the Apply button to save the device setup.

FIGURE 28. PCC 3100 SITE SETUP

FIGURE 29. PCC 3100 DEVICE SETUP

3.13 PCC 3200 w/CAN (PCC 3201) InPower Setup
Refer to Setup for a general description of the Setup feature. Launch the Setup program from
the Start menu - Power Generation program group.

In this example a new site will be created specifically for connecting to a PCC 3200 with CAN
(PCC 3201) control.

Select the Site Setup tab and then click on the Add button, located below the Site List. Create
a new site for connecting to the PCC 3200 control. Select the Site Type Physical, from the
drop-down list. Enter a Site ID. Select goal from the Protocol drop-down list. Select Local for
the Location and enter 1 (or the desired com port) for the COM Port. Click on the OK button to
create the new site (Figure 30).
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FIGURE 30. PCC 3200/CAN SITE SETUP

With PCC 3200 with CAN selected in the Site List, click on the Device Setup button, then click
on the Add button, to create a new device.

Enter a Device ID and Device Name (Figure 31). Select PCC 3200, from the Device Type
drop-down list. Click on the OK button to create the device. Click on the Device Setup OK
button to exit the Device Setup. Click on the Apply button to save the device setup.

FIGURE 31. PCC 3200/CAN DEVICE SETUP

3.14 MCM 3320 InPower Setup
Refer to Setup for a general description of the Setup feature. Launch the Setup program from
the Start menu - Power Generation program group.

In this example a new site will be created specifically for connecting to an MCM 3320 master
control.

32 901-0108 (Issue 10)



12-2013 3. Setup

FIGURE 32. MCM 3320 SITE SETUP

Select the Site Setup tab and then click on the Add button, located below the Site List. Create
a new site for connecting to the MCM 3320 control. Select the Site Type Physical, from the
drop-down list. Enter a Site ID. Select mon from the Protocol drop-down list. Select Local for
the Location and enter 1 (or the desired com port) for the COM Port. Click on the OK button to
create the new site (Figure 32).

With MCM3320 selected in the Site List, click on the Device Setup button, then click on the
Add button, to create a new device.

Enter a Device ID and Device Name (Figure 33). Select MCM3320, from the Device Type
drop-down list. Click on the OK button to create the device. Click on the Device Setup OK
button to exit the Device Setup. Click on the Apply button to save the device setup.

FIGURE 33. MCM 3320 DEVICE SETUP
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3.15 Monnet InPower Setup
Refer to Setup for a general description of the Setup feature. Launch the Setup program from
the Start menu - Power Generation program group.

In this example a new site will be created specifically for connecting to a MONNet (PCCnet)
network.

FIGURE 34. MONNET SITE SETUP

Select the Site Setup tab and then click on the Add button, located below the Site List. Create
a new site for connecting to the MONNet. Select the Site Type Network, from the drop-down
list. Select Network Type MONNet. Enter a Site ID. Enter 1 (or the desired com port) for the
COM Port. Click on the OK button to create the new site (Figure 34).

Select the MONNet site from the site list and note that the Device Setup feature is disabled
(Figure 35). When InPower is connected to a MONNet site it automatically checks the number
of devices that are connected to the site and shows the active devices under the site.
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FIGURE 35. MONNET DEVICE SETUP

A typical connection for a MONNet application is shown in Figure 36.

FIGURE 36. MONNET CONNECTION

3.16 HMI InPower Setup
Refer to Setup for a general description of the Setup feature. Launch the Setup program from
the Start menu - Power Generation program group. The Setup for HMI220 and HMI320 control
panels is similar to what is shown.

In this example a new site will be created specifically for connecting to an HMI 211 (bargraph
display).
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FIGURE 37. HMI SITE SETUP

Select the Site Setup tab and then click on the Add button, located below the Site List. Create
a new site for connecting to the HMI. Select the Site Type Physical from the drop-down list.
Enter a Site ID. Select mon from the Protocol drop-down list. Select Local for the Location
and enter 1 (or the desired com port) for the COM Port. Click on the OK button to create the
new site (Figure 37).

With HMI 211 selected in the Site List, click on the Device Setup button, then click on the Add
button, to create a new device.

Enter a Device ID and Device Name (Figure 37). Select HMI211 from the Device Type drop-
down list. Click on the OK button to create the device. Click on the Device Setup OK button to
exit the Device Setup. Click on the Apply button to save the device setup.

FIGURE 38. HMI DEVICE SETUP
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This section describes InPower's user interface features.

4.1 How to Start InPower
1. Open the Start menu.

2. Click All Programs > Power Generation > InPower Lite > InPower Lite.

Attempting to launch InPower or the Bravo Setup when one of these programs is already
running will result in an error message.

· If an attempt is made to run a second instance of Bravo Setup (Start > All Programs >
Power Generation > Setup), the following message is displayed.

FIGURE 39. BRAVO SETUP MESSAGE FOR WHEN BRAVO SETUP IS ALREADY IN USE

· If InPower is launched and then an attempt is made to launch Bravo Setup (Start > All
Programs > Power Generation > Setup while InPower is still running), the following
message is displayed.

FIGURE 40. INPOWER IS RUNNING MESSAGE FOR WHEN ATTEMPTING TO USE BRAVO SETUP

· If the Bravo Setup is launched and then an attempt to launch InPower is made while Bravo
Setup is still running, the following message is displayed.
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FIGURE 41. BRAVO SETUP IS RUNNING MESSAGE FOR WHEN ATTEMPTING TO USE INPOWER

4.2 The Main Window
The main window, named Device Explorer, includes the Menu Bar, the Toolbar, the Status
Bar, and the left and right window panes.

The Menu Bar contains the groups of commands that are used to access tool functions and
features. A list of menu options is available under each main menu entry.

The InPower Menu Bar expands to display additional menu features when InPower is
connected to a device or a file.

When a Menu Bar command is grayed (dimmed), the command is not available. You may need
to select another action (such as connecting to a port or device) before the grayed command
will be displayed in black type—indicating that the feature is available.

· To display the list of options under a menu entry, move the mouse pointer to the menu
name and click on the mouse button. (Clicking refers to using the mouse select button,
typically the left button.)

· To select an option from a menu list, move the mouse pointer to the option name and click
on it.

The Toolbar provides direct graphical interface shortcuts to some of the more frequently used
menu options. Buttons on the Toolbar represent frequently used tool functions.

When a Toolbar button is grayed (dimmed), the shortcut to that command is not available. You
may need to select another action (such as connecting to a device or file) before the grayed
command will be displayed in color (or black type)—indicating that it is available.

Placing the mouse pointer on a Toolbar button, the Status Bar describes the function of the
button. The Status Bar also shows a description of operations as they occur.

The left window pane works like Windows Explorer to navigate the directory tree. The right
window pane displays the contents (or screens) for the item selected in the left window pane.
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4.2.1 Main Window Example

FIGURE 42. MAIN WINDOW

FIGURE 43. STATUS BAR DETAILS

4.3 Menu Descriptions
This section provides a brief description of the functions performed by each of the InPower
menu commands. Some of the menus are not displayed until the tool is connected to a Port
(COM port or .CAP file).

Several of the menu features have Toolbar shortcuts and some features can be enabled simply
by double clicking on the item from the directory tree in the left window.
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4.3.1 Port
The Port menu allows the user to Connect to and Disconnect from a port. InPower uses the
term Port to refer to either a COM Port or a .CAP(ture) File, including Simulator files. The Port
menu also allows the user to Add a local or remote Site, find InCAL calibrations, and it has an
Exit selection for exiting InPower.

In order to connect to a COM port, the PC must be physically connected to a device via a serial
communications null-modem cable.

COM port error messages are displayed at the following times:

· In Bravo Setup when the user selects add site

· In Bravo Setup when the user selects apply

· In Bravo Setup when the user selects another site

· When the user closes bravo setup

· In Engineering Tool when the user selects add site

· In InPower Tool when the user selects add site.

The following shows an example error message:

FIGURE 44. MESSAGE DISPLAYED FOR COM PORT

4.3.2 Device
The Device menu is used to Connect to, and Disconnect from, a device, and for performing
read and write functions with a connected device. InPower uses the term device when referring
to a controller such as the generator set control.

Use InPower to change a device's trims and settings, and then use the Device menu to Save
Adjustments. The device's parameters can be Captured (saved) to a File.

The Device Menu can also be used to Clear Faults (inactive faults only) and to Prepare CSV
file with All Selected Features of the device's settings.

When the InPower service tool is connected to a device, three new features are added to the
Device menu; Initial Calibration, Update Calibration, and Update Features.
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4.3.3 Edit
The Edit menu works within the directory of the connected device to Find a specified string of
data. The Edit menu can also be used to Copy and Paste selected data.

4.3.4 View
The View menu is used to view data from the connected device in a Monitor display or Strip
Chart display. The View menu can also be used to access the FIS Fault Tree Main Window,
view faults and refresh (update) all of the parameters displayed in the Value field.

4.3.5 Help
The Help menu commands are used to find online information about using InPower and
Windows. Help is also used to display Service and Support information and to obtain InPower
product and version information. A separate Help file contains information on consumer device
fault codes for marine and RV products. The menu also allows the user to launch the
registration program.

4.4 User Interface
Frequently used commands have keyboard shortcuts and toolbar access. Only commands
applicable to the current active window are enabled. All other commands are grayed out.

4.4.1 Keyboard Access
InPower uses standard Windows keyboard conventions.

The underlined letter indicates the keyboard selection for a given menu option. For example, to
select the Port menu, press and hold the “Alt" key and type a “P" (Alt P).

Once the menu is open, type just the underlined letter to select a specific menu item. For
example, once the Port menu is open, type a (C) to select Connect.

4.4.2 Toolbar
Some frequently used commands have toolbar shortcut buttons. Each button is associated with
one or more menu items. The buttons have the same effect as the menu items.
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4.4.2.1 Toolbar Example

FIGURE 45. TOOLBAR

4.4.3 Dialog Boxes
A dialog box is a window that requires information from the user. Often, when you select a
function or menu option, the software will display a dialog box. You will then provide the
required information by selecting an item from a list, by clicking on an option button, or by
entering text. Several different dialog boxes are used with InPower.

The following rules will apply to all the dialog boxes and system messages unless specified
otherwise.

· The Cancel button allows you to close and exit a dialog box without saving any
modifications, and without executing any commands.

· The OK button allows you to save any changes made and/or execute a command and
close the dialog or message box.

All lists that the dialog boxes display are sorted alphabetically.

4.4.4 Mouse Menu Functions
In some Window views, clicking on the right mouse button will bring up a menu command
related to that Window. (Some users change the right and left mouse functions to their
preferences. The default settings for a two-button mouse are left for select and right for menu.)

Example: When viewing Faults in the Detail View, clicking on the right menu button will bring up
three choices:

· View Snapshot
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· View Fault Information

· Clear Faults

4.5 How to Terminate InPower
Should the InPower program ever hang up or crash abruptly, the Terminate InPower Application
utility can be used to close all InPower applications. After the applications are closed, InPower
can be re-launched and work can be resumed.

NOTE: This feature is not available on PCs with a Windows 2000 operating system.

To use this feature, go to Start > All Programs > Power Generation > Utilities > Terminate
InPower Application.

FIGURE 46. LAUNCHING THE TERMINATE INPOWER APPLICATION FEATURE

After the Terminate InPower Application is launched, the following message is displayed.
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FIGURE 47. TERMINATING INPOWER APPLICATIONS MESSAGE

Afer clicking Yes, all Etool applications are terminated and the following message is displayed.
Click OK.

FIGURE 48. ETOOL TERMINATION MESSAGE
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5 Genset Service
This section describes how to use InPower for making adjustments and performing tests on
commercial or consumer gensets. When the user is connected to a genset, they can also
access the Monitor, Faults, and Events Configuration features.

5.1 Commercial Genset Service
InPower performs several functions including genset service and diagnostic functions. The
Adjustment feature is used to perform service adjustments and trims.

The Test feature is used for diagnostics. Test is used to temporarily override a variety of input
and output parameters. (The PCC 3100 does not include the Test Feature).

WARNING: Electrical shock and moving parts can cause severe personal injury or death.
Notify personnel before starting a generator set and before performing load
transfer on a transfer switch. Refer to the equipment Operator's Manual for
important safety precautions.

You must be connected to the genset in order to write adjustment trims and setting changes to
the controller, and to temporary send test commands to the genset controller. The features
described may not apply to all control types.

5.1.1 Connecting to a Genset
Connection between the service PC and some gensets is made with a special RS-232 serial
null-modem cable. Some connections between the generator set and the PC require an
interface wiring harness and an RS-232 to RS-485 converter.

If the service PC does not have a serial port, a USB-to-serial converter may be required as well.

5.1.1.1 Connecting to PS 0500
The PS 0500 control requires an RS-232 to RS-485 data converter and a unique cable. Figure
49 shows the PS 0500 InPower connection.

Kit number 541-1199 is available for use with the PS 0500. The kit includes the RS-232 to RS-
485 converter and the cable used for these applications. The 5-pin connector is used to connect
to the back of the display at the TB15 connector.
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FIGURE 49. INPOWER SERIAL CONNECTION WITH POWERSTART 0500 CONTROL

5.1.1.2 Connecting to PCC 1100
The PCC 1100 requires an RS-232 to RS-485 data converter and a unique cable.
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FIGURE 50. INPOWER PRO SERIAL CONNECTION PCC 1100

5.1.1.3 Connecting to a Genset with a PCC 1300 Control
The PCC 1300 requires only a DB9 to DB9 cable connected from the PC to the control board.
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FIGURE 51. PCC 1300 INPOWER CONNECTION

5.1.1.4 Connecting to a Genset with a PCC 1301 Control
The PCC 1301 requires an interface wiring harness and an RS-232 to RS-485 converter.
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FIGURE 52. PCC 1301 INPOWER CONNECTION

5.1.1.5 Connecting to PCC 1302
The PCC 1302 control requires an RS-232 to RS-485 data converter and a unique cable. The
PCC 1302 also requires an extension harness connected from the display to the engine harness
J2 connector. Figure 53 shows the PCC 1302 InPower connection.
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FIGURE 53. KIT INSTALLATION FOR POWERCOMMAND CONTROL 1302 WITH HMI211

5.1.1.6 Connecting to a Genset with a PCC 2100 Control
The PCC 2100 requires only a DB9 to DB9 cable connected from the PC to the control board
inside the control box.

50 901-0108 (Issue 10)



12-2013 5. Genset Service

FIGURE 54. PCC 2100 INPOWER CONNECTION

5.1.1.7 Connecting to PCC2300 and PCC3300
The PCC2300 and PCC3300 controls require an RS-232 to RS-485 data converter and a
unique cable. Figure 55 shows the PCC2300 InPower connection and Figure 56 shows the
PCC3300 InPower connection.

Kit number 541-1199 is available for use with the PCC2300 and PCC3300. The kit includes the
RS-232 to RS-485 converter and the cable used for these applications. The 5-pin connector is
used to connect either to the control board or the display.
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FIGURE 55. KIT INSTALLATION FOR PCC2300 WITH HMI220 OR HMI320 DISPLAY
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FIGURE 56. PCC3300 INPOWER CONNECTION

5.1.1.8 Connecting to a PCC 3100 Genset
The PCC 3100 requires a unique cable with a DB9 socket on one end of the null modem cable
and a 10-pin connector on the other end (Figure 57).
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FIGURE 57. PCC 3100 INPOWER CONNECTION

5.1.1.9 Connecting to a PCC 3200 Genset
Figure 58, Figure 59, and Figure 60 show three methods of connecting to a PCC 3200 genset.
The cable has a DB9 socket on each end. The serial cable from the service PC can be
connected to the engine harness or to the customer connection box.

FIGURE 58. INPOWER CONNECTION (PCC 3200 TYPE 1 CONNECTION BOX)
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FIGURE 59. INPOWER CONNECTION (PCC 3200 TYPE 2 CONNECTION BOX)
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FIGURE 60. PCC 3200 SERIAL CONNECTION (TYPE 3, FOUR CARD CAGE STYLE)

5.2 Consumer Genset Service
InPower performs several functions including genset service and diagnostic functions. The
Adjustment feature is used to perform service adjustments and trims.

The Test feature is used for diagnostics. Test is used to temporarily override a variety of input
and output parameters.

WARNING: Electrical shock and moving parts can cause severe personal injury or death.
Notify personnel before starting a generator set. Refer to the equipment
Operator's Manual for important safety precautions.
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You must be connected to the genset in order to write adjustment trims and setting changes to
the controller, and to temporarily send test commands to the genset controller. The features
described may not apply to all control types.

5.2.1 Connecting to a Genset
Connection between the service PC and the genset is made with a special RS-232 interface
harness. If the service PC does not have a serial port, a USB-to-serial converter may be
required as well.

Figure 62 and Figure 63 show two types of connections to a genset in a recreational vehicle.
Figure 64 shows how to connect to a marine genset. The interface harness from the service PC
can be connected to the engine harness at the remote connector. Disconnect remote
connections and connect the tools. Interface harnesses are available for all connection
methods.

FIGURE 61. DEVICE EXPLORER - TYPICAL GENSET FEATURES
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FIGURE 62. INPOWER SERIAL CONNECTION FOR HDKCX, HDKAX (PRIOR TO SPEC K, AND
HDKBX DIESEL GENSETS AND HGJAA, HCJAD, HGJAB, HGJAC, HGJAE, HGJAF (UNITS WITH

CONTROLS BUILT IN 2001 OR LATER), KY, AND MKY GASOLINE/LPG GENSETS
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FIGURE 63. INPOWER SERIAL CONNECTION FOR HDKAX (STARTING WITH SPEC K), DKHA,
HDKAW, 810HQD, 1215HQD, AND 1218HQD DIESEL GENSETS, HQGMX GASOLINE/LPG GENSETS,

GSAAX NATURAL GAS/PROPANE GENSETS, AND HJBAAX AND RV/CM DISPLAYS

FIGURE 64. SHOWS HOW TO CONNECT TO A MARINE GENSET. THE INTERFACE HARNESS
FROM THE SERVICE PC CAN BE CONNECTED
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5.2.2 Connecting to an HQD Inverter/Charger, Transfer Switch,
or Display and an RV Inverter and GSAA
InPower can also be used with recreational vehicles with an HQD generator to communicate
with the inverter/charger, transfer switch, or the display.

Connection between the service PC and the device is made with a special RS-232 interface
harness.

Figure 65 shows how to connect to an inverter/charger or a transfer switch. Figure 66 and
Figure 67 show how to connect to a display. The interface harness from the service PC can be
connected to the inverter/charger or transfer switch. The interface harness from the service PC
must be connected to an adapter harness that is connected to the display and a power source.
Connections to these devices require an RS-232 to RS-485 communications converter.
Interface harnesses are available for all connection methods.

NOTE: When using InPower is connected to the transfer switch to do an update or
an initial calibration, the display must either be asleep or disconnected.

FIGURE 65. INPOWER SERIAL CONNECTION FOR AN HQD INVERTER/CHARGER OR TRANSFER
SWITCH, RV INVERTER, AND GSAA
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FIGURE 66. INPOWER SERIAL CONNECTION FOR 6-PIN RV/COMMERCIAL MOBILE DISPLAYS

FIGURE 67. INPOWER SERIAL CONNECTION FOR 8-PIN RV/COMMERCIAL MOBILE DISPLAYS
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5.2.3 Connecting to Marine Devices
5.2.3.1 Programming A Marine Control

NOTE: For communicating and troubleshooting only, use a MONnet connection and
plug into the remote control. For programming using MON, refer to the wiring
diagrams.

To program a Marine control, refer to the connections shown in Figure 68.

1. If you installation includes a display or a Network Interface Module (NIM),

a. Disconnect the generator set remote control connector.

b. Connect the interface harness (P4) to the generator set remote control connector.

c. Connect the jumper (J7) to the interface harness (P2).

d. Connect the jumper (P8) to the adapter harness.

e. Install the RS-232 to RS-485 converter on the PC.

f. Connect the interface harness to the RS-232 to RS-485 converter.

2. If your installation does not include a display or a NIM, plug the interface harness into the
remote control connector.

3. Wake up the control using the display or the Start/Stop switch. Press Stop until the status
light comes on or the LCD screen shows genset data.

4. Program the control.

5. Remove the battery and reconnect the wiring to its original configuration.
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FIGURE 68. INPOWER SERIAL CONNECTION FOR MARINE CONTROLS

5.2.3.2 Programming A Marine Display
To program a Marine display, refer to the connections shown in Figure 69.

1. Disconnect the adapter harness from the display.

2. Connect the jumper (J7) to the adapter harness.

3. Connect the jumper (P8) to the interface harness (P4).

4. Connect the interface harness (P2) to the digital display.

5. Install the RS-232 to RS-485 converter on the PC.

6. Wake up the control by pressing any button until the backlight is enabled on the display.

7. Connect the interface harness to the RS-232 to RS-485 converter.

8. Program the display.

9. Remove the battery and reconnect the wiring to its original configuration.
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FIGURE 69. INPOWER SERIAL CONNECTION FOR MARINE DISPLAYS

5.2.3.3 Programming A Network Interface Module (NIM)
To program a Marine NIM, refer to the connections shown in Figure 70.

1. Disconnect the generator set harness from the adapter harness.

2. Connect the jumper (J7) to the generator set harness.

3. Connect the jumper (P8) to the adapter harness.

4. Connect the interface harness (P4) to the adapter harness.

5. Connect the interface harness (P2) to the digital display.

6. Install the RS-232 to RS-485 converter on the PC.

7. Connect the interface harness to the RS-232 to RS-485 converter.
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8. Wake up the control using the display or the Start/Stop switch. Press Stop until the status
light comes on or the LCD screen shows genset data.

9. Unplug the display.

10. Program the NIM.

11. Remove the battery and reconnect the wiring to its original configuration.

NOTE: For communicating and troubleshooting only, use a MONnet connection and
plug into the remote control. For programming using MON, refer to the wiring
diagrams.

FIGURE 70. INPOWER SERIAL CONNECTION FOR PROGRAMMING A NIM

5.3 Starting InPower
Start InPower and connect to the port (COM1, COM2, etc.) that matches the COM port on the
service PC, that is being used for the genset connection. The available COM ports are
displayed in the Device Explorer directory (left pane). Double click on the COM port (or click on
the COM port and then click on the Connect button, on the toolbar).
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If InPower has problems connecting to a site, the message shown in Figure 71 is displayed. If,
after a few seconds, the program still cannot connect to the site, the connection failure message
shown in Figure 71 is displayed. If you get this message, click on OK, make sure the selected
COM port is available, make sure the COM port is being used, verify that the RS-485 adapter is
correctly installed, make sure the genset is powered and the control is awake, check all
connections, and repeat the procedure for connecting to the COM port.

NOTE: To wake up the genset control, press and hold the Stop button on the genset
until the switch's status light is enabled.

FIGURE 71. CONNECTION PROBLEM MESSAGE

FIGURE 72. CONNECTION FAILURE MESSAGE

The InPower Device Explorer displays the features that are available for gensets in the
directory, listed under the device in the left pane. To view the genset features, make sure the
genset is powered up and the genset control is awake, double click on the site (COM1, COM2,
etc), and expand the genset directory.

When you double click on a site the first time after InPower is started, the Progress messages
shown in Figure 73 are displayed to show you that InPower is connecting to the device and
verifying parameters. When completed, a message is displayed to inform you of the location
where capture files were placed (Figure 74). Click on OK to acknowledge the message.
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FIGURE 73. DEVICE PROGRESS MESSAGES

FIGURE 74. ANNOUNCEMENT OF CAPTURE FILE LOCATION

If a connection failure message is displayed when attempting to connect to an available device,
make sure the device is turned on and check all connections.
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The following is a typical list of available features.

· Adjustments

· Events Configuration

· Faults

· Monitor

· Test

· CAN Control

· Events and Faults

NOTE: The available features vary from genset to genset.

When you are connected to a genset, the Capture File feature is enabled. This feature is used
to create a copy of the gensets existing parameter values. Always create a Capture file of the
device parameters for reference, prior to making any adjustments.

5.4 Genset Adjustments
This section describes how to make genset parameter value adjustments for trims and settings.
There are a large number of adjustable trims and settings available for gensets. Not all genset
models will have the same adjustments available. This section will cover typical adjustment
examples, to help demonstrate basic procedures for using the adjustment features.

CAUTION: Improper adjustment can cause equipment malfunction or damage. Adjustments
must be performed by trained and experienced personnel only. Refer to the
equipment's Installation and Service manuals for adjustment sequences and
procedures.

5.4.1 Adjustment Basics
To access a group of adjustments or an individual adjustment, use Device Explorer to navigate
the left pane until you reach the desired folder, and click on it. The right pane will display the
parameter(s) associated with the adjustments for that feature.

Figure 75 shows a list of parameters for the Governor - Frequency selection.

The right pane displays the Parameter description, Value, Units of measure and the Last Time
that the value was Read.

Placing the mouse pointer over a parameter will bring up an information popup box. The popup
provides a brief description of how the parameter value is used.

NOTE: Some values may require that the genset is running or stopped before they
can be edited. Refer to the parameter's information pop-up for details.
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FIGURE 75. TYPICAL PARAMETER INFORMATION

5.4.2 Adjustment Features
The groups and the contents of the Adjustment features can vary by genset model, control
software version, and InPower version.

The Adjustments directory for a typical genset contains the following groups (folders) of
Adjustment options:

AC Measurement Calibration: This group contains Current, Voltage and Power Factor
measurement parameters for the graphical display. Also contained in this group is the
calibration for Voltage Measurement for Regulation.

Alternator Protection: Contains adjustments for Over and Under Frequency, High and Low AC
Voltage, and related time delay settings.

Automatic Voltage Regulator: Contains adjustments for the Voltage Adjust trim for the
nominal voltage offset, overall AVR gain adjust, and the V/Hz rolloff table.

Engine Protection Adjustments: Engine protection settings for high and low temperature,
pressure settings, and related time delays.

Features: This group contains several genset setup and feature settings. For example, the
Exercise Setup parameter allows the user to set the genset exercise duration, in hours.

Genset Power Ratings: Contains adjustments for setting up the application information such as
Standby or Prime Power, Delta or Wye alternator connection, KVA rating, line-to-line voltage
and generator connection for single or three phase.

Governor: This group contains Governor adjustments for Frequency settings, Gain and Droop
settings, and Idle and Ramping.

LONWORKS: This group contains network settings, Controller Identification, modem Dialout
Setup, network Fault Setup and Network Setup.

Paralleling: This group contains parameters for Breaker Interface, Bus Voltage Setup, Load
Share Setup, Paralleling Mode, Protection, and Synchronizing.
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Passwords: This group contains three features that are used for password administration.

The Change Passwords feature is used to establish initial passwords and to change existing
passwords.

Passwords must be 5 to 8 characters in length. They may consist of any combination of alpha
or numeric characters. Do not use special characters.

The Clear Passwords feature allows users, with a password, to clear the password. This is
typically used if you wish to permanently remove the password. If you want to change an
existing password, use the Change Passwords feature.

The Enter Passwords feature is used to gain access to password protected parameters.
Entering the password allows the user to write changes to password protected parameters.

There are two predefined groups of parameters that can be protected by passwords, these are
named User and Application. When a password is established for either of these groups,
access becomes password protected. Users can view password protected parameters, but they
cannot write changes to them without Entering the password first.

The Site Password feature is used to provide password protection when accessing a device
from a remote (dial-in) location. This feature can also be used to administer an existing site
password.

Refer to the examples of changing, entering and clearing passwords, in this section.

Reset History Counters: Allows the user to reset the history records for Fuel, Power, and
Starts and Runs in a genset control.

Starting: Contains parameters for setting cranking time settings and attempts, and for Start
Time Delay.

Switch Setup: Contains a group of miscellaneous switch parameters for monitoring and for
setting switches to a specific state. An example of switch some states are: Enable or Disabled,
Started or Stopped, On or Off, Active Open or Active Closed, etc., The settings depends on the
type switch selected.

Many of these features contain sub menus of additional adjustment features. Use Device
Explorer to expand each of these categories to view the sub-menu of adjustments.

FIGURE 76. TYPICAL ADJUSTMENT FEATURES
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5.4.3 Making Adjustments
Located to the left of each parameter is an icon that indicates if the parameter can be adjusted
or if it is for monitoring (refer to Figure 76).

The screwdriver icon is used for trims and settings that can be written permanently to the device
(read and write). When the cursor is placed over a parameter that can be adjust, the range for
the parameter is displayed (Figure 77). The magnifying glass indicates that the parameter value
is being monitored (read only). The switch icon is used to display settings that can be
temporarily written to a device. The wrench icon represents factory settings that are not
adjustable with InPower.

FIGURE 77. PARAMETER RANGE

NOTE: The value being monitored will not automatically update. The user can
double click on the parameter to update the value field or click on the
Refresh button, on the toolbar.

Each parameter displays the current value and the units of measure for that value. Review this
information before making adjustments. Parameter value trims and settings are displayed.
Trims are numeric values that are entered directly into the Value cell. Settings are selected
from drop down lists, and they consist of several types of values such as On/Off and
Enable/Disable.

To change a parameter value, double click inside the Value cell of the parameter that you wish
to change. The current value will be highlighted, if there are only a few choices, a drop-down
arrow will be displayed next to the Value.

If an arrow is displayed, click on the arrow to view a drop-down list of the available settings.
Click on the desired setting, and it will be entered into the Value cell.

If you do not see an arrow, begin typing the new value, the new value entry will overwrite the
current value. If the value entered is above or below the range of acceptable values, an error
message dialog box will be displayed (Figure 78). Review the information in the dialog box to
see the value limits, before clicking OK, to close the error message dialog box.

FIGURE 78. ADJUSTMENT ERROR

5.4.4 Saving Adjustments
Edit Mode: When selected, a parameter value remains in the edit mode (to change a numeric
value or select from a drop-down list). When finished making adjustments, press the enter key
or click on another parameter value to exit the edit mode.
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Saving Adjustments: Adjustments are written to the device as they are entered. To make
these changes permanent, click on the Save Trims button, on the toolbar (floppy disc) or click
on the Device menu and select Save Adjustments. Changes in adjustments will immediately
alter the device's performance.

After the Save Adjustments button is selected, a Save Adjustments dialog is displayed. This
feature allows you to view and confirm your changes by clicking on Save. You can make final
edits within this dialog by double clicking inside the New Value box and entering a new
parameter value or you can reset all of your changes by clicking on the Cancel button.

Saved adjustments are written to the Audit Trail in the Monitor feature. Refer to the Audit Trail
to review the record of adjustment changes.

If the user loses connection with the device before saving an adjustment, the change will not be
saved.

5.5 Adjustment Examples
The following examples are provided to demonstrate how typical trim and setting adjustments
are made. Some measurements and adjustments are done while the genset is running. Do not
attach or remove test meters while the genset is running.

WARNING: Hazardous voltage can cause severe personal injury or death. Voltage and
frequency measurements must be performed by trained and experienced
personnel only. Do not attach or remove test meters while the equipment is
running. Refer to the equipment Operator's Manual for important safety
precautions.

Example: In this example (Figure 79), InPower is used to adjust the governor gain (refer to the
specific engine model T&R manual for additional governor adjustment details)

Select the Governor - Gain and Droop feature and then double click on the Gov. Gain Adjust
Trim Value cell.

Make a note of the existing Value reading. The range of adjustment is 0.05 to 10 (1 is the
factory default setting).

Increase or decrease the value as needed to obtain the proper load response. If the gain is set
too high, engine speed will hunt or oscillate, and if the gain is set too low, the engine will
respond too slowly to changes in the load.

Click on the Save Trims button, on the toolbar, to write the new value to the device. Continue
adjusting until satisfactory response time and stability are obtained.

Example: In this example, InPower is used to increase the Starting to Rated Ramp Time
(refer to Figure 80). Select the Governor - Idle and Ramping feature, from the Adjustments
directory. Double click on the Value cell for Starting to Rated Ramp Time. This adjustment
sets the desired time interval between starting and rated power. The current setting will be
highlighted. For this example, enter 10 (for 10 seconds) into the Value cell. (For faster startup
and for NFPA 110 compliance, set this value to zero.)

Click on the Save Trims button on the toolbar to write the new value to the device.
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FIGURE 79. ADJUSTMENTS - GOVERNOR - GAIN AND DROOP

FIGURE 80. ADJUSTMENTS - GOVERNOR - IDLE AND RAMPING

Example: In this example (Figure 81), InPower is used to adjust the automatic voltage
regulator to obtain the correct AVR gain setting.

With the genset OFF, attach a calibrated volt meter to the AC output leads from L1 to L2.

Start the genset and allow it to warm up. Apply and remove a load from the genset while
observing the voltage meter reading.

Select the Automatic Voltage Regulator feature, and then double click on the AVR Gain
Adjust parameter Value cell.

Make a note of the existing Value reading. The range of adjustment is 0.05 to 10. Enter a higher
or lower value as required. If the gain is set too high, output voltage will be unstable. If the gain
is set too low, the output voltage will respond sluggishly to changes in load and overshoot may
result.

Click on the Save Trims button, on the toolbar, to write the new value to the device.
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Example: In this example, InPower is used to make a setting change to one of the Switch
Setup parameters.

Select the Switch Setup feature in the Adjustments directory. Click on the Value cell for
Customer Switch Settings. Double click on the Value cell for Customer #1 Switch Active
State Selection. The current setting will be highlighted and a drop-down arrow will be displayed
in the Value cell.

Click on the drop-down arrow to display the setting choices (Figure 82). The user can set the
state to either Active Open or Active Closed. To make the selection, click on the desired
switch state.

Click on the Save Trims button, on the toolbar, to write the new value to the device.

FIGURE 81. ADJUSTMENTS - AUTOMATIC VOLTAGE REGULATOR

FIGURE 82. SWITCH SETUP - CUST. 1 SWITCH STATE
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FIGURE 83. ENGINE PROTECTION ADJ. - LCP WARNING THRESHOLD

Example: In this example InPower is used to adjust an XY table.

NOTE: InPower will only allow adjustments to engine protection parameters that
result in increased engine protection.

Select the Engine Protection Adjustments feature and double click on the Value cell for LCP
Warning Threshold (Figure 83). The current threshold settings are displayed in a graph.
Pressure, in psi, is displayed on the Y-axis and engine speed is displayed on the X-axis.

Editing can be performed in the Graph Mode (Figure 84) or in the Spreadsheet Mode (Figure
85). To change to the Spreadsheet Mode, click on the Graph Mode checkbox to remove the
check mark.

Edit in the Graph Mode by dragging a threshold point on the graph to the desired setting. When
the cursor is in the correct location, a pointing hand will appear on the graph. Select the hand by
holding down on the mouse button, continue to hold down on the mouse button while dragging
the point to the desired location.

Click on Save, to update the most recent changes. Click on Close when you are finished making
changes.

Click on the Save Trims button, on the toolbar, to write the new value to the device.
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FIGURE 84. XY GRAPH

FIGURE 85. XY SPREADSHEET

Edit in the Spreadsheet Mode by clicking on a value cell and entering the parameter value in the
edit box, next to the check mark. Click on the check mark to enter the new value into the
spreadsheet. Both the RPM and PSI values can be edited.

In this example, the user can change the LCP warning threshold at 1200 rpm to 20.5 psi. Use
either the drag-and-drop method to move the point on the graph, or enter the new value into the
spreadsheet.

Click on Save to update the most recent changes. Click on Close, when you are finished
making changes.

Click on the Save Trims button, on the toolbar, to write the new value to the device.
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The Paste button (Figure 85) is used to import spreadsheet value data from an Excel
spreadsheet. Service personnel will not need to use this feature because the data is
already provided. Generally, only minor adjustments are required.

Password Example 1: In this example (Figure 86), InPower is used to create both an
Application password and a User password. These passwords are used to prevent unauthorized
InPower users from writing changes to password protected parameters.

In examples 2 and 3, InPower is used to Enter these passwords to write changes to protected
parameters and to Clear these Application and User passwords.

Connect to the device and open the Adjustments - Passwords parameter group. Click on the
Change Passwords folder.

Double click on the value cell for the Change Application Password parameter. Enter the
password test21 (passwords must be 5 to 8 characters in length and may consist of any
combination of alpha or numeric characters).

Make a note of the Application password.

Click on the Save Trims button, on the toolbar, to write the new password to the device.

Repeat this process for the Change User Password value cell. Enter test22 and click on the
Save Trims button again to write the new password to the device.

Make a note of the User password.

Close the connection to the device and exit InPower. Proceed to the next Password Example.

FIGURE 86. CHANGE PASSWORDS

Password Example 2: In this example (Figure 87), InPower is used to adjust parameters that
have password protection.

Start InPower, connect to the device, and open the Adjustments - Passwords parameter
group. Click on the Enter Passwords folder.

Double click on the value cell for the Enter Application Password parameter. Enter the
password test21. Click on the Save Trims button. Repeat by entering test22 in the Enter User
Password value cell, and click on the Save Trims button.
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Open the Adjustments - Engine Protection Adjustments parameter group and double click
on the Coolant Level Switch Enable value cell (this parameter is Application Password
protected). Select Enable, from the drop down list and click on the Save Trims button.

Next, double click on the Engine Cold Warning Threshold value cell (this parameter is User
Password protected). Enter 20 (degF) and click on the Save Trims button.

Entering the password first allows the user access to write changes to these password
protected parameters. Reset both of these parameters to their original settings before
proceeding to the final password example. Do not disconnect from the device.

FIGURE 87. ENTER PASSWORDS

Password Example 3: In this example (Figure 88), InPower is used to clear the Application
and User Passwords.

During an InPower session, you must Enter the password(s) before they can be cleared. Open
the Enter Passwords parameter group and enter both the Application and User passwords.

Click on the Clear Passwords folder. Double click on the Value cell for the Clear Application
Password parameter. Click on Clear Password in the drop-down list. Click on the Save Trims
button. This will remove the Application password.

Double click on the Value cell for the Clear User Password parameter. Click on Clear
Password in the drop-down list. Click on the Save Trims button. This will remove the User
password.
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FIGURE 88. CLEAR PASSWORDS

Example: In this example (Figure 90), InPower is used to display a load profile for a PCC 3100
genset.

Connect to the PCC 3100 device and open the Monitor feature group. Select the Genset Data
feature and double click on the Value cell to display a chart showing the for Genset Load
Profile (Figure 89).

The load profile displays the number of hours that the generator set has operated between zero
and 120 percent of rated power. The table is divided into 10 percent increments.

Click on the Close button when you are finished viewing the data.

FIGURE 89. PCC 3100 LOAD PROFILE
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FIGURE 90. PCC 3100 GENSET LOAD PROFILE

Example: In this example (Figure 91), InPower displays a message and disables the Save
Adjustment when the Genset State of the PCC1302 control is Fault Shutdown and the user tries
to edit and save the parameter values.

FIGURE 91. PCC1302 SAVE ADJUSTMETNS CANNOT BE PERFORMED MESSAGE

5.6 Test
The Test feature is a diagnostic tool that is used to perform internal self-checks on the device
(Self Test). Use InPower to verify inputs and outputs of the device, and test device protection
functions (like Overspeed).

After changing a Test parameter, the user can observe or measure the results of the changes.
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NOTE: There are two types of Test Commands: maintained inputs and momentary
inputs. When a maintained input is set to active, the input will remain active.
The InPower user MUST set the input back to inactive, when they are finished
with the test or before leaving the site, otherwise the command will remain
active.

Momentary inputs automatically change state to inactive after one second.

Maintained inputs generally have the screwdriver icon next to the parameter name, and
momentary inputs have the switch icon next to the parameter name.

This section describes each group of tests listed in the Test directory. The Self Test feature can
be used as a quick check to determine if the genset control is responding, by sending control
inputs that should activate the control outputs. The other Tests are used for performing more
specific test functions.

The Test parameter values are adjustable (Figure 92). Some parameters have a numeric value
that can be changed while others have values that can be selected from a drop-down list.

5.6.1 Commercial Gensets
The Test directory for a typical commercial genset may contain the following groups (folders) of
Test options:

· Fault Simulation

· Inputs

· Manual Operation

· Outputs

· Self Test

· Speed Override

· Protection Verification

· Annunciator

The Test directory for a typical consumer genset may contain the following groups (folders) of
Test options:

5.6.2 Consumer Gensets
The Test directory may contain the following groups (folders) of Test options for consumer
gensets:

· Starter Override Request

· Starter Override Command

· Starter Override Status

· Glow Plugs Override Request

· Glow Plugs Override Command

· Glow Plugs Override Status

· Fuel Pump Override Request

· Fuel Pump Override Command
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· Fuel Pump Override Status

· Run Output Override Request

· Run Output Override Command

· Run Override Status

· Status Light Override Request

· Status Light Override Command

· Status Light Override Status

· Power Latch Override Request

· Power Latch Override Command

· Power Latch Override Status

· Inverter Enable Override Request

· Inverter Enable Override Command

· Inverter Enable Output Status

· Governor Output Override Request

· Governor Output Override Command (in percent)

· Governor Output Override Status

· Set High Idle

5.6.3 Override Requests
This test option allows you to enable or disable an override for each of the eight devices.

5.6.4 Override Commands
For the starter, glow plugs, fuel pump, run output, status light, power latch, and inverter, this test
option allows you to set the override command to On or Off. For the governor output, this test
option allows you to set the range from 0 to 100%.

Pressing the Stop button disables any override. Overrides are active for 60 seconds, and then
are disabled.

WARNING: Overriding genset command may result in damage to the genset. Only
trained and experienced personnel should override genset commands.

5.6.5 Override Status
For the starter, glow plugs, fuel pump, run output, status light, power latch, and inverter, this test
option allows you to see the current state of the override status. For the governor output, this
test option allows you to vary the governor output from 0 to 100%.

5.6.6 Set High Idle
While the default value is Normal, this variable can be used to set a mechanical High Idle Stop
by setting the value to “Set High Idle."
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FIGURE 92. ADJUSTABLE TEST PARAMETERS

5.6.7 Inputs
When inputs are externally activated, the Inputs feature can be used to monitor the inputs. The
actual inputs can be measured with a multimeter and the results can be compared.

Example: To test the Oil Pressure Input, check the genset wiring diagram for the location of
the oil pressure sender input. In this example the input is on connector 05 between pins 22 (+)
and 23 (gnd). Remove the connector and insert the service breakout box. Check for voltage
between pins 22 and 23.

If no voltage is present, check the harness and the sensor. If voltage is measured, and InPower
and the Operator panel display no input, the connections to the control, or the control are
suspect.

Figure 93 shows the results when an input voltage is present, in this example the oil pressure
(approximately 26 psi) is displayed in InPower, and should also be displayed in the Operator
Panel display.
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FIGURE 93. TEST - INPUTS - OIL PRESSURE

5.6.8 Manual Operation
This feature allows the user to perform genset operations including exercising the genset,
stopping the genset and bypassing the warm-up period (used if the genset is already warmed
up).

Example: In this example, InPower is used to initiate a Manual Run Command. Make sure that
the Run/Off/Auto switch, on the genset control panel, is set to Auto. Double click on the Manual
Run Command Value cell, and a drop-down list arrow is displayed (refer to Figure 94). Click on
the drop-down arrow and click on Run. To initiate the Manual Run Command, click on the
Save Trims button, on the toolbar. To end the Run command double click on the Value cell
again, click on the drop-down arrow and click on Stop, then click on the Save Trims button, on
the toolbar.

5.6.9 Outputs
The Outputs feature allows the user to activate relay drivers without running the genset. This
feature can be used to test the relays and wiring, or measure the relay driver output with a
voltmeter.

Example: In this example, InPower is used to enable the Load Dump Override Command
(refer to Figure 95). Make sure that the Load Dump parameter is set to Driver On. (If it is not,
change it with the Load Dump Override Command parameter, and save that parameter
setting.)
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Double click on the Load Dump Override Enable Value cell. A drop-down list arrow is
displayed, click on the drop-down arrow and click on Enabled. To temporarily write this output
to the Load Dump Override Relay, click on the Save Trims button, on the toolbar. The
override can be disabled by selecting Disabled in the Value cell, then click on the Save Trims
button, on the toolbar.

FIGURE 94. MANUAL OPERATION - MANUAL RUN COMMAND

FIGURE 95. OUTPUTS - CUST. SUPPL. WIRING - LOAD DUMP

5.6.10 Fault Simulation
This feature allows the user to test alternator protection and engine protection devices by
temporarily overriding the sensor inputs and verifying that the engine shuts down. There are a
large number of protection features that can be checked.

Example: In this example, InPower is used to test an engine protection feature (Figure 96).

The user can make a check of the current engine protection settings for low oil pressure. Double
clicking on the XY Table Value cell for the LOP Warning Threshold Table. Review the oil
pressure Vs. RPM chart to see where the warning threshold points are set. Note the warning
levels, and then close the XY table.
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Double click on the Oil Pressure Override Command Value cell and enter a voltage amount
that will be low enough to trigger the warning (or leave the setting at the default 0 volts).

Double click on the Value cell for the Low Oil Pressure Override Enable. A drop-down list
arrow is displayed, click on the drop-down arrow and click on Enabled. To temporarily write this
output to the device, click on the Save Trims button on the toolbar.

The Alarm popup will display the active warning (Figure 96).

FIGURE 96. TEST - ENGINE PROTECTION -OIL PRESSURE TEST

5.6.11 Self Test
InPower has built in tests that can be used for diagnostics. The default setting is the Test Abort
value (not in test mode) setting. Figure 97 shows the Self Test options. Double click on the
Value cell, then click on the arrow to display the drop-down list of settings.

The Self Test feature has two Built In Tests (BIT Command). The first test, named Test
Stationary, is used to check all sensors and output relays by activating control outputs. The
user can then monitor inputs, if fault conditions occur, the event handler will popup to display
faults.

WARNING: Notify personnel before using the Self Test Feature to crank the engine.
Severe personal injury or death can result. See the equipment Operator's
Manual for important safety precautions.

The second test, named Test Cranking, sends a start cranking signal to the engine to test the
magnetic pick-up (MPU) speed sensors, starter relay and battery level.

The Test Abort setting is the default setting, indicating that a Self Test is not in process. When
you are finished with a Self Test, or to end a test, return the BIT Command Value to Test
Abort.
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5.6.12 Speed Override
The speed override options are used to override the normal governor reference input to the
control. The Speed Reference Override feature can be Enabled to override the governor
reference input in order to operate the engine at another speed, for diagnostics purposes.

FIGURE 97. SELF TEST - TEST -BIT COMMAND

5.6.13 Single Cylinder Cutout Test
InPower can used to cutout fueling to one cylinder at a time. This test can be used to help
isolate a cylinder with fueling or combustion problems.

Example: InPower is used to perform a single cylinder cutout test (Figure 98). This test is used
in genset applications that use QSX-15 series engines (part of DFE series).

CAUTION: Do not cutout fueling to more than one cylinder at a time or engine damage can
result. Always change the Cylinder Cut Out Test Enable to Disabled, when finished
testing. Follow these steps carefully and refer to the equipment Operator's Manual
for Important Safety Precautions.

Connect the service PC to the genset. Start the genset and operate it at rated speed with no
load.

Open the Test\Fuel System Test parameter group. Make sure each of the six cylinder
parameter values are set at 1 (enabled).

Double click on the Cylinder Cut Out Test Enable parameter and select Enabled.

Double click on the desired cylinder for testing, in this example: Cylinder #1 Injector Fueling.
Enter 0 (disabled). Use the Save button on the toolbar to save the change and perform the
cutout test on cylinder number 1.

When finished, always remember to return the Cylinder Cut Out Test Enable to Disabled, and
return the cylinder being tested to 1 (enabled). Use the Save button on the toolbar to save the
change.
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FIGURE 98. SINGLE CYLINDER CUTOUT TEST
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6 ATS Service
This section describes how to use InPower to configure and make adjustments to a
PowerCommand® controlled Automatic Transfer Switch (ATS). When the user is connected to
the ATS, they can configure the transfer switch, make adjustments, and access the Monitor
and Faults features.

6.1 ATS Service
The Adjustment feature is used to configure the ATS for the application, set exercise times and
exceptions, and perform service adjustments and trims. The Test feature is used to configure
the Test Mode, and for diagnostics.

You must be connected to the ATS in order to write adjustment trims and setting changes to the
controller, and to use the Test feature.

WARNING: AC power within the cabinet and the rear side of cabinet door present a
shock hazard that can cause severe personal injury or death. Use extreme
caution to avoid touching electrical contacts with hair, clothing, tools or
body. Do not wear jewelry. Stand on a rubber mat or dry wood platform. The
following procedures are to be performed by trained and experienced
personnel only.

6.1.1 Connecting to An ATS with the Original Digital Display
A connection between the service PC and the ATS is made with a special RS-232 serial null-
modem cable. The cable has a DB9 socket on each end. If the service PC does not have a
serial port, a USB-to-serial converter may be required as well.

The serial cable from the service PC is connected to the upper right side of the Digital Module.
This module is located inside the ATS (Figure 99).
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FIGURE 99. INPOWER SERVICE CONNECTION (ORIGINAL ATS APPLICATIONS)

6.1.2 Starting InPower
Start InPower and connect to the port that matches the COM port on the service PC being used
for the ATS connection (COM1, COM2, etc.). The available COM ports are displayed in the
Device Explorer directory (left pane). Double click on the COM port (or click on the COM port
and then click on the Connect button on the tool bar).

The InPower Device Explorer displays the features that are available for the ATS in the
directory, listed under the device in the left pane.

Figure 100 shows the features listed for an ATS. These features are:

· Adjustments

· Faults

· Monitor

· Test

When you are connected to an ATS, the Capture File feature is enabled. This feature is used to
create a copy of the existing parameter values for the ATS. Always create a Capture file of
the ATS parameters for reference, prior to making adjustments.
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FIGURE 100. DEVICE EXPLORER - TYPICAL ATS FEATURES

6.2 ATS Adjustments
This section describes how to make ATS parameter value adjustments for trims and settings.
Not all ATS models will have the same adjustments or features available. This section will cover
typical adjustment examples, to demonstrate basic procedures for using the Adjustments
feature.

CAUTION: Improper adjustment can cause equipment malfunction or damage. Adjustment
must be performed by technically qualified personnel only. Refer to the equipment's
Installation and Service manuals for adjustment sequences and procedures.

6.2.1 Adjustment Basics
To access an individual adjustment, or group of adjustments, use Device Explorer to navigate
the left pane until you reach the desired folder, and then click on it. The right pane will display
the parameter(s) associated with the adjustments for that feature. Figure 101 shows a list of
parameters for the Time Delays selection.

The right pane displays the Parameter description, Value, Units of measure and the Last Time
that the value was Read.

Placing the mouse pointer over a parameter will bring up an information popup box. The popup
provides a brief description of how the parameter value is used.
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FIGURE 101. TYPICAL PARAMETER INFORMATION

6.2.2 Adjustment Features
See Section 6.4 for examples mentioned in this section.

The contents of the Adjustments folder can vary by transfer switch model. The Adjustments
directory for a typical transfer switch contains the following groups (folders) of Adjustment
options:

Closed Transition: Contains timing and Common Alarm parameters for closed transition
applications.

Controller Mode: These parameters are used to make significant changes to the ATS, such as
changing from one application to another. Some factory settings cannot be changed with the
InPower service tool.

Current Adjustment: This group contains current measurement parameters for the graphical
display.

Exception Table: Allows up to eight exceptions to the exerciser clock settings.

Exercise Clock: Allows programming of exercise time and duration. Up to eight repeating
exercise programs can be programmed on some models.

Feature Enable: Used to enable available features. The InPower tool recognizes if the feature
(and if needed, the related hardware) are installed and allows the user to enable the feature.

LonWorks: This group of parameters is used when the network module is installed and
enabled. The parameters are used to configure the dial out settings, identify the device on the
network, and check the network status.
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Neutral Current: Used to set the neutral current warning threshold in amperes and the time
delay for the neutral current warning.

Nominal Current: Displays the nominal current for the transfer switch. Do not adjust this
parameter without reviewing the Controller Mode example.

Nominal Frequency: Displays the nominal frequency for Source 1 and Source 2 in the current
application. Do not adjust this parameter without reviewing the Controller Mode example.

Nominal Voltage: Displays the nominal Voltage for Source 1 and Source 2 in the current
application. Do not adjust this parameter without reviewing the Controller Mode example.

Power Factor Adjustment: This group contains Power Factor measurement parameters for the
graphical display. The multiplier and trim offset are shown for each phase. Do not adjust this
parameter without reviewing the Voltage Adjustment example.

Preferred Source: This parameter is used to select the preferred source in utility-to-utility
applications and for genset-to-genset applications.

Real Time Clock: These parameters set the time and date information, Hours are displayed in
military time only (no A.M and P.M. designations). the control will automatically adjust for leap
year and daylight savings time (if enabled).

Source-1 Sensing: This group contains all of the Source 1 sensor settings normally associated
with transfer switch operation (refer to the equipment's Operator's or Installation Manual for a
detailed description of each sensor setting.

Source-2 Sensing: This group contains all of the Source 2 sensor settings normally associated
with transfer switch operation (refer to the equipment's Operator's or Installation Manual for a
detailed description of each sensor setting.

NOTE: Level 1 controls do not support 3-phase sensing on Source 2. Do not select
the 3-phase option for the Source 2 Sensing adjustment, with Level 1
controls, even if the system is three phase. This setting will prevent Source 2
from becoming available.

Sync Check Sensor: Used in closed transition applications only, this group sets the acceptable
conditions for closed-transition transfers.

Time Delays: This group contains all of time delay settings normally associated with transfer
switch operation (refer to the equipment's Operator's or Installation Manual for a detailed
description of each time delay. This group also contains the Changeover Timer used in genset-
to-genset applications only.

Transition (Transfer) Mode: Used to select one of five possible transfer modes used for
various applications. Initial product offerings only support the Open Program Transition mode.

Voltage Adjustment: This group contains voltage measurement parameters for the graphical
display.

6.3 Service Replacement Controls
Service replacement controls for the OTPC/BTPC series transfer switches are factory set to
Configuration - Offline. They are also set to Switch Configuration Type - Zenith. These
settings, along with the voltage and current settings will need to be changed when the
replacement control is installed.

The switch mechanism types available are shown below, along with their descriptions:
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OTPC/BTPC - OTPC and BTPC models less than 1,200 Amps

Zenith - Use on all OTPC/BTPC models 1,200 Amp to 4,000 Amp capable of
Delayed Transition (Programmed Transition) or Closed Transition

Zenith2 - Use on all OTPC/BTPC models 1,200 Amp to 4,000 Amp capable of
In-Phase Transition

OHPC/CHPC - OHPC and CHPC models

PLT - PLTH and PLTS models

After identifying the Configuration Type, check the transfer switch nameplate voltage and
amperage. Use InPower to adjust the replacement control to the appropriate settings, before
changing the Configuration from Offline to the application configuration (Utility-to-Genset, etc.).
Review the first adjustment example in this section.

Source 1 and Source 2 Sensing features Voltage Imbalance Sensing and Loss of Phase
Detection are disabled by default. These features may not be needed in most applications. Do
not enable these features without an understanding of the feature.

Voltage Imbalance Sensing: This feature is used in three-phase applications. It informs the
operator when there is a significant voltage imbalance between the phases of Source 1 or
Source 2. The imbalance is typically caused by severe single phase loading. To prevent
nuisance faults, the setting can be increased up to ten percent of the nominal voltage. This
feature is used for equipment protection.

Loss of Phase Detection: Only used with Level 2 controls, in three phase applications. This
feature will initiate a transfer away from a source that has lost a single phase and it prevents
transfer to a source that has lost a single phase. This is generally caused by a single phase to
line ground or open. This feature is mainly used to protect three phase devices, like motors.

Phase Rotation Sensing: This feature is required in fire pump applications and it is enabled by
default. The feature monitors the phase rotation of the source opposite from the connected
source. When the alternate source is out of phase rotation with the connected source, transfer is
inhibited. This generally occurs on new installations or after storm damage or generator
rewiring.

This feature is used to protect against equipment damage.
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FIGURE 102. TYPICAL ADJUSTMENT FEATURES

6.3.1 Making Adjustments
Figure 102 shows a typical set of parameters from the Adjustments group. Located to the left of
each parameter is an icon that indicates if the parameter is used for adjustment or monitoring.

The screwdriver icon is used for trims and settings that can be written to the device (read and
write). The magnifying glass indicates that the parameter value is being monitored (read only).
The switch icon is used to display settings that can be temporarily written to a device. The
wrench icon represents factory settings that are not adjustable with InPower.

NOTE: The value being monitored will not automatically update. The user can
double click on the parameter to update the value field or click on the toolbar
Refresh button.

Each parameter displays the current value and the units of measure for that value. Review this
information before making adjustments. Parameter value trims and settings are displayed.
Trims are numeric values that are entered directly into the Value cell. Settings are selected
from drop down lists, and they consist of several type of values such as On/Off, 50Hz/60Hz,
Enable/Disable, etc.

To change a parameter value, double click inside the Value cell of the parameter that you wish
to change. The current value will be highlighted, if there are only a few choices, an arrow will be
displayed next to the Value.

If an arrow is displayed, click on the arrow to view a drop-down list of the available settings.
Click on the desired setting, and it will be entered into the Value cell.

If you do not see an arrow, enter the new value, to overwrite the current value. If the value
entered is above or below the range of acceptable values, an error message dialog box will be
displayed (Figure 103). Review the information in the error message box to see the value limits,
before clicking OK.
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FIGURE 103. ADJUSTMENT ERROR

6.3.2 Saving Adjustments
Edit Mode: When selected, a parameter value remains in the edit mode, as indicated by a
flashing cursor (numeric values) or the drop down arrow (settings). When finished making
adjustments, press the enter key or click on another parameter value to exit the edit mode.

Saving Adjustments: Adjustments are written to the device as they are entered. To make
these changes permanent, click on the Save Trims button, on the toolbar (floppy disc) or click
on the Device menu and select Save Adjustments. Changes in adjustments will immediately
alter the device's performance.

After the Save Trims button is selected a Save Adjustments dialog is displayed. This feature
allows you to view and confirm your changes by clicking on Save. You can make final edits
within this dialog by double clicking inside the New Value box and entering a new parameter
value or you can reset all of your changes by clicking on the Cancel button.

Saved adjustments are written to the Audit Trail. Refer to the Audit Trail to review the record
of adjustment changes.

Refer to the Controller Mode example, for making application changes.

If the user looses connection with the device before saving an adjustment, the change will not
be saved.

6.4 Adjustment Examples
The following examples are provided to demonstrate how typical trim and setting adjustments
are made. Some measurements and adjustments are done while the equipment is energized,
do not attach or remove test meters while the equipment is energized.

WARNING: Hazardous voltage can cause severe personal injury or death. Voltage and
frequency measurements must be performed by trained and experienced
personnel only. Do not attach or remove test meters while the equipment is
energized. Use extreme caution to avoid touching electrical contacts with
hair, clothing, tools or body. Do not wear jewelry. Refer to the equipment
Operator's Manual for important safety precautions.

6.4.1 Controller Mode
These parameters are used to make significant changes to the ATS factory application settings.
The four features in the Controller Mode group are described here, followed by an example of
how to use some of the Controller Mode features.
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Configuration: This feature contains four settings. The Offline feature puts the controller into a
standby, or non-automatic state. The control will continue to monitor conditions, but it will not
perform any automatic functions, like initiating a transfer. This prevents faults from occurring
while you are making adjustments to a transfer switch that is in use.

The other three Configuration features are application choices: Utility-to-Genset, Utility-to-
Utility, and Genset-to-Genset.

Refresh_Controller: Updates the device for changes made to voltage, current, frequency or
power. This feature must be used after saving changes to any trims for voltage, current,
frequency or power. For a complete listing of the changes that require use of this feature, refer
to the end of this example.

CAUTION: The Refresh feature uses a lot of the control processing resources. Do not use this
feature during paralleling or critical applications, because the control may not
respond as needed during the refresh process.

Permanent_Save_Settings: Used to permanently change the device settings.

Restore_Factory_Settings: Restores all parameter changes to the original factory settings.
Use caution, this change overwrites previous adjustments. Previous adjustments cannot be
restored unless a capture file was created. The Operator must remove all power from the device
(including the batteries) after changing this setting, for the changes to take effect.

Example: In this example, InPower is used to change the Source 1 and Source 2 nominal
voltage, on an ATS with a Level 1 control, from 208 VAC, line to line, to 240 VAC, line to line.
Use step 1 if the transfer switch has power applied to Source 1, otherwise begin at step 2.

1. Open the Adjustments folder, in the left pane and click on the Controller Mode folder.
Select the value field for the Configuration parameter and click on Offline, in the drop down
list.

2. Click on the Nominal Voltage folder in the left pane. Enter the new nominal voltage in the
Source 1 and Source 2 value fields.

3. Go back to the left pane and click on the Controller Mode folder again. Change the
Refresh Controller value setting to update the device settings for changes to the nominal
voltage.

4. Verify Nominal Voltage settings. If step one was used, change the Configuration value
setting, in the Controller Mode folder, from Offline to the original application.

5. To permanently preserve this change, click on the Controller Mode folder again and
change the Permanent_Save_Settings to On.
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FIGURE 104. ADJUSTMENTS - CONTROLLER MODE

6.4.2 List of Parameters Requiring the Refresh Controller
Feature
When any of the following parameters are changed, save the change and then use the Refresh
Controller Feature to complete the save process.

Current Adjustment

Nominal Current

Neutral Current Trim Multiplier

Neutral Current Trim Offset

Phase 1 Current Trim Multiplier

Phase 1 Current Trim Offset

Phase 2 Current Trim Multiplier

Phase 2 Current Trim Offset

Phase 3 Current Trim Multiplier

Phase 3 Current Trim Offset

Current Transformer Max Amps

Nominal Current

Nominal Current

Nominal Frequency

Source 1 Nominal Frequency

Source 2 Nominal Frequency

Nominal Voltage

Source 1 Nominal Volts

Source 2 Nominal Volts

Source 1 Sensing
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Source 1 Sensing

Source 1 Nominal Volts

Source 1 Under Voltage Pickup

Source 1 Under Voltage Dropout

Source 1 Over Voltage Pickup

Source 1 Over Voltage Dropout

Source 1 Nominal Frequency

Source 1 Frequency Pickup

Source 1 Frequency Dropout

Source 1 Voltage Imbalance Dropout

Source 2 Sensing

Source 2 Sensing

Source 2 Nominal Volts

Source 2 Under Voltage Pickup

Source 2 Under Voltage Dropout

Source 2 Over Voltage Pickup

Source 2 Over Voltage Dropout

Source 2 Nominal Frequency

Source 2 Frequency Pickup

Source 2 Frequency Dropout

Source 2 Voltage Imbalance Dropout

Synch Check Sensor

Frequency Bandwidth

Voltage Window

Voltage Adjustment

Source 1 Phase 1 Trim Multiplier

Source 1 Phase 1 Trim Offset

Source 2 Phase 1 Trim Multiplier

Source 2 Phase 1 Trim Offset

Source 1 Phase 2 Trim Multiplier

Source 1 Phase 2 Trim Offset

Source 2 Phase 2 Trim Multiplier

Source 2 Phase 2 Trim Offset

Source 1 Phase 3 Trim Multiplier

Source 1 Phase 3 Trim Offset

Source 2 Phase 3 Trim Multiplier
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Source 2 Phase 3 Trim Offset

Model Data

Nominal Current

Source 1 Nominal Volts

Nominal Voltage Source 2

6.4.3 Exerciser Clock
Example: In this example, InPower is used to set an exercise time and duration. The ATS
exercise program, shown in Figure 105, is set to begin every Monday evening at 22:00 hours
and run for one hour, with load.

NOTE: Before setting the exerciser clock, make sure that the real time clock is set to
the correct time.

1. Select the Exerciser Clock feature in the Adjustments directory.

2. Double click on the Program 1 Enabled value cell. Click on the drop down arrow and click
on Enable.

3. Select each of the remaining value cells for program 1 and set the Start Day, Start Time,
Duration, Interval, and Load.

4. To save the changes, click on the Save Trims button, on the toolbar.

To program an exception to the exercise program, proceed to the next example.

Changes made to an exercise program (or exception), while the event is active, will not take
effect until the next time the program starts.

FIGURE 105. ADJUSTMENTS - EXERCISER CLOCK

6.4.4 Exception Table
This feature is used to set time periods during which exercises cannot be performed. This
feature can be used to set up to eight exceptions on Level 2 controls and one exception on
Level 1 controls (not available on Level 1 controls with early production software).
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Example: In this example, InPower is used to set one exception period. This will prevent any
previously programmed exercise from starting during that time period.

1. Select the Exception Table feature in the Adjustments directory.

2. Double click on the Exception 1 Enabled value cell. Click on the drop down arrow and click
on Enable.

3. Select each of the remaining value cells for program 1 and Start Month, Start Day, Start
Time, Duration Days and Repeat.

4. (The duration in days and Time (hours) are additive, 1 day and 26 hours equals 2 days and
2 hours.

5. The Repeat can be either False, for a one time exception, or True, to repeat the exception
each year.

6. To save the changes, click on the Save Trims button, on the toolbar.

FIGURE 106. ADJUSTMENTS - EXCEPTION TABLE

6.4.5 Time Delays
Example: In this example, InPower is used to change the time delay for transferring from
Emergency to Normal (TDEN). The Default factory setting for each of the time delays are
displayed. A brief description of time delay is displayed in the pop-up box. Refer to the ATS
Operator's manual for a complete description of each time delay.

1. Select the Time Delays feature in the Adjustments directory.

2. Double click on the TDEN Value cell. Enter the desired time (in seconds).

3. To save the changes, click on the Save Trims button, on the toolbar.
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FIGURE 107. ADJUSTMENTS - TIME DELAYS

6.4.6 Voltage Adjustment - For Display
This adjustment is only required when either the Current Module or Digital Module have been
replaced and the digital display reading appears to be inaccurate.

Examples are given for both the Level 2 and Level 1 controls, because the methods of
adjustment are different. To adjust the display voltage, Level 1 controls will use a line-to-line
calculation and Level 2 controls will use a line-to-neutral calculation. (Adjusting line-to-neutral
voltage automatically adjusts the line-to-line voltage).

To determine the control package level with InPower, click on the About Controller folder in the
Monitor parameter group.

If the optional Bar Graph is available (Level 2 only), these adjustments will also correct the
bargraph voltage display.

WARNING: AC power within the cabinet and the rear side of the cabinet door presents a
shock hazard that can cause severe personal injury or death. Use extreme
caution to avoid touching electrical contacts when the cabinet door is open.
The following procedures are to be performed only by technically qualified
personnel.

When making adjustments on parameters like voltage and frequency, that can result in an
unintentional load transfer, the user can place the Motor Disconnect Switch in the Off position (if
available). The ATS control can also be taken Offline, with the Controller Mode feature in the
the Adjustments folder. Make sure that you reset the switch or change the Configuration
value setting, in the Controller Mode folder, from Offline to the original application when
finished.
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FIGURE 108. ADJUSTMENTS - DISPLAY VOLTAGE

Example 1 (Level 2 Control): InPower is used to adjust the voltage as displayed in the digital
display (and optional bargraph) on a Level 2 control).

In this example, the transfer switch is configured for 3 phase, and a nominal 208 VAC line-to-
line. The digital display is displaying source 1 line-to-neutral voltage as 118 VAC. The bargraph
is displaying 98% for Line 1, with Source 1 connected.

1. Select the Voltage Adjustment feature in the Adjustments directory. Observe the Source 1
V1-Neutral value that is being monitored (signified by magnifying glass). This is the display
voltage.

2. Measure the actual Source 1 voltage at the power Module between NA and NN (Line 1 to
neutral). (Line 2 would be measured from NB to NN and line 3 would be measured from
NC to NN).

3. Calculate the Trim Multiplier (K) needed to adjust the displayed voltage as follows:

4. Double click on the Voltage PH1S1 Trim Mult (multiplier) Value cell, and enter 1041.

5. To save the changes, click on the Save Trims button, on the toolbar.

6. Check the results to make sure the displayed voltage is close to the actual voltage.
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Example 2 (Level 1 Control): InPower is used to adjust the voltage as displayed on the
optional digital display on a Level 2 control.

In this example the transfer switch is configured for 3 phase, with a nominal 208 VAC line-to-
line. The digital display reads 210 VAC for Source 1, phase A.

1. Select the Voltage Adjustment feature in the Adjustments directory. Observe the Source 1
V1-V2 value that is being monitored (signified by magnifying glass). This is the display
voltage.

2. Measure the actual Source 1 voltage at the power Module between NA and NB (Phase A).
(Phase B would be measured from NB to NC and phase 3 would be measured from NC to
NA).

3. Calculate the Trim Multiplier (K) needed to adjust the displayed voltage as follows:

4. Double click on the Voltage PH1S1 Trim Mult (multiplier) Value cell, and enter 1014.

5. To save the changes, click on the Save Trims button, on the toolbar.

6. Check the results to make sure the displayed voltage is close to the actual voltage.

6.4.7 Feature Enable
When a feature is present, and its hardware is installed and connected, the feature can be
enabled using InPower.

Example: In this example, InPower is used to enable the Digital Display feature.

1. Select Feature Enable, in the Adjustments directory.

2. Double click on the Alphanumeric Display Feature.

3. Double click on the Disable/Enable Value cell. Click on the arrow to view a drop-down list
and click on Enable.

4. To save the changes, click on the Save Trims button, on the toolbar.

5. Changes to features are only recognized on power up. Remove all power from the transfer
switch, including battery power. Then restore AC power and install the batteries.

After installing the batteries, reprogram the Real Time Clock settings.

An optional procedure for step five is to remove all AC power and wait until the control resets
(takes approximately 2 and 1/2 minutes). When AC is restored, the control powers up with the
feature change, and without losing the real time clock settings.
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FIGURE 109. FEATURE ENABLE

6.4.8 PTC Settings
When a Power Transfer Control (PTC) is installed and connected, the feature can be enabled
using InPower.

Example: In this example, InPower is used to enable the Power Transfer Control (PTC).
Enabling this feature can only be performed with InPower. The PTC is only used in utility to
genset applications. Source one (S1), in this example will always refer to the utility source.

Before connecting InPower, make sure the PTC module is installed including the data cable
connection from the PTC to the PCC 2100 control. The PTC status light should be flashing.

Select the Power Transfer Control (PTC) feature in the Adjustments directory. Click on the
PTC S1 Setpoints parameter group and confirm that the default parameters settings are
adequate for your application.

Click on the PTC Settings parameter group and click on the Switch Device Type parameter.
Select the correct switch device type from the drop-down list. Choose between the Circuit
Breaker, Contactor, or OT 3. (OT 3 refers to OTPC and BTPC transfer switches of less than
1,200 amps).

Confirm that the S1 Nominal Voltage and S1 Nominal Frequency match the utility.

Set the Power Transfer Test Configuration to the desired setting. Review the remaining PTC
Settings before enabling the PTC feature.

Select the PTC Feature Enable parameter and select Enable from the drop-down list.

Click on the Save Trims button, on the toolbar, to save the changes and enable the PTC
feature.

NOTE: The Power Transfer Test Configuration Setting is used for the remote test
input. This setting does not apply to the InPower Test/S1 Protection tests.
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FIGURE 110. PCC 2100 POWER TRANSFER CONTROL (PTC) SETUP

6.5 Test
The Test feature contains two groups of parameters, Remote and Setup. The Remote
parameters are used for diagnostics and the Setup parameter is used to set the with/without
load setting for the Test button on the front panel of the ATS.

Typically, the Test button on the front panel is used to perform a transfer switch test. Pressing
the Test button a second time will stop a test in progress. As a diagnostics example, if the Test
button does not appear to work, the InPower Test Command can be used to initiate a test.

WARNING: Notify personnel before using the Test button or InPower Test features on
the ATS, to start the genset or transfer the load. Severe personal injury or
death can result. See the equipment Operator's Manual for important safety
precautions.

6.5.1 Test - Remote Features
The commands that are available in this group interact with the corresponding hardware inputs.
For example, if the Load Shed Command is deactivated, but the Load Shed input is activated,
the ATS will shed the load.

NOTE: There are two types of Test Commands: maintained inputs and momentary
inputs. When a maintained input is set to active, the input will remain active.
The InPower user MUST set the input back to inactive, when they are finished
with the test or before leaving the site, otherwise the command will remain
active.

Momentary inputs automatically change state to inactive after one second.

Maintained Inputs for Test are: Test Command, Remote Start (Dual Standby), Load Shed
Command, Transfer Inhibit, Retransfer Inhibit

Momentary Inputs for Test are: Reset Command and Override Command.
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Features can vary by transfer switch model. The Test - Remote directory for a typical transfer
switch contains the following features:

Test Command: Allows the user to initiate an ATS Test. The user can then monitor the ATS, if
fault conditions occur, the event handler will popup to display faults. In utility-to-genset
applications the Test Command sends a start signal to the genset designated as Source 2.

Remote Start (Dual Standby): Used only in dual standby genset-to-genset applications, to start
the main (Source 1) genset.

Load Shed Command: Allows the user to initiate a Load Shed command, when the Load Shed
feature is installed and enabled. This function moves the transfer switch from Source 2 (genset)
to neutral. This will remove the load from the genset.

Transfer Inhibit Command: Allows the user to initiate a Transfer Inhibit command. This
command, typically used in paralleling applications, is used to control the load transfer to a
genset.

FIGURE 111. TEST - REMOTE

Retransfer Inhibit Command: Allows the user to initiate a Retransfer Inhibit command. This
command is used when the operator wants manually control the retransfer of the load back to
Source 1. Once the source appears stable the operator can use the Override input to transfer
the load to Source 1.

Override Command: Allows the InPower user to initiate an Override command. This command
is used to override most of the time delays. The Program Transition, Elevator Signal, and
Engine Cooldown delays are not affected by this command.

Reset Command: Allows the InPower user to initiate a Reset command. This command
acknowledges events.

Refer to the ATS Operator's Manual for detailed feature descriptions.

6.5.2 Test - Setup Features
The Test feature can be used to set the With/Without Load setting for the Test button on the
front panel.
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FIGURE 112. TEST - SETUP

6.5.3 Test - S1 Protection (PTC Test)
When a Power Transfer Control (PTC) is installed and connected, the PTC can be tested using
InPower.

Example: In this example, InPower is used to test for a Source 1 (S1) overvoltage condition.
When installed and enabled, the Power Transfer Control (PTC), will start the genset and
transfer the load.

Source one (S1), in this example will always refer to the utility source.

Connect InPower to the PCC 2100. Make sure the PTC feature is enabled and the PTC status
light is flashing, to indicate that it is installed.

Select the S1 Protection feature in the Test directory. Click on the Overvoltage parameter
group.

To test the PTC, an Analog Input Override Command value must be entered first, then the
Analog Input Override is Enabled.

The Analog Input Override Command value is a scaled input value. The input range is zero to
five volts. This range represents zero to 150 percent of nominal voltage.

Note that the S1 Overvoltage Drop-Out Percentage is at the default setting of 110 percent of
nominal voltage. In this example, InPower will be used to simulate an S1 L1-L2 overvoltage
input of 115 percent of nominal L1-L2 voltage.

Determine the input value:

(115 ÷ 150) X 5.0 = 3.833

Click on the S1 L1-L2 Analog Input Override command value cell and enter 3.833. Click on
S1 L1-L2 Analog Input Override Enable and select Enabled from the drop-down list.

Click on the Save Trims button, on the toolbar, to save the changes and enable the PTC test.
The PTC will start the genset and transfer the load to the genset.

To end the test, select Disabled in the S1 L1-L2 Analog Input Override Enable drop-down list
and Click on the Save Trims button, on the toolbar, to save the changes and enable the PTC
feature.
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FIGURE 113. PCC 2100 POWER TRANSFER CONTROL (PTC) TEST
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7 Master Control Module Service
This section describes how to connect InPower to a Master Control Module (MCM) 3320 and
how to make adjustments and perform tests.

7.1 Connecting an MCM3320
The MCM3320 master control requires an RS-232 to RS-485 data converter and a unique
cable. Figure 114 shows the MCM3320 InPower connection.

Kit number 541-1199 is available for use with the MCM3320. The kit includes the RS-232 to RS-
485 converter and the cable used for this application.

If the service PC does not have a serial port, a USB-to-serial converter may be required as well.

FIGURE 114. INPOWER SERIAL CONNECTION WITH MCM3320 CONTROL
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7.2 Configuring the MCM3320
There are two ways to configure the MCM3320 in InPower.

· Use the folders in the device explorer, the same way you configure any device.

· Use the MCM3320 setup screens. Right-click on the device to open these screens.
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8 Monitor
This section describes how to use the Monitor and Datalog features. There are two methods of
monitoring parameters, the user can create a custom Monitor dialog for viewing selected
parameters, or the user can view pre-selected parameters, based on the device type.

8.1 Monitor and Datalog
The Monitor and Datalog features are used to view and record (datalog) parameters. The user
can monitor preselected parameters with Device Explorer, or they can select the specific
parameters they want to monitor and record, using the Monitor Dialog feature.

InPower's Device Explorer allows the user to navigate and view preselected parameters.

8.2 Monitor Dialog
The Monitor Dialog allows the user to select the parameters they want to view, set a sampling
rate and enable the data logging feature. Sampling allows realtime data viewing. Data logging
stores information in a file for later use.

The Monitor Dialog is displayed when the Monitor command is launched from either the Start
menu or the Monitor button, on the InPower toolbar.

8.2.1 Monitor Dialog Features
The Monitor Dialog is shown in Figure 115. This section describes how to use the Monitor
Dialog features.

File Menu: Used to create a New Monitor file or to Open an existing Monitor file. Also used to
Save changes to an opened file or Save As..., to save changes to a new file. Recent allows the
user to view recently opened files and is used as a shortcut to open a file.
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FIGURE 115. MONITOR DIALOG FEATURES

Edit Menu: Use the Edit menu commands to Add, Delete, Edit, Cut, Copy, Paste, and Save
Adjustment parameters into and out of the Monitor Dialog.

View Menu: Use the View command to hide or display the Toolbar and Status Bar.

Help Menu: Provides InPower Help Topics and About Monitor help.

Sampling: The Monitor dialog will sample at the selected setting. To select the sample rate,
click on the Sampling - Enabled check box (enabled when checked). Enabling the Sampling
feature activates the Sampling Rate list box. Select the desired sampling rate from the list box.
Sample rates are available from 0.05 seconds to 60 seconds.

Logging: Logging al lows the user to log parameter information to a .LOG file (at the selected
Sampling Rate). Sampling must be enabled to use this feature. Before enabling data logging,
enter a name in the file dialog. The log file uses the tab delimited file format. To select the
Logging feature, click on the Start Logging button. When data logging begins, the button text
switches from Start Logging to Stop Logging. Click on the Stop Logging button to stop data
logging.

Data can be logged to the default (Monitor_<Time Stamp>.001.log) file where the time stamp is
"MM_DD_YYYY_HH_MM_SS" (for example, Monitor_12_22_2011_13_46_10.001.log). If this
file exceeds the size limit of 4 MB, a new file is created where the last digits that were 001 are
incremented to 002 (for example, Monitor_12_22_2011_13_46_10.002.log).

A report can be generated if you click on the Generate Report button. The Browse button
allows the user to locate and overwrite a .log file in another directory.

A report can be generated if you click the Generate Report button. The Browse button allows
the user to locate and overwrite a .log file in another directory. The Monitor utility displays
reports correctly when parameters from multiple sites are being logged.
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NOTE: If the list of variables is long, the actual log rate may be longer than the
selected rate.

If logging is stopped and started again, the message shown below is displayed.

FIGURE 116. LOG FILE ALREADY EXISTS MESSAGE

Three buttons are available.

· Click the OVERWRITE button if the existing log file is to be overwritten.

NOTE: Because all previously saved data will be erased, overwriting an existing file
is not advisable.

If the OVERWRITE button is selected, the following message is displayed to remind the
operator that using this feature will result in the existing file being overwritten. Click Yes to
overwrite the existing log. If No is selected, the message shown above will be redisplayed.

FIGURE 117. OVERWRITE CONFIGURATION MESSAGE

· Click the APPEND button if the existing log file is to be appended with the new data logs.

· Click the CREATE NEW LOG FILE button if the data logging is to be continued in a new
log file.
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8.2.2 Adding Parameters
Parameters can be added to the Monitor Dialog by selecting Edit - Add from the Menu bar or
by clicking on the Add button, on the toolbar. The Add command launches InPower. Use
Device Explorer to locate, select and copy the parameters that you want to add to the Monitor
dialog.

After selecting a parameter, use the drag-and-drop procedure to add the parameter to the
Monitor Dialog. (Or use the right menu button to Copy it, then move the cursor to the Monitor
Dialog and use the right menu button again to Paste the parameter into the Monitor Dialog.)

Monitor settings can be saved to a template (.TPL file). These files are saved in the Monitor
subdirectory of InPower. The template file stores the COM port information, this prevents the file
from working on another COM port.

Each monitor screen provides the ability to log sampled values into a tab delimited .LOG file.
This file format allows the data to be imported into Microsoft Excel.

8.2.3 Saving Parameters
Parameters values can be edited and saved in the controller flash memory from monitor utility.

1. To edit the parameter from monitor utility, double click on parameter or select the
parameter from monitor and go to menu Edit->Edit. The Change/Write dialog is launched.

FIGURE 118. CHANGE/WRITE ELEMENT DIALOG

2. After changing the value click on Change button. After clicking on Change button, The
Change/Write dialog closes and the monitor shows the changed parameter row in blue.
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FIGURE 119. CHANGED VALUE SHOWN IN BLUE

3. To launch the save adjustment dialog from the monitor utility, select menu items Edit-
>Save Adjustment or click on the save adjustment icon on the tool bar.

FIGURE 120. SAVE ADJUSTMENT MENU ITEM
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FIGURE 121. SAVE ADJUSTMENT TOOL BAR ICON

4. If one or more parameters are present in the save adjustment list. The Save adjustments
dialog is launched. The Save adjustment functionality is only supported by applications the
"Device explorer", "Monitor utility" and "Snapshot Configuration".

FIGURE 122.
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9 Faults and the Fault Information
System
This section describes the fault information features available for various types of devices.

9.1 Commercial Device Fault Information
The features include a Fault Information Window listing all active and inactive faults for a
connected device, a Snapshot dialog displaying additional details about those faults, and the
Fault Information System (FIS). The FIS feature is an online manual used to help diagnose
the fault.

9.1.1 Fault Information Window
Use the InPower Device Explorer to view Faults for a connected device. Fault information for a
device is only available when you are connected to the device.

To access the Fault Information Window, start InPower and connect to a port, then connect to
a device. Click on the Faults directory, listed under the device, to display fault information in the
right pane of Device Explorer.

Faults can also be viewed when connected to a device by clicking on the View Faults button,
on the toolbar. This shortcut displays the faults in the Faults directory.

Each fault is represented by a fault code indicating a particular malfunction or abnormal
condition within the device. The Service Manual and FIS reference this fault code to identify the
fault condition and facilitate diagnosis and repair.

Faults are either active or inactive. Active faults indicate that the fault condition is present now.
Inactive faults indicate a conditions that are no longer active. To change an active fault to
inactive, make the necessary adjustment or repair to correct the fault condition.

The Fault Information Window displays an entry for each fault that has been generated by the
device. All active faults are displayed first, followed by all inactive faults. The most recent fault is
displayed at the top of each list.

The following information describes the titles in the Fault Information dialog.

Fault Code: A numeric code that identifies the fault.

Description: A brief description of the fault.

Fault Status: Indicates whether the fault is active or inactive, at this time.

Count: Indicates the number of times that the fault has occurred since the last time the fault
data was cleared.

Last Occurrence: Indicates the amount of controller on time at the last occurrence. Time is
given in hours.

First Occurrence: Indicates the amount of controller on time at the first occurrence. Time is
given in hours.

Effect: Displays the effect of the fault on the device. The effect can be a Warning, Derate,
Shutdown with Cool Down, Shutdown, or none.
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Use this information to match a specific fault to the symptoms observed by the operator. This
information can help you determine which fault to address first.

9.1.2 Clearing Inactive Faults
Inactive faults can be cleared when the user is connected to the device. Click on the Clear
Faults button, on the toolbar (or select the Device menu, and click on Clear Faults, to remove
the faults). All inactive faults will be removed.

InPower does not allow removal of an individual inactive fault. If no inactive faults are present,
the Clear Faults button is disabled.

9.1.3 Snapshot
Snapshot contains sensor and switch values that are captured when the fault occurred.
Snapshot information is displayed in a separate Snapshot dialog.

To see snapshot information, double click on the Fault, or right click the mouse and select the
View-Snapshot menu item. The Snapshot dialog has a Previous (<<) and Next (>>) button to
move between the faults.

An engine related fault will have a Snapshot containing engine operating conditions at the time
the fault occurred. Some faults may not have a Snapshot.

NOTE: COT is Controller on Time and ERT stands for Engine Run Time.

9.1.3.1 Devices That Do Not Support Snapshot
Snapshot is not available with the PCC 1100, PCC 1300, PCC 1301, PCC 1302, PCC 2300,
and PCC 3300.

9.1.4 Fault Information System
The Fault Information System (FIS) contains an online manual that displays troubleshooting and
repair (help) files for commercial gensets.

To access the main Fault Information Window, select Fault Trees from the View menu or click
the View Fault Info. (magnifying glass icon), on the toolbar. The main Fault Information System
Window is displayed (Figure 123).

The FIS is designed as a standard Windows Help system. The system uses conventional
Windows Help techniques to display and find information. For example, you can:

· Click on text marked by a solid underline to open the window for that topic.

· Click on text marked by a dashed underline to display a pop-up window related to the text.
Click once to close the pop-up window.

· Use the buttons on the Button Bar to perform common Windows Help functions (Contents,
Search, Back, etc.).

· Use the Print Topic command from the File menu to print information related to the
current screen. (Note: pop-up windows and secondary Help windows will not print.)

Use the FIS main window to navigate to each of the systems main features as follows:

· Click on Fault Code Diagnostics to display descriptive information about a specific,
identifiable fault, or to display a troubleshooting step to correct a specific fault.
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· Click on Symptom Based Diagnostics when a fault code is not available and you need to
diagnose and troubleshoot the problem based on your observations.

· Click on Additional Information text to display information about service tools and general
engine servicing procedures, such as performing a continuity check.

· Click on Component Listing to display a list of components and a description of each
component.

· Click on Specifications to display a list of electrical or sensor specifications.

· Click on Theory of Operation to view a list of available subjects. Click on the desired
subject to view the basic theory of operation for the selected subject.

· Click on Wiring Diagrams to view a list of available wiring diagrams. Click on the desired
circuit text to view the wiring diagram.

FIGURE 123. MAIN FAULT INFORMATION SYSTEM WINDOW

9.1.4.1 Fault Code Diagnostics
Use the Fault Code Diagnostics feature to display diagnostic and troubleshooting information for
a specific fault code.

After selecting Fault Code Diagnostics, a list of fault codes is displayed (Figure 124). Click on
a specific underlined fault code to display more information about troubleshooting the fault.
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FIGURE 124. FAULT CODE DIAGNOSTICS

After clicking on a fault code, the Diagnostic Method window is displayed (Figure 125).

FIGURE 125. DIAGNOSTIC METHOD

Two diagnostic methods are provided, choose one these options:

· Click on Fault Code Overview to display the fault code, the cause of the fault and the
effect of the fault. This information will determine which fault to address first. You can
display a variety of other information related to the fault including fault location, description
and troubleshooting steps. (Refer to Fault Overview.)

· Click on Troubleshooting Steps to display a list of corrective actions to troubleshoot the
fault. You can display various levels of detail for each troubleshooting step. (Refer to
Troubleshooting Steps.)

9.1.4.2 Fault Code Overview
The Fault Code Overview feature is used to view summary information about the selected fault,
including the fault code, reason for the fault, and possible effects of the fault.

To display the fault Overview window (Figure 126), click on the Fault Code Overview text in
the Diagnostic Method window (Figure 125).
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FIGURE 126. OVERVIEW

From the Fault Overview window, you can display additional information about the fault and its
symptoms:

· Click on the Diagram button to display a specific circuit wiring diagram for the component
related to this fault.

· Click on the Shop Talk button to display added background information about the fault and
helpful troubleshooting tips.

· Click on Location (marked by a dotted underline) for a pop-up diagram that shows the
physical location of the part that is related to this fault.

· Click on the Description (marked by a dotted underline) for a pop-up description of the
part related to the fault and purpose of the part.

· Click on the Troubleshooting Steps (marked by a solid underline) for a list of steps to
help you correct this fault.

Use the Annotate command, from the Edit menu, to enter comments related to a fault. This
allows you to personalize the fault information for your site.

After entering a comment, a paper clip icon displays on the screen where the information was
entered. Click once on the paper clip icon to display the note.

Use the Search, Back and Glossary buttons, on the button bar, to find more information about
each fault and to navigate through the help system.

9.1.4.3 Troubleshooting Steps
Three levels of diagnostic help are available, depending on your needs and level of experience:

To display troubleshooting steps, click on Troubleshooting Steps from either the Diagnostics
Methods window or the Overview window.

1. Troubleshooting Steps are designed for trained and experienced technicians needing a
quick outline of the steps to take to correct the fault. This is the first screen that displays
when opening the Troubleshooting Steps window.

2. Summary Steps are designed for the technician wanting a more detailed overview of the
major troubleshooting steps required to correct the fault. A summary topic includes the step
description, a diagram, and specifications related to that step. It also provides some
guidelines for taking actions to correct the fault.

901-0108 (Issue 10) 123



9. Faults and the Fault Information System 12-2013

3. Guided Steps are designed for technicians wanting the most detailed information about
each step in the troubleshooting process. Guided steps provide a step-by-step path
through the troubleshooting process. Simply click on an OK icon to proceed to the next
step or click on the Not OK icon to receive summary information on how to correct the
problem before proceeding.

This section covers each of these types of steps in detail.

WARNING: Troubleshooting procedures present hazards that can result in severe
personal injury or death. Only trained and experienced personnel, with
knowledge of electricity and machinery hazards should perform service.

The Troubleshooting Steps window (Figure 127) provides a button bar for quick access to
other related information about the fault and its symptoms:

· Choose the Diagram button to display a circuit wiring diagram for the component that is
related to this fault.

· Choose the Shop Talk button to display added background information about the fault and
helpful troubleshooting tips.

· Choose the Conditions button to display a list of pre-testing conditions or setup
requirements that you should follow to make sure the best possible outcome from the
troubleshooting steps.

· Click on the Location text (marked by a dotted underline) for a pop-up diagram that shows
the physical location of the part related to the fault.

· Click on the Description text (marked by a dotted underline) for a pop-up description of
the part related to this fault and the purpose of the part.

· Choose the Overview text (marked by a solid underline) for descriptive information about
this fault.

FIGURE 127. TROUBLESHOOTING STEPS
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The Troubleshooting Steps list the steps in outline format. For example, Step 1, Step 1A, Step
1B, Step 2, Step 2A, Step 2B, and so on. Any cautionary notes or warnings associated with the
steps display in a pop-up box. Click anywhere outside these boxes to remove them from the
display and scroll through the window. You can re-display them at any time by clicking on the
Caution or Warning icon.

To display summary steps:

From the Troubleshooting Steps window, click on a major underlined step. For example, click
on Step 1 (not Step 1A).

The Summary window displays. It contains diagrams and specifications related to this step.

The troubleshooting procedures are organized so that a satisfactory result from each step will
lead you to the next step in the procedure. For example, if Step 1A is OK, immediately proceed
to Step 1B. Simply click on the Step number underlined, to go directly to it.

After performing a step and receiving unsatisfactory results, click on the Not OK icon in the
Actions column (Figure 128). A pop-up window will provide summary information on what to do
to correct the problem.

After reviewing the information, click on Summary Text, to display the next summary step for
this fault or click on Troubleshooting Steps to display the high-level summary of
troubleshooting steps.

FIGURE 128. SUMMARY STEPS

To display guided steps:

From the Troubleshooting Steps window, or Summary window, click on one of the detailed
troubleshooting steps. For example, click on Step 1A (not Step 1).

The Guided Step window displays (Figure 129). It contains diagnostic information specific to
this step.
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FIGURE 129. GUIDED STEPS

Any general conditions that should be met prior to performing the steps will display in a pop-up
box. Click once to remove the pop-up window from the display, then scroll through the window.
You can display these pop-up messages again by clicking on the Conditions button, on the
button bar.

If satisfactory results are received from this step, click on the OK icon to display the next guided
step for troubleshooting this fault.

If unsatisfactory results are received, click on the Not OK icon. A pop-up window will provide
summary information on how to correct the problem. Once the program is repaired, click on the
Repair Complete text in the pop-up window to go to the next guided step.

Click on Summary Text to display the next summary step for this fault, or click on
Troubleshooting Steps to display the high-level outline of troubleshooting steps.

9.1.4.4 Symptom Based Diagnostics
Use Symptom Based Diagnostics when the fault code is not known, but are aware of the
symptom.

This feature displays a list of common symptoms (Figure 130). Click on a symptom to view a
display of the possible cause of the symptom and a list of corrective actions (Figure 131).
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FIGURE 130. SYMPTOM BASED DIAGNOSTICS

FIGURE 131. SYMPTOM BASED TROUBLESHOOTING

9.1.4.5 Additional Information
After clicking on Additional Information, a list of general service topics are displayed (Figure
132). These topics contain general information about troubleshooting and service. Click on an
entry in the list to display more information about that topic. For example, click on How to Use a
Multimeter for basic instructions on how to use a multimeter.

When you are finished, use the buttons on the toolbar (such as Contents) to navigate another
part of the online manual. Close the Fault Tree window to return to InPower.
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FIGURE 132. ADDITIONAL INFORMATION

9.1.4.6 Component Listing
The Component Listing feature provides details about engine and control component locations
and descriptions. Click on the text in the Location column for a pop-up description of the
components location. Click on the text in the Description column for a pop-up description of the
component (Figure 133).

When finished, use the buttons on the toolbar (such as Contents) to navigate another part of
the online manual. Close the Fault Tree window, to return to InPower.

FIGURE 133. COMPONENT LISTING

9.1.4.7 Specifications
Click on Specifications to display a list of the selected specifications.

When finished viewing the specifications, use buttons on the toolbar (such as Contents) to
navigate another part of the online manual. Close the Fault Tree window to return to InPower.
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FIGURE 134. SPECIFICATIONS

9.1.4.8 Theory of Operation
The Theory of Operation feature describes operation of the selected component. Use the scroll
bars to view the text.

When you are finished, use the buttons on the toolbar (such as Contents) to navigate another
part of the online manual. Close the Fault Tree window to return to InPower.

FIGURE 135. THEORY OF OPERATION

9.1.4.9 Wiring Diagrams
The Wiring Diagrams feature displays a list of engine system components (Figure 137). Click
on one of the components to view a wiring diagram for that component.

When finished, use the buttons on the toolbar (such as Contents) to navigate another part of
the online manual. Close the Fault Tree window to return to InPower.
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CAUTION: Wiring Diagrams are subject to change. Refer to the wiring diagram supplied with
the equipment or in the manufacturer's service manual. Failure to use the correct
wiring diagram can result in severe personal injury or equipment damage.

9.1.4.10 Glossary
The Glossary contains an alphabetical listing of frequently used terms and their descriptions
(Figure 136). Use the Search feature, or the scroll bar to locate the desired term.

When finished, use the buttons on the toolbar (such as Contents) to navigate another part of
the online manual. Or close the Fault Tree window to return to InPower.

FIGURE 136. ONLINE GLOSSARY

FIGURE 137. WIRING DIAGRAM WINDOW
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9.2 Consumer Device Fault Information
Three categories of fault information are available with RV gensets: Advanced Fault Info, Fault
History, and Fault Occurrences. Marine gensets include the same three categories of fault
information plus an additional category, Fault Bypass Info.

The Fault Information Window displays detailed information for each of the parameters listed
in each category.

9.2.1 Fault Information
Use the InPower Device Explorer to view Faults for a connected device. Current fault
information for a device is only available when you are connected to the device.

To access the Fault Information Window, start InPower and connect to a port, then connect to
a device. To view the fault categories, select the device name and either expand the device
directory or else click on the View Faults shortcut button (Figure 138).

Each fault is represented by a fault code indicating a particular malfunction or abnormal
condition within the device.

FIGURE 138. FAULT INFORMATION WINDOW FOR RV GENSET

9.2.2 Advanced Fault Information
The Advanced Fault Information window (Figure 139) is for factory use only. This window
shows the number of faults enabled in the software. For some gensets, it also shows the
number of fuel faults enabled in the software.

NOTE: The time listed in the Time Last Read column is the time that InPower last
read the fault; it is not the actual time of occurrence.

9.2.3 Fault History
The Fault History window (Figure 139) lists all active fault codes for a connected device and the
last recorded faults that occurred (some display the last five faults).
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To find information about fault codes and how to correct faults, refer to the Fault Help menu.
Use this information to match a specific fault to the symptoms observed by the operator. This
information can help you determine which fault to address first.

NOTE: The time listed in the Time Last Read column is the time that InPower last
read the fault; it is not the actual time of occurrence.

FIGURE 139. ADVANCED FAULT INFORMATION

FIGURE 140. FAULT HISTORY

9.2.4 Fault Occurrences
The Fault Occurrences window (Figure 141) lists all possible faults that are available with the
device and the number of times each fault occurred.

NOTE: The time listed in the Time Last Read column is the time that InPower last
read the fault; it is not the actual time of occurrence.
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9.2.5 Fault Bypass Info
Fault Bypass Information (Figure 142) is only available with Marine MDDCx gensets. This
screen displays the number of minutes the control was operated in fault bypass mode and other
events that may have occurred while in fault bypass mode. If any of these events occur, a
number is placed in the Value column.

FIGURE 141. FAULT OCCURRENCES

FIGURE 142. FAULT BYPASS INFORMATION (FOR SELECT MARINE GENSETS ONLY)
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9.2.6 Clearing Inactive Faults
InPower does not allow removal of an individual inactive fault. The Clear Faults button is
disabled.

To clear faults, press the Stop or Start switch on the genset, as described in the genset
Operator's Manual.

9.2.7 Consumer Device Fault Information
Consumer Device Fault information is available from the Help menu (Figure 143). It includes a
list of possible faults that can occur with each genset model. Each individual fault includes a
fault description, a list of possible causes, and diagnosis and repair procedures.

FIGURE 143. CONSUMER DEVICE FAULT INFORMATION HELP FILES

9.3 ATS Faults
The ATS Faults features are covered in this section because the fault features for this device
are unique to transfer switches. The Faults directory for a typical transfer switch contains the
following groups (folders):

· Clear Faults

· Event History Log

· Event Records

134 901-0108 (Issue 10)



12-2013 9. Faults and the Fault Information System

9.3.1 Clear Faults
This group allows the user to Acknowledge faults, clear all inactive faults, or clear a specific
inactive fault. (Figure 144.)

Inactive faults can be acknowledged by double clicking on the Acknowledge Faults Value cell
and selecting True from the drop down list. Then click on the Save Trims button, on the tool
bar, to acknowledge the faults.

Inactive faults can be acknowledged by double clicking on the Acknowledge Faults Value cell
and selecting True from the drop down list. Then click on the Save Trims button, on the tool
bar, to acknowledge the faults.

All inactive faults can be cleared by double clicking on the Clear All Inactive Faults Value cell.
Then select ON, in the drop down list. Click on the Save Trims button, on the tool bar, to clear
all inactive faults.

Clear a specific inactive fault by double clicking on the Clear Specific Inactive Fault Value cell
and enter the fault code number. Then click on the Save Trims button, on the tool bar, to clear
the inactive fault.

FIGURE 144. CLEAR FAULTS

9.3.2 Event History Log
The following information describes the titles in the Event History Log. Events include both
events and warnings. (Figure 145.) Refer to the ATS Operator's manual for a complete
description of events.

Event Code: A numeric code that identifies the event.

Event Description: A brief description of the event.

Status: Indicates whether the event is active or inactive, at this time.

Occurrences: Indicates the number of times that the event has occurred since the last time the
event data was cleared.

Last Occurrence: Indicates the date and time of the most recent occurrence.

Last on Time: Controller on time in hours at time of last occurrence.
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Use this information to match a specific fault to the symptoms observed by the operator. This
information can help you determine which fault to address first.

FIGURE 145. EVENT HISTORY LOG

9.3.3 Event Records
This feature allows the user to view and configure each event.

The following information describes the titles in the Event Records dialog. (Figure 146.)

Event Description: A brief description of the event.

Occurrences: Indicates the number of times that the event has occurred since the last time the
event data was cleared.

Last Occurrence: Indicates the date and time of the most recent occurrence. If all zeros are
displayed, there have been no occurrences of the event.

Last on Time: Controller on time in hours at time of last occurrence.

Event Type: Indicates if the event is an event or a warning. This value is pre-configured and it
is not editable.

Event Priority: Events are pre-configured for high or low priority. When the ATS is connected in
a network application, High Priority events are sent over the network immediately. Low Priority
events are sent when polled.

Dialout Inactive: This value can be configured to send a dialout message whenever the
selected event occurs. Double click on the parameters Dialout Inactive Value cell and select
True from the drop down list. Click on the Save Trims button, on the tool bar, to save this
setting.

Dialout Active: This value can be configured to send a dialout message whenever the selected
event occurs. Double click on the parameters Dialout Active Value cell and select True from
the drop down list. Click on the Save Trims button, on the tool bar, to save this setting.
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Unacknowledged: This event status indicates when an event has not been acknowledged
(unacknowledged). Typically used in network applications to communicate if an event that has
occurred is unacknowledged (True). When the event is acknowledged, the Unacknowledged
value changes to False.

Status: Indicates whether the fault is Active or Inactive, at this time.

FIGURE 146. EVENT RECORDS
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10.1 Receiving Events
When connected to a device, InPower will receive events, and allow the user to acknowledge
events.

It is important to note that InPower is a service tool. InPower will receive and display events, but
it does not acknowledge events within the device. Monitoring should be performed with
operating software that is specifically designed for monitoring and event acknowledgment.

The Event Handler feature launches when InPower is started, and it closes when the InPower
session is ended.

Events are displayed in the Alarm dialog until InPower is closed, or the user clears
(acknowledges) the events. The record of event announcements is not stored from one session
of InPower to the next.

Acknowledging events removes the events displayed to the InPower user only.
Acknowledgement with InPower will not remove the event from the control.

InPower displays an Alarms popup dialog to view event information as soon as the event is
received. Users can clear events, view more information about an event, or simply close the
Alarm popup until the next time the device announces an event.

Be aware that event announcement and fault code diagnostics are not the same function.
InPower provides fault code and diagnostic information that is not related to event
announcement.

10.1.1 Devices That Cannot Receive Events
This feature is not applicable to PCC 1100, PCC 1300, and PCC 1301.

10.2 Displaying Events
InPower will display all events that have been received in an Alarm dialog. When the Auto-
Announce feature is enabled (default setting), the Alarm dialog pops up to displays of all the
events it contains. Additional details about the events are available in the Event Detail dialog.

10.2.1 Alarms Popup
The Alarm Popup provides details about events. The Alarms popup dialog menu features can
be used to view more details about an event, clear the event, or dock the Alarm Pop-up back to
the Windows taskbar. To launch the Alarms pop-up from the taskbar, click on the Alarms
button.

The Alarm Popup provides the following menu bar and button options.

View-Acknowledge All: Selects all displayed alarms and removes them from the Event popup
view.

View-Detail: Displays the Event Details dialog of the selected event.
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Options-AutoAnnounce: Displays a check box for displaying the Alarms Popup. If checked,
(default setting) the Alarms popup displays each time a new event is received. If unchecked,
the Alarms Popup will not open automatically to announce new events.

Help-Contents: Displays InPower help contents.

Help-Search: Used to searching for an InPower help topic.

Close Button: Used to dock the Alarms popup dialog to the Windows task bar.

Help Button: Used to access Event Announcement help.

The most recent event is added at the top of the list. One event will always be selected
(highlighted). Events received while the Alarm dialog is displayed will appear in the dialog
immediately.

10.2.1.1 Columns in the Alarms Popup
The Alarms popup provides the following columns:

Code: This displays the fault code associated with the event.

Description: This displays a textual description associated with the event. The description
comes from the controller.

Level: This indicates the type of event that occurred; for example, shutdown, warning, or none.
If this is not applicable to the controller (for example, a G-drive controller), the value is "None".

Status: This indicates whether the associated fault code became active or inactive in this event.

Site:

Module: This displays the type of device that reported the event.

Time: This displays the time at which the event occurred.

10.2.2 Event Detail
Events have additional detail associated with them. The user can view these details in the
Event Details dialog by selecting an event, then selecting View-Detail from the View menu.

The Event Details dialog provides the following button options:

Close Button: Closes the Event Details dialog and returns the user to the Alarms dialog.

Navigation Buttons: The left arrow button changes the Event Details dialog to display the next
event (down) on the Alarm dialog list. The right arrow changes the Event Detail dialog to display
the previous event (up) on the Alarm dialog list.

Help Button: Used to access Event Details help.

10.2.2.1 Columns in the Event Details Dialog
The Event Details dialog provides the following fields:

In the Alarms section,

Description: This displays a textual description associated with the event. The description
comes from the controller.

Status: This indicates whether the associated fault code became active or inactive in this event.

Level: This indicates the type of event that occurred; for example, shutdown, warning, or none.
If this is not applicable to the controller (for example, a G-drive controller), the value is "None".
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Code: This displays the fault code associated with the event.

Version:

Occurrences: This displays the number of times the event has occurred.

Last Occurrence: This field is blank.

Run Time Last: This displays the most recent time the event occurred.

First Occurrence: This field is blank.

Run Time First: This displays the first time the event occurred.

In the Module section,

Type: This displays the type of device that reported the event.

Address: This displays the network address of the device that reported the event.

In the Site section,

Site Id: This displays the name of the site; typically, the name of the COM port for devices or
the file name type for files, such as capture files.
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11 Strip Chart

11.1 Strip Chart
The Strip Chart feature displays data in a graphical form on a real-time strip chart. Up to six
parameters can be displayed in one chart. Data is scrolled from right to left, so the most recent
data appears at the right.

Chart parameters can be saved to chart file (.TPL file), allowing the user to save custom
parameter selections and settings. The chart file will store the charts graph settings (Y-axis
limits, sampling rate, line styles, etc.) and port identification. A chart file can be used with other
ports. Chart files are saved in the Strip Charts directory.

Data is not logged using the Strip Chart feature, in contrast to the Monitor feature.

11.1.1 Example of a Strip Chart

FIGURE 147. TYPICAL STRIP CHART

This example shows a typical strip chart. Each of the parameters contained in the chart are
named in the legend at the top of the chart. The Y-Axis displays the range of each parameter
value. The Time that the sample was taken for each interval is displayed at the bottom of the
chart.

11.1.2 Starting the Strip Chart Feature
The Strip Chart feature can be launched in two ways:

1. Launch strip chart from the Start Menu group shortcut.

2. Start InPower, connect to a device, and then click on the Strip Chart button, on the
InPower toolbar.

Starting a strip chart from InPower, while connected to a device, allows InPower to identify the
device and display the correct strip chart file type. This prevents accidentally opening a strip
chart file for the wrong device type.
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If the chart file does not exist, Strip Chart will display the File-Open screen, with a listing of
chart files in the Strip Charts directory.

11.2 Creating a Custom Strip Chart
Strip charts can be customized by adding or deleting parameters, adjusting the sampling rate,
changing line styles, changing the Y-axis limits and making format changes.

The user can customize an existing strip chart, or create a new strip chart and define each of its
properties. To create a new strip chart, launch the Strip Chart feature from the Start -> All
Programs menu, without specifying any chart file to open.

FIGURE 148. TYPICAL STRIP CHART

11.2.1 Adding Parameters
Click on Add Parameters, from the Edit menu, to launch InPower. To add parameters to the
strip chart, drag individual parameters from InPower (right pane) and drop the parameter on the
strip chart. Multiple parameter selections may be dragged and dropped on the Strip Chart, to
add several parameters at once. Parameters can also be added by selecting a parameter and
using the Edit - Copy command from InPower and the Edit - Paste command from the Strip
Chart menu bar.

Since parameters with different units of measure may be added to the graph, a separate Y-axis
will be displayed for each graphed parameter.

As parameters are added to the graph, an additional Y-axis will appear, indicating the
parameter's description and unit of measure. A new legend item will appear at the top of the
graph, indicating the point shape and color that will be used when plotting the parameter's
values, and these values will automatically begin to be displayed.

Immediately after the first parameter is added to the Strip Chart graph, the applet automatically
begins monitoring parameter values at half-second intervals. The sampling rate may be
modified via the Options dialog.
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11.2.2 Parameter Properties Dialog
The Parameter Properties dialog, shown in Figure 149, is accessible from the Edit-Properties
menu.

The Name combo box, at the top of the dialog, provides access to each of the parameters
currently displayed on the Strip Chart. The user may delete the selected parameter from the
strip chart by clicking on the Delete button.

The Data Ranges associated with the selected parameter may be modified by entering new
values into the edit boxes. These new values will control the minimum and maximum data
values displayed on the Y-axis of the graph.

The Line Attributes may also be modified by selecting a new line style from the Style combo
box. A new line color may be selected by clicking on the Color button, which invokes the
Windows common Color dialog. Current changes are applied after the user clicks on the OK
button, to close the dialog.

FIGURE 149. PARAMETER PROPERTIES

11.2.3 Sampling Rate Dialog
The Sampling rate feature is available from the Strip Chart - Options menu. The Sampling
Rate dialog, shown in Figure 150, allows the user to select the strip chart sampling rate.
Sampling can be enabled or disabled using the Sampling Enable feature (see Strip Chart
Menu Bar Functions).

FIGURE 150. SAMPLING RATE DIALOG

When finished customizing the strip chart, choose the File-Save As... menu option. Name the
file and save in the Strip Charts directory.
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NOTE: Saving a Custom Strip Chart saves only the chart settings, it does not save
(log) data.

See Context Menu for additional commands that are available for customizing strip charts.

11.2.4 Strip Chart Menu Bar Functions
This section describes each of the menu commands that are available from the Strip Chart
menu bar.

File-Open: Allows the user to specify a particular chart (.TPL) file to load from the list of chart
files, in the Strip Chart directory. Logged data (.LOG file) can also be opened and viewed with
the Strip Chart feature.

After a .TPL file has been selected, the applet will open the file and load the parameters and
settings from that file. Since parameter values will be graphed, only the first six parameters that
have numeric values will be accepted.

File- Save: Allows saving the current selection of parameters to a chart file.

File - Save As: Allows saving the current set of parameters to a new chart file name and/or
location.

File-Close: Closes the Strip Chart

Edit-Add Parameter: Allows adding parameters to the Strip Chart graph from InPower. This
command opens InPower, allowing the user to select parameters to be added to the Strip Chart.
Drag individual parameters from InPower and drop the parameter on the Strip Chart graph.

Edit-Paste: Allows pasting the parameter(s) from the Windows clipboard into the strip chart.
The Paste menu option will remain disabled until one or more parameters have been cut or
copied to the Windows Clipboard.

Edit-Properties: Opens the Element Properties dialog. (This feature can also be activated by
double clicking on the parameter names in the strip chart's legend.) The Element Properties
dialog allows the user to perform a variety of commands relating to the display properties of the
Strip Chart.

Options-Sampling: This option displays the Sampling Rate dialog, which allows the user to
change the strip chart sampling rate. The sample rate is adjustable from 0.05 seconds to 60
seconds.

Options-Sampling Enable: This option is used to enable or disable the collection of sample
data. A check mark is displayed next to Sampling Enable on the Options drop down menu to
indicate that the feature is enabled. Click once on Sampling Enable to stop collecting sample
data. Click on it again to start collecting sample data again.

Options-Logging: This option provides you with a means to assign a location for storing strip
log files. The default file location is listed on the menu (Figure 151). If necessary, select the
Browse button to select another location. Logging can be enabled from this menu. When all
adjustments are completed, click on the OK button.
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FIGURE 151. LOGGING DIALOG

Options-Logging Enabled: This option is used to enable the logging option to save a file at the
location set up with the Logging dialog. If a strip chart log has already been created, the
message shown in Figure 152 is displayed.

FIGURE 152. LOGGING MESSAGE

11.2.5 Context Menu Features
The Context Menu, shown in Figure 153, may be accessed by clicking on the right mouse
button (or equivalent pointing device button) while the cursor is inside the graph. This set of
menu items provides the users with additional customization features.

FIGURE 153. CONTEXT MENU FEATURES (RIGHT MENU BUTTON)

Viewing Style: This controls the viewing style of the object. Possible values include color,
monochrome, or monochrome with symbols.
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Font Size: This controls the font size used in the graph's image creation process. The font sizes
available are large, medium, or small.

NOTE: It is recommended that the user change the Font Size to the Medium setting
or Large setting if only a few parameters are being monitored. This selection
will make it easier to read the parameter legends.

Numeric Precision: This controls the number of decimal places associated with the graph's
data. Possible values include zero, one, two or three decimal places.

Data Shadows: This controls whether shadows will be placed behind plotting method graphics.
The shadows add depth to the images; however, they will slow image creation significantly
when graphing many subsets and/or points.

Grid Lines: This controls the horizontal and vertical lines that make up the graphs grid.
Possible values include horizontal and vertical grid lines, horizontal grid lines only, vertical grid
lines only, or no grid lines.

Grid In Front: This controls whether the graphs grid is placed behind or in front of the plotting
method graphics.

Graph and/or Table: This controls what is displayed in the graph's area. Possible values
include graph, table, or graph with table.

What to Table: This controls what information is included in the objects table. Possible values
include tabling those subsets that are graphed or tabling all subsets.

Point Label Orientation: This controls the orientation of the point labels. Possible values
include automatic, horizontal, or vertical.

Mark Data Points: This controls whether data-points are marked with a small circle.

Maximize: This function maximizes the graph display. To return to the default display size, click
inside the solid bar at the top of the window or use the Esc key.

Customization Dialog: This function displays the chart Customization dialog.

Export Dialog: Graphs can be exported in the formats shown in Table 4, for the listed
destinations. This dialog allows the user to print a Strip Chart.

TABLE 4. GRAPH EXPORTABLE FORMATS

FORMAT DESTINATIONS

Metafile Clipboard, File, and Printer

Bitmap Clipboard and File

OLE Object Clipboard

Text / Data Clipboard and File

Help: Displays graph-related help topics.

11.2.6 Chart Customization Dialog
An additional level of editing is available that allows the user to customize the chart dialog. To
access this feature, double click within the chart to display the Customization dialog. This
dialog has tabs for each of the editable features.
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Click on the desired tab to view the available settings for that feature. These features can be
used to enhance the chart by changing border colors, text size and colors, and many other chart
display features.

FIGURE 154. CHART CUSTOMIZATION DIALOG

11.2.7 Printing a Strip Chart
A Strip Chart can be printed by using the Export dialog (Figure 155). Use the right menu button
to access the Export Dialog, then select the Printer radio button and select the Print button.

FIGURE 155. EXPORT - PRINT DIALOG

11.2.8 Viewing Logged Data
Logged data, created with the Monitor feature can be displayed with the Strip Chart feature.
Select Open from the Strip Chart File menu. Enter the .LOG file location and name.

Strip Chart will display the logged data. Since the data is not being displayed on a realtime
basis, the data is static. Use the left and right arrow buttons located on the keyboard to navigate
the data within the .LOG file.
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12 Capture File

12.1 PCC 1100 Limitation
This feature is not applicable to PCC 1100.

12.2 Capture File
InPower provides a method of extracting (capturing) a device's parameter values. Capturing
saves device information in a file that is identified with a .CAP extension. The files are saved in
the Capture Files directory.

Capture files are used to store a copy of a device's parameter values, History and Faults.
Capture files are read only files that can be viewed after disconnecting from the device. Capture
files can also be used as a template to write the captured settings to another device of the same
type.

12.3 Creating a Capture File
Capture files can be created by selecting the Capture to File command from the Device menu.
This feature displays the Capture File dialog, which is similar to Save As dialog.

The user names the file, and InPower appends the file name with the .CAP extension. Capture
files are not editable by InPower (read-only). A capture file can be overwritten, allowing the user
to re-capture parameters and settings to the same file.

12.3.1 Creating a Capture File Automatically
A Capture files will be automatically captured each time you connect to a site or you will be
prompted to create one, depending on your setup selection.

If Capture to File is selected, a default filename will be created. This filename can be changed.

12.4 Viewing a Capture File
To view a capture file, the user must connect to it using InPower. Double click on the Capture
file name in the Capture Files directory structure. Capture file contents can be viewed, like
devices, using Device Explorer.

In InPower, the capture file is compared with support files. If a parameter is found in Support
files but not found in the capture file, the tool will give a warning message. If parameters which
are not supported in the firmware are removed from Support file, the capture file will get
connected without showing any warning message.
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FIGURE 156. VIEW CAPTURE FILE WARNING MESSAGE

12.5 Writing to a Device
Capture files can be used to overwrite the parameter values of a connected device (of the same
device type) with the parameter values from a capture file. One capture file can be used
repeatedly (like a template) to configure many devices of the same type.

When a device has password protected parameters, the password protection applies when
writing a Capture file to the device. The user must enter the required password(s) before the
password protected parameters can be changed with the Capture file.

To write to a device you must have registered software of the correct device type.

To write from a Capture file, connect to the Capture file first, then click on the target device, and
connect to it. Next, select the Capture file and drag-and-drop the Capture file onto the target
device.

The Edit - Copy and Edit - Paste features can also be used to write parameter settings from a
Capture file to a device. This feature can be used to copy the entire Capture file, or individual
folders or parameters.

Start by connecting to the Capture file, Use Edit - Copy to copy the desired information from
the Capture file. When copying a folder or individual parameters, use Device explorer to display
the desired folder or parameters in the right pane. Hold down the Control key while selecting the
desired folder (s) or parameter(s) then use the Edit - Copy command. Connect to the target
device and use the Edit - Paste feature to overwrite the target device's parameters with the
parameter settings from the Capture file.

NOTE: A capture file from a genset (for example) can be copied to another genset,
but it cannot be copied to a transfer switch control, or any other device type.
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13 Simulator
InPower provides a means of demonstrating the service tool without connecting to an actual
device. A Capture file is used for simulation. This file contains most of the information that is
normally displayed when you are connected to a device.

Any capture file(s) used for simulation are added during InPower installation. These files are
device specific, for example, if you install a genset InPower product, you will only receive genset
Simulator files.

Simulator files are read only, although during simulation, the user will be allowed to make
editorial changes, to help demonstrate the tool. Any changes made during simulation will not be
saved.

If an arrow is displayed, click on the arrow to view a drop-down list of the available settings.
Click on the desired setting, and it will be entered into the Value cell.

The simulator file(s) are stored in the Simulator directory. To run an InPower simulation, double
click on the Simulator directory and then double click on the desired simulator file (*.CAP file).
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14 Reports
This section describes how to create, save and print reports. Reports consist of parameter
groups and their values at the time the report was created. Reports can be printed directly from
InPower, or they can be saved to a file for use in a spreadsheet, database, or word processing
program.

14.1 Creating a Report
Start InPower and connect to a port, then connect to a device (or file). Use the Device Explorer
(tree view) to locate and select the information you wish to include in the report.

NOTE: When selecting parameters for a report, be careful to avoid selecting too
many parameters. If a folder is selected that contains additional folders, the
parameters of all of the folders in the group will be selected.

You can create a report from a single group of parameters or from several groups of
parameters. A few smaller reports are generally more manageable than a very large report.

To create a report for a single group of parameters: Select the group folder, if it contains
additional folders, double click on the folder to expand it. Select the desired folder and use the
mouse or keyboard menu button to display the pop-up menu (Figure 157). Select Print Feature
from the pop-up menu, to create a report for the selected folder and display the Parameter List
Report window (Figure 158).

To create a report with more than one group of parameters: Select each folder individually,
use the mouse or keyboard menu button to display the popup menu, click on Select Feature, in
the popup menu. Each folder selected will be marked with a check mark, to indicate that it has
been selected for use in the report (Figure 157).

After selecting the desired parameter groups, use the Prepare CSV file with all Selected
Features menu pick from the InPower Device menu to create a report and display the
Parameter List Report window (Figure 158).

NOTE: If you only want to create a report on one feature, select the feature, right-
click and select the Prepare CSV file for Feature menu pick.

Selected folders can be deselected by clicking on a folder with a check mark, then use the
mouse or keyboard menu button to display the pop-up menu, click on Deselect Feature, in the
pop-up menu.

The Parameter List Report window allows viewing the report contents. Each selected
parameter group is shown.
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FIGURE 157. SELECTING FEATURES FOR A REPORT

FIGURE 158. PARAMETER LIST REPORT WINDOW

14.2 Support Reports
A Support Report can be created and Emailed.

To create a Support Report,

1. Select Help > Send Support Report.
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FIGURE 159. LAUNCHING THE SEND SUPPORT REPORT FEATURE

2. When the ETools Support Report Utility dialog is displayed, enter an Issue Title and
Issue Description.

FIGURE 160. ETOOLS SUPPORT REPORT UTILITY DIALOG

901-0108 (Issue 10) 157



14. Reports 12-2013

If these fields are not filled in, the following error message is displayed when attempting to
save the report.

FIGURE 161. ERROR REPORT UTILITY MESSAGE

3. Click Save Report. The following message is displayed. Click OK.

FIGURE 162. SAVED REPORT MESSAGE

4. If you wish to attach additional files, click Attach File. Navigate to the location the file is
stored, select it, and click OK. The total attachment size cannot exceed 2MB. If this limit is
exceeded, the following message is displayed.

FIGURE 163. ATTACHMENT SIZE EXCEEDED MESSAGE

NOTE: A file can also be removed by using the Remove Attachment button.

If, after creating a Report, you wish to Email it,

1. Click Email Report on the ETools Support Report Utility dialog box. The report is saved in
ZIP format at the default location.
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2. Once the Report is saved, an Email message with the default mailbox location for
Cummins InPower support is displayed. Click Send.

FIGURE 164. EMAIL FOR ERROR REPORT

If you wish to view an existing report, click Open Report Folder on the Error Report Utility
dialog box. The default error report location (D:\Program Files\Power
Generation\Shared\Reports) is displayed.

FIGURE 165. ERROR REPORT DEFAULT LOCATION
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15 Event Configuration
This section describes how to use the Events Configuration feature. This feature is only used
with genset applications. Event Configuration allows the InPower user to configure both the
Fault Effect and the Notification settings for Faults.

The term events refers to status changes that can be viewed on a control display or with
InPower. There are two types of events, fault events and non-fault events. The Event
Configuration feature is used to configure fault events (Faults). Faults represent genset
operating conditions that are outside the normal operating range or setting.

Start InPower and connect to the port (COM1, COM2, etc.) being used for connection to the
device.

Click on the Events Configuration folder to view the Events Configuration parameters (Figure
166). This group displays all of the genset Faults numerically, by Fault Code. Also displayed are
the Fault Descriptions, current Fault Effect settings and current Notification settings.

15.1 Devices That Do Not Support Event Configuration
This feature is not applicable to PCC 1100, PCC 1300, PCC 1301, and MCC 3320.

15.2 Fault Effect
Fault Effect is used to configure the action taken when a fault becomes active. All faults are
pre-configured with a fault effect.

The severity of the effect generally cannot be decreased. For example: Engine Overspeed
cannot be changed from Shutdown to Warning.

In genset applications, there are five possible Fault Effect settings.

None: When a Fault Effect is set to None, there is no effect when the fault becomes active
(including no dialout notification).

Warning: A warning message is delivered to the control display and to InPower when InPower
is connected to the device.

Derate: Faults configured for Derate will act like a Warning when the fault is active. If a
parameter has a factory set derate percentage the genset will derate to that setting when the
fault is active.

Shutdown: Faults configured for Shutdown will cause the genset to shutdown immediately
when the fault is active.

Shutdown Cooldown: Faults configured for Shutdown Cooldown will shed the load (if
available) and shut the genset down after a cooldown period, when the fault is active.

To change the effect of a fault, double click on the Fault Effects value cell, for the desired fault.
A drop-down arrow will be displayed. Click on the drop-down arrow to display the setting
choices (Figure 166). Click on the desired effect, to select it.. Click on the Save Trims button,
on the toolbar, to write the new value to the device.
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FIGURE 166. FAULT EFFECT

15.3 Notification
Notification refers to annunciation of the fault for remote monitoring. In order to remotely monitor
genset faults, the Fault Notification setting must to set to Dial Out.

There are two possible settings for Notification as follows:

Don't Dial Out: When Notification is set to Don't Dial Out, the control will not attempt to dial out
when the fault becomes active.

Dial Out: When Notification is set to Dial Out, and remote site(s) are configured, the control will
attempt to dial out to annunciate the fault to one or more remote locations. The modem must be
enabled, a valid dialout number must be entered, and the fault Effect must not be set to None.

To change the Notification setting for a Fault, double click on the Notification value cell, for the
desired fault. A drop-down arrow will display, click on the drop-down arrow to display the setting
choices (Figure 167). Click on the desired effect, to select it. Click on the Save Trims button,
on the toolbar, to write the new value to the device.

FIGURE 167. NOTIFICATION
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16 Remote Communication
This section describes how to setup and use InPower for remote communication with a
PowerCommand® controlled genset.

InPower cannot be used to remotely monitor Automatic Transfer Switches. Use the optional
network module for remote communication with an Automatic Transfer Switch.

WARNING: Electrical shock and moving parts can cause severe personal injury or death.
Notify personnel before starting a generator set and before performing load
transfer on a transfer switch. Refer to the equipment Operator's Manual for
important safety precautions.

InPower can also be used to configure a genset to dialout events for remote monitoring with
monitoring software or with InPower.

Read through this entire section to become familiar with the remote communication features and
uses before configuring a genset control for remote communications.

16.1 Remote Connections
Figure 168 and Figure 169 show typical remote connections. Two modems are available for
use with InPower, a standard modem and one designed for mounting to a DIN rail.

FIGURE 168. INPOWER SERIAL CONNECTION (TYPE 1 CONNECTION BOX)
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FIGURE 169. INPOWER SERIAL CONNECTION (TYPE 2 CONNECTION BOX)

16.2 Remote Site Setup
The following procedures describe how to setup InPower for remote communication.

The Setup feature is accessed from the Start menu by clicking on the Power Generation -
InPower program group. Click on Setup, to launch the Setup dialog.

If a TAPI Error message appears, you may be using Windows 95 operating software.
InPower does not support remote communications with Windows 95.

The user will need to define a new site, then add a device for that site and apply the changes.

16.2.1 Site Setup
Click on the Site Setup tab to access the Site Setup dialog (Figure 170). Click on the Add
button, to display the Create Site dialog (Figure 171).

16.2.2 Create Site
Enter the following information in the dialog to create a new remote site:

Site Type - Select Physical from the drop down list.

Site ID - Enter a port name, use Remote in this example.

Protocol - Select goal as the protocol from the drop down list.

164 901-0108 (Issue 10)



12-2013 16. Remote Communication

Location - Enter Remote, from the drop down list.

Telephone Number: Enter the telephone number of the phone line connected to the modem at
the site location.

Click on the OK button to save the new site. This establishes the port, next, setup a device for
this port.

FIGURE 170. SITE SETUP DIALOG

FIGURE 171. CREATE SITE DIALOG

16.2.3 Device Setup
Click on Remote, in the Site List, then click on the Device Setup button to access the Device
Setup dialog. Click on the Add button to access the Create Device dialog (Figure 173). For
remote communication, enter the following information in the Create Device dialog:

Device ID - Enter Remote.

Device Name - Enter Genset.

Device Type: Click on the drop-down arrow, then scroll to and select pcf_dvc.
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Click on the OK buttons for the Create Device and Device Setup dialogs, then click on Apply to
save the settings. Click on OK to complete the setup and close the Site Setup dialog.

FIGURE 172. DEVICE SETUP

FIGURE 173. CREATE DEVICE DIALOG

16.2.4 Communications Setup
The Communications setup feature is used to enable incoming calls for remote InPower Users.

Enable this feature by clicking on the Allow incoming calls checkbox. (Check mark appears in
checkbox when the feature is enabled.)

In the Incoming Calls Use modem combo box, select the desired modem. Only one modem
can be selected.

In the Remote Connections Use modem combo box, select the modem to use for outgoing
calls (for remote sites). The names of all modems currently installed on the system will be listed
in the drop-down list. The First Available selection allows the Windows TAPI program to select
an available modem.

When available, Local or Remote LON Network Connections can also be set.
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FIGURE 174. COMMUNICATIONS SETUP

16.3 Remote Connection with InPower
InPower can be used to remotely connect to a genset. Before attempting remote
communication, perform the Remote Site Setup steps and make sure that the modem is
enabled.

Start InPower and connect to the site that was used for remote connection (named Remote in
this example).

A dialing status window is displayed during dialout. When connected to the device, InPower
Device Explorer opens and displays the device the same way it does with a local connection
(Figure 175).

To write to a device you must have registered software of the correct device type.

When a device has password protected parameters, the password protection applies when
using a remote connection. The user must enter the required password(s) before the password
protected parameters can be changed.
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FIGURE 175. REMOTE CONNECTION

16.4 Dialout Configuration
This section describes the modem setup parameters used for dialing out. To configure the
device for dialout, the service PC must be directly connected to the device (Dialout
Configuration cannot be done remotely).

Start InPower and connect to the port (COM1, COM2, etc.) that matches the COM port on the
service PC, used for connection to the device. Double click on the COM port (or click on the
COM port and then click on the Connect button, on the toolbar).

The modem setup parameters are located in the Adjustments - Features folder. Double click
on these folders to display the Direct Connect Modem Setup folder. Click on this folder to view
the modem setup parameters (Figure 176).

The following list describes the modem setup parameters:

Modem Hangup Delay: Enable this feature to remain connected for two minutes after
delivering a dialout message.

Modem: This feature must be Enabled in order to use the modem.

Dial Out Attempts: Used to set the number of times a number will be dialed while attempting to
deliver a dial out message. The default setting, zero, is equal to one attempt. (The recommend
setting is 10.)

Modem Configuration String: Used to enter the modem configuration string for the specific
modem in use. See Section 16.5 for the modem init strings for each of the modems that are
used with InPower.

NOTE: The modem configuration string is preconfigured when one of the optional
modems is factory installed.
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Dialout Numbers 1 through 4: These are the dialout numbers for the location(s) that are
monitoring the device. Use a comma (,) to pause, and start with a P for pulse dialing.

Dial Out Retry Delay: Enter the time delay between dialout attempts (in minutes).

Clear Undelivered Events: This feature clears all pending dialouts.

Dialout Break: When enabled, this feature breaks the connection after two minutes in order to
complete a dialout.

Set the modem parameters, then click on the Save Trims button, on the toolbar, to write
modem setup values to the device.

FIGURE 176. DIRECT CONNECT MODEM SETUP

16.5 Modems
There are two modems that can be used with InPower. The two modems each have a unique
init string (Modem Configuration String). When a modem is installed in the field, it is important to
identify the modem brand, and enter the proper init string using InPower.

Both of these modems can be powered with a DC power supply.

When using InPower locally, do not remove the modem connection from the serial port until
after the modem power has been turned off. Do not re-apply power to the modem until after it
has been reconnected to the device's serial port. Failure to follow this sequence can result in
loss of the modem configuration string.

CAUTION: The modem configuration string can be lost, preventing dialout of important
messages if power to the modem is not turned off and on in the proper sequence.
Whenever the dialout modem is disconnected for access to the device's serial port,
the modem first must be turned off. The modem should not be turned on again until
after it has been reconnected.

The modem used for dialout should be connected through the normally closed contacts of the
modem power relay. This is required because when the control is off (and the driver is off) the
modem has to be able to receive dial-in calls, to wake up the controller.
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16.5.1 Modem Configuration Strings
Use the following information for configuring one of the two available modems for use with
InPower:

Multitech Model MT3334ZDX

Modem Configuration String:

ATE0V0Q0&C1%C0&D0&K0N0\N0$SB9600S0=1S25=25S37=9&W0

Industrial Modem Model VT-Modem-1US by Sixnet.

Modem Configuration String:

ATE0V0Q0&C1%C0&D0&K0N0\N0S0=1S25=25S37=9&W0

16.6 Remote Monitoring
PowerCommand controlled Gensets can be monitored from a remote location. Use InPower to
perform the Setup and Dialout Configuration. Make sure that the Allow incoming calls feature
is enabled, in the Communication setup.

After making the necessary remote connections (Figure 168 and Figure 169), the monitoring
software is used to receive dialout events from the genset control.

Using InPower for remote monitoring:

Start InPower, but do not connect to a port. Double click on the Alarm Popup icon (exploding
fire cracker icon) located on the Task Bar in the lower right corner of your monitor. Enable the
AutoAnnounce feature in the Alarm Popup Options menu.

When enabled (checked), the Alarms Popup displays each time a new event is received. If
unchecked, the Alarms Popup will not open automatically to announce new events. InPower
must remain running when it is being used for monitoring a remote genset. The InPower
program can be minimized to the Task Bar.

The most recent event is added at the top of the list. One event will always be selected
(highlighted). Events received while the Alarm dialog is displayed will appear in the dialog
immediately.
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17 Network Applications
This section describes how to use InPower to configure network settings and how to configure
devices over a commissioned network.

17.1 Network Configuration
A LonWorks folder has been added in the Adjustments directory for PCC 3200, PCC 2100
and PowerCommand transfer switch controls. This group of parameters is used to configure
network settings. Each device type has a unique group of settings.

PCC 3100 controls use a GCM for network applications. Network settings for this device are
available through a plug-in, used with LonMaker.

The service PC, with InPower version 3.0 or later, must be connected to the genset or ATS, in
order to configure the network settings.

17.2 PCC 2100
Start InPower and connect to the port (COM1, COM2, etc.) that matches the COM port on the
service PC, that is being used for the PCC 2100 genset connection.

Open the Adjustments folder, and then the LonWorks folder (Figure 177). The following group
of parameters are available for network configuration:

· Custom Annunciation

· Customer Outputs

· Device

· Dialout

· Fault Settings

This section describes how to use each of the parameter groups, in the PCC 2100 LonWorks
directory. Press the Reset button on the NCM, after saving changes to the PCC 2100, to write
the changes from the base board to the NCM.

17.2.1 Custom Annunciation
The Custom Annunciation feature allows the customer to select up to 16 different fault codes to
be sent to an annunciator, when the fault becomes active. A listing of fault codes can be viewed
with InPower, in the Fault Settings folder.

The desired fault codes are entered directly into a Data Table (Figure 177). Select the Custom
Annunciation feature and double click on the Data Table Value cell. The Data Table will open
in a new window.

To enter or edit data in the table, click on the first Event Identifier field, then enter the desired
fault code number into the edit box, next to the check mark. Click on the check mark to enter
the fault code number into the Event Identifier table. Repeat this process until all of the desired
fault codes have been entered.

Click on the Save button, to update the Data Table changes. Click on Close, when you are
finished adding fault codes or making changes.
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Click on the Save Trims button, on the toolbar, to write the Custom Annunciation Data Table
settings to the device. Press the Reset button, on the NCM, to download the new data table
settings from the base board to the NCM.

The Paste button is used to import spreadsheet value data from an Excel spreadsheet. This
feature is useful for configuring multiple devices with the same event fault codes.

FIGURE 177. LONWORKS - PCC 2100 CUSTOM ANNUNCIATION

17.2.2 Custom Relay Events
The Custom Relay Events feature allows the customer to enter up to 16 fault codes that will
actuate a corresponding relay on the optional Digital I/O Module. When the selected fault
becomes active, the corresponding relay will energize, and remain energized until the fault
becomes inactive.

A listing of fault codes can be viewed with InPower, in the Fault Settings folder.

The fault codes are entered directly into a Data Table (Figure 178). Select the Custom Relay
Events feature and double click on the Data Table Value cell. The Data Table will open in a
new window.

To enter or edit data in the table, click on the first Event Identifier field, then enter the desired
fault code number into the edit box, next to the check mark. Click on the check mark to enter
the fault code number into the Event Identifier table. Repeat this process until all of the desired
fault codes have been entered.

Click on the Save button, to update the Data Table changes. Click on Close, when you are
finished adding fault codes or making changes.
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Click on the Save Trims button, on the toolbar, to write the Custom Annunciation Data Table
settings to the device. Press the Reset button, on the NCM, to download the new data table
settings from the base board to the NCM.

The Paste button is used to import spreadsheet value data from an Excel spreadsheet. This
feature is useful for configuring multiple devices with the same event fault codes.

FIGURE 178. LONWORKS - PCC 2100 CUSTOM RELAY EVENTS
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FIGURE 179. INPOWER CONNECTION TO DEVICES OVER LONWORKS SITE

17.2.3 Device
The Device group of parameters allows the user view and edit several parameters related to the
network site, the device and network performance. Use these settings as follows:

Site ID: The site ID must consist of no more than seven characters. The characters can only be
a combination of upper case letters, numbers and underscores. Do not use spaces, special
characters, or lower case letters in the Site ID.

Location: Enter a description for the location of the unit (up to 16 characters).

Name: The device Name (tag) is used when sending system data. Provide a different name for
each device on the network (up to 16 characters).

Terminated: Displays the network termination switch setting on the network module (the
network module must be installed and enabled to be read).

Update Interval: Use to set the send time for analog network variables and the network status
check. The default 2 second interval is recommended.
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Test Interval: Use to set the send time for the network test interval. The default 10 second
interval is recommended.

LonWorks Card: Use to disable the network feature after the network module has been
removed.

After making any necessary adjustments, click on the Save Trims button, on the toolbar, to
write the settings to the device. Press the Reset button, on the NCM, to download the new data
from the base board to the NCM.

FIGURE 180. LONWORKS - PCC 2100 DEVICE

17.2.4 Dialout
The Dialout group of parameters allows the customer to configure the dialout settings for remote
monitoring of devices on the network. Use these settings as follows:

Host 1 thru 5: Enable the number of remote monitoring sites (hosts) that you want to send
alarm messages to. Click on the value cell and select Enabled from the drop-down list.

Dialout Retries: Used to set the number of dialout retries, if the first alarm dialout fails while
attempting to deliver a dial out message. The default setting 10, is the recommended setting. A
setting of zero, is equal to one attempt.

Retry Delay: Enter the time delay between dialout attempts. The recommended setting is 60
seconds.

Dialout Break: When enabled, this feature breaks a current connection after two minutes in
order to complete a dialout.

Connection Timeout: After a dialout command has been sent to the modem, this feature
specifies how long to wait for the site to connect to the remote monitoring location. The default
setting is 60 seconds.

If the site does not connect with the remote monitoring location, it will dialout to Host 2, Host 3,
etc. (if additional hosts are enabled) until it connects. If it still does not connect, it will repeat the
process, beginning with Host 1, based on the number of retries that have been set.
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After making any necessary adjustments, click on the Save Trims button, on the toolbar, to
write the settings to the device. Press the Reset button, on the NCM, to download the new data
from the base board to the NCM.

FIGURE 181. LONWORKS - PCC 2100 DIALOUT

17.2.5 Fault Settings
The Fault Settings group allows you to name the network input message (event name) for
Network Inputs 1 through 8, and view their status. This feature also allows you to assign a fault
code to the Battery Charger AC Failure and S1 Circuit Breaker Trip.

Use these settings as follows:

Network Input Status (1 - 8): Displays the current status of the fault (Active or Inactive) in the
Value field for each of the eight network inputs. Use the Refresh button, on the toolbar, to
update the value fields.

Network Input Event Name (1 - 8): Allows the user to enter a description for network input 1
through 8. Double click the value cell and enter the new description. The new name should
define the customer network input such as Open Louvre or Remote Cooling Fan On. This event
name will be displayed when the network input becomes active.

Battery Charger AC Failure Fault Code: Enter a fault code number for an event related to this
fault. As an example for genset use fault code 1311 or 1312.

Refer to the Events and Faults folder for fault code descriptions.

Utility Circuit Breaker Trip Fault Code: Enter a fault code number for an event related to this
fault. As an example for paralleling use fault code 1317 or 1318.

After making any necessary adjustments, click on the Save Trims button, on the toolbar, to
write the settings to the device. Press the Reset button, on the NCM, to download the new data
from the base board to the NCM.
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FIGURE 182. LONWORKS - PCC 2100 FAULT SETTINGS

17.2.6 PCC 2100 Events and Faults Configuration
When setting up the network settings for a PCC 2100 control, refer to the Events and Faults
folder (Figure 183).

The last columns allow the user to Bypass (disable) the notification (Dial Out). This feature
allows the user to eliminate nuisance event messages by setting the Bypass value to Enabled.
Some events may not be bypassed, like Overspeed and Speed Governor Signal.

Review the settings in this parameter group to make sure the desired settings are configured.

To configure a fault to dial out for remote monitoring, go to the Notification value field for the
fault and double click on the Notification value cell, select Dial Out from the drop-down list.

After making any necessary adjustments, click on the Save Trims button, on the toolbar, to
write the settings to the device. Press the Reset button, on the NCM, to download the new data
from the base board to the NCM.

901-0108 (Issue 10) 177



17. Network Applications 12-2013

FIGURE 183. EVENTS AND FAULTS

17.3 PCC 3200
Start InPower and connect to the port (COM1, COM2, etc.) that matches the COM port on the
service PC, that is being used for the PCC 3200 genset connection.

Open the Adjustments folder, and then the LonWorks folder (Figure 184). The following
parameter groups are available for network configuration:

· Custom Annunciation

· Customer Outputs

· Device

· Dialout

· Fault Settings

This section describes how to use each of the parameter groups, in the PCC 3200 LonWorks
directory. Press the Reset button on the genset LonWorks card (GLC), after saving changes to
the PCC 3200, to write the changes from the base board to the GLC.
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FIGURE 184. LONWORKS - PCC 3200

17.3.1 Custom Annunciation
The Custom Annunciation feature allows the customer to select up to 16 different fault code
messages to be sent to an annunciator, when the fault becomes active. A listing of fault codes
can be viewed with InPower, by opening the Events Configuration folder.

The desired fault codes are entered directly into a Data Table (Figure 185). Select the Custom
Annunciation feature and double click on the Data Table Value cell. The Data Table will open
in a new window.

To enter or edit data in the table, click on the first Event Identifier field, then enter the desired
fault code number into the edit box, next to the check mark. Click on the check mark to enter
the fault code number into the Event Identifier table. Repeat this process until all of the desired
fault codes have been entered.

Click on the Save button, to update the Data Table changes. Click on Close, when you are
finished adding fault codes or making changes.

Click on the Save Trims button, on the toolbar, to write the Custom Annunciation Data Table
settings to the device. Press the Reset button, on the GLC, to download the new data table
setting from the base board to the GLC.

The Paste button is used to import spreadsheet data from an Excel spreadsheet. This feature is
useful for configuring multiple devices with the same event fault codes.
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FIGURE 185. LONWORKS - PCC 3200 CUSTOM ANNUNCIATION

17.3.2 Custom Outputs
The Custom Outputs feature allows the customer to select up to 8 different fault codes to be
sent to a Digital Master Control (DMC) or other third party monitoring device when the fault
becomes active. (Custom Outputs are not read by PowerCommand for Windows monitoring
software.) A listing of fault codes can be viewed with InPower, by opening the Events
Configuration folder.

The desired fault codes are entered directly into a Data Table (Figure 186). Select the Custom
Outputs feature and double click on the Data Table Value cell. The Data Table will open in a
new window.

To enter or edit data in the table, click on the first Event Identifier field, then enter the desired
fault code number into the edit box, next to the check mark. Click on the check mark to enter
the fault code number into the Event Identifier table. Repeat this process until all of the desired
fault codes have been entered.

Click on the Save button, to update the Data Table changes. Click on Close, when you are
finished adding fault codes or making changes.

Click on the Save Trims button, on the toolbar, to write the Custom Annunciation Data Table
settings to the device. Press the Reset button, on the GLC, to download the new data table
settings from the base board to the GLC.

The Paste button is used to import spreadsheet value data from an Excel spreadsheet. This
feature is useful for configuring multiple devices with the same event fault codes.
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FIGURE 186. LONWORKS - PCC 3200 DEVICE

17.3.3 Device
The Device group of parameters allows the user to view and edit several parameters related to
the network site, the device and network performance. Use these settings as follows:

Site ID: The site ID must consist of no more than seven characters. The characters can only be
a combination of upper case letters, numbers and underscores. Do not use spaces, special
characters or lower case letters in the Site ID.

Location: Enter a description for the location of the unit (up to 16 characters).

Name: The device Name (tag) is used when sending system data. Provide a different name for
each device on the network (up to 16 characters).

LonWorks Software Version: Displays the current LonWorks network software version.

Terminated: Displays the network termination switch setting on the network module (the
network module must be installed and enabled to be read).

Update Interval: Use to set the send time for analog network variables and the network status
check. The default 2 second interval is recommended.

Test Interval: Use to set the send time for the network test interval. The default 10 second
interval is recommended.

LonWorks Card: Use to enable the network module. (The network module must be physically
installed before the feature can be enabled.)
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After making any necessary adjustments, click on the Save Trims button, on the toolbar, to
write the settings to the device. Press the Reset button, on the GLC, to download the new
settings from the base board to the GLC.

FIGURE 187. LONWORKS - PCC 3200 CUSTOM OUTPUTS

17.3.4 Dialout
The Dialout group of parameters allows the customer to configure the dialout settings for remote
monitoring of devices on the network. Use these settings as follows:

Host 1 thru 5: Enable the number of remote monitoring sites (hosts) that you want to send
alarm messages to. Click on the value cell and select Enabled from the drop-down list.

Dialout Retries: Used to set the number of dialout retries, if the first alarm dialout fails while
attempting to deliver a dial out message. The default setting 10, is the recommended setting. A
setting of zero, is equal to one attempt.

(Dialout) Retry Delay: Enter the time delay between dialout attempts. The recommended
setting is 60 seconds.

Dialout Break: When enabled, this feature breaks a current connection after two minutes in
order to complete a dialout.

Connection Timeout: After a dialout command has been sent to the modem, this feature
specifies how long to wait for the site to connect to the remote monitoring location. The default
setting is 60 seconds.

If the site does not connect with the remote monitoring location, it will dialout to Host 2, Host 3,
etc. (if additional hosts are enabled) until it connects. If it still does not connect, it will repeat the
process, beginning with Host 1, based on the number of retries that have been set.

182 901-0108 (Issue 10)



12-2013 17. Network Applications

After making any necessary adjustments, click on the Save Trims button, on the toolbar, to
write the settings to the device. Press the Reset button, on the GLC, to download the new data
from the base board to the GLC.

FIGURE 188. LONWORKS - PCC 3200 DIALOUT

17.3.5 Fault Settings
The Fault Settings group allows you to name the network message for Network Faults 1 through
4, and view their status. This feature also allows you to assign a fault code to the Battery
Charger AC Failure and S1 Circuit Breaker Trip.

Use these settings as follows:

Network Fault Name 1 thru 4: Allows the user to enter a description for network input faults 1
through 4. Double click the value cell and enter the new description. The new name should
define the customer network input such as Open Louvre or Remote Cooling Fan On. This fault
name will be displayed when the network input becomes active.

Network Fault Status 1 thru 4: Displays the current status of the network input fault (Active or
Inactive) for each of the four network faults. Use the Refresh button, on the toolbar, to update
the value fields.

Battery Charger AC Failure Fault Code: Enter a fault code number for an event related to this
fault. As an example, use fault code 1311 or 1312.

Refer to the Event Configuration folder for fault code descriptions.

Utility Circuit Breaker Trip Fault Code: Enter a fault code number for an event related to this
fault. As an example, for paralleling applications, use fault code 1317 or 1318.
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After making any necessary adjustments, click on the Save Trims button, on the toolbar, to
write the settings to the device. Press the Reset button, on the GLC, to download the new data
from the base board to the GLC.

FIGURE 189. LONWORKS - PCC 3200 FAULT SETTINGS

17.3.6 PCC 3200 Events Configuration
When setting up the network settings for a PCC 3200 control, refer to the Events
Configuration folder (Figure 190).

Review the settings in this parameter group to make sure the desired settings are configured.

To configure a fault to dial out for remote monitoring, go to the Notification value field for the
fault and double click on the Notification value cell, select Dial Out from the drop-down list.

After making any necessary adjustments, click on the Save Trims button, on the toolbar, to
write the settings to the device. Press the Reset button, on the GLC, to download the new data
from the base board to the GLC.
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FIGURE 190. PCC 3200 - EVENT CONFIGURATION

17.4 PCC ATS
The LonWorks directory for a typical PowerCommand transfer switch (PCC ATS) contains all of
the network settings within one folder. (To enable the network feature, use the Feature Enable
folder, in the Adjustments directory.)

Press the Reset button on the NCM, after saving changes to the PCC 2100, to write the
changes from the base board to the NCM.

Start InPower and connect to the port (COM1, COM2, etc.) that matches the COM port on the
service PC, that is being used for the PCC ATS connection.

Open the Adjustments folder, and then the LonWorks folder (Figure 191). This section
describes how to use each of the parameter groups, in the LonWorks directory.

Network Error: Displays the current status of the Network Error fault (Active or Inactive) in the
Value field. The Network Error fault signifies that the network is not working when the fault is
active. Use the Refresh button, on the toolbar, to update the value fields.

Network Wink: Use this feature to test a network module. Click on the Value cell and select
Active to send a test signal to the device. The service led will wink when the message is
received, indicating that the network connection and the network module are working.

Host 1 thru 5: Enable the number of remote monitoring sites (hosts) that you want to send
alarm messages to. Click on the value cell and select Enable from the drop-down list.

Dialout Break: When enabled, this feature breaks the connection after two minutes in order to
complete a dial out.

Dialout Retries: Used to set the number of dialout retries, if the first alarm dialout fails while
attempting to deliver a dial out message. The default setting 10, is the recommended setting. A
setting of zero, is equal to one attempt.

Dialout Retry Delay: Enter the time delay between dialout attempts. The recommended setting
is 60 seconds.
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FIGURE 191. LONWORKS - PCC ATS

Connection Timeout: After a dialout command has been sent to the modem, this feature
specifies how long to wait for the site to connect to the remote monitoring location. The default
setting is 60 seconds.

If the site does not connect with the remote monitoring location, it will dialout to Host 2, Host 3,
etc. (if additional hosts are enabled) until it connects. If it still does not connect, it will repeat the
process, beginning with Host 1, based on the number of retries that have been set.

Device Location: Enter a description for the location of the unit (up to 16 characters).

NameTag: The device Name Tag is used when sending system data. Provide a different name
for each device on the network (up to 16 characters).

Device Site ID: The site ID must consist of no more than seven characters. The characters can
only be a combination of upper case letters, numbers and underscores. Do not use spaces,
special characters, or lower case letters for the Device Site ID.

Network Test Interval: Use to set the send time for the network test interval. The default 10
second interval is recommended.

Network Update Interval: Use to set the send time for the network message updates. The
default 2 second interval is recommended.

Network Terminator: Displays the network termination switch setting on the network module
(the network module must be connected and enabled to be read).

NCM Software Version: Displays the current network software version installed in the network
module (NCM).
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NCM Battery Status: Displays the status (condition) of the batteries supplying voltage to the
network module (NCM).

After making any necessary adjustments, click on the Save Trims button, on the toolbar, to
write the settings to the device. Press the Reset button, on the NCM, to download the new data
from the base board to the NCM.

17.4.1 PCC ATS Event Configuration
When setting up the network settings for a transfer switch, refer to the Event Configuration
folder, in the Faults directory (Figure 192).

Review the last three columns of value settings. Dailout Active needs to be set to True, before
an event will dial out when it goes active. The Dailout Inactive must be set to True, to dial out
when the event goes Inactive.

FIGURE 192. FAULTS - EVENT CONFIGURATION - PCC ATS

17.5 Network Connection Setup
InPower, beginning with version 3.0, can configure devices over an FT-10 network. The service
PC must be setup for connecting to a network and the network must be commissioned and
operating.

The service PC must have LonMaker for Windows version 3.1 installed. This program is
available from Echelon. The service PC will need a gateway driver (either PCC-10 or SLTA-10,
depending on the device being used). Also, a copy of the network site database must be
obtained from the network, and installed on the service PC.

This section covers the required service PC setup steps for local and remote network
connections.
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Familiarity with LonMaker for Windows and the SLTA Link Manager program would be helpful
for creating a backup of the network site database and for troubleshooting connection problems.
This experience can be gained thorough LonMaker for Windows training and from PGA FT-10
Networks training.

Install LonMaker for Windows software on the service PC following the instructions provided by
Echelon.

· Gateway Driver Installation and Setup

If the network gateway driver, has not already been installed, follow these instructions:

A copy of the SLTA-10 gateway driver is included on the LonMaker for Windows CD. Gateway
drivers are also available from the Echelon web site at (www.echelong.com). Install the driver
that matches the gateway device type that will be used to connect to the network.

Most applications will use either an SLTA-10 external gateway, or a PCC-10 gateway card, in
the service PC.

In this example the SLTA-10 installation and setup will be described.

1. Locate the SLTA-10 gateway driver on the CD, double click on the slta10....exe file to
begin the driver installation.

2. From the Setup window, select Next to view the license agreement.

3. Review the license agreement and select Yes, to accept the terms of the agreement.

4. In the Choose Destination Location window, select Next, to use the default destination
(recommended).

5. In the Select Program Folder window, select Next, to create the program folder.

6. Select No to the option of accessing the file from DOS.

7. Click on the Finish button to complete the installation setup.

17.5.1 Gateway Settings
Launch the SLTALink Manager from the Start menu (or the taskbar icon ). Click on the Link
menu and select New. To operate correctly, the name must be entered exactly as shown.

Local Setup: For a local network application, enter a name and type for the link, Name:
LocalSLTALON1 and click on the Local button, click on the Update Identifier box to select it,
then click on Next (Figure 194).
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FIGURE 193. SLTA LOCAL SETUP

Use the Serial Port drop-down arrow to select the serial port that the SLTA is attached to on
the monitoring PC. Use the Speed drop-down arrow to select 38400 as the communication
speed, click on Next to continue.

FIGURE 194. SLTA SETUP SPEED

Remote Setup: For a remote network application, enter a name and type for the link, Name:
RemoteSLTALON1 and click on the Remote button. Enter the network site name in single
quotes. Click on the Update Identifier box to select it, then click on Next (Figure 195).
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FIGURE 195. SLTA REMOTE SETUP

Use the Dialing Address dialog to enter the area code (if applicable) and phone number of the
phone line that is connected to the modem at the remote site. Skip the Configure Line setting,
connection speed will be set automatically. Click on the Next button and then the Finish button
to complete the setup.

FIGURE 196. SLTA REMOTE DIALING ADDRESS

190 901-0108 (Issue 10)



12-2013 17. Network Applications

FIGURE 197. SLTA LINK PROPERTIES

17.5.2 Alarm Settings
After making the initial local or remote gateway settings, a Link Properties dialog box is
displayed. This feature is used to setup the gateway for delivering alarms.

Setup the Command Line by clicking on the Browse button. Navigate to and select the a file
named PostEchBvAlarm.exe. This file is located in the following directory:

C:\Program files\common files \cummins shared\power generation\

Double click on each folder, beginning with the Program Files folder, until you reach the
PostEchBvAlarm.exe file. Double click on this file, and the directory path and file will be added
to the Command Line.

The Command Line needs to be appended with additional instructions. Refer to Figure 197.
Click inside the Command Line and use the right arrow key, to reach the end of the Command
Line. Enter the following text, including spaces, enter a space before the first percent symbol:

%id% %LINKNAME%

Click on Finish to complete the Link Properties settings.

17.5.3 Importing the Network Site Database
The network site database is created by the network installer. A backup copy of the database
can be created from the PC used to install the network. Use the LonMaker for Windows Backup
feature, with the Backup Database selection. LonMaker for Windows creates the backup copy
of the network site, as a compressed (ZIP) file.

NOTE: The network name (site ID) must consist of no more than seven characters.
The characters can only be upper case letters, numbers and underscores.
Make sure the network installer does not use lower case letters, special
characters, or spaces for the network name.

Obtain the network site database from the network installer. If the site database is not available,
and you are able to connect to the network site with Lonmaker for Windows, use the Recover
Database from Network selection, displayed after selecting New Network.
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The site backup database file is usually small enough to be transferred to a floppy disk. Locate
the site backup file (sitename.zip) using Windows Explorer. Double click on the file to launch
the WinZip utility.

Extract the file to the root directory where LonMaker for Windows is installed (typically C:/).
When finished extracting the file, close the WinZip program and close Windows Explorer.

17.5.4 Local Network Site Setup
The following procedures describe how to setup InPower for local communication.

The Setup feature is accessed from the Start menu by clicking on the Power Generation ->
InPower program group. Click on Setup, to launch the Setup dialog.

In this example the user will define a new site for a local network application.

17.5.5 Site Setup
Click on the Site Setup tab to access the Site Setup dialog. Click on the Add button, to display
the Create Site dialog (Figure 198).

17.5.6 Create Site
Enter the following information in the dialog to create a new local site:

Site Type - Select Network from the drop down list.

Network - Use the drop-down list and select the name for the network you want to connect to.
(If the network name is not present in the drop-down list, cancel the setup and import the
network site database first.)

Site Name - Enter the name as it appears in the preceding Network name.

Location - Enter Local, from the drop-down list.

SLTA Password: This feature is typically not used. If the SLTA has a password, enter it here.

Click on the OK button to save the new site. This establishes the site, in network applications it
is not necessary to create devices for the site because the devices that are at the site are
imported from the network database.
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FIGURE 198. CREATE SITE DIALOG

FIGURE 199. TYPICAL LOCAL NETWORK CONNECTION SETUP

17.5.7 Remote Network Site Setup
The following procedures describe how to setup InPower for remote communication.

The Setup feature is accessed from the Start menu by clicking on the Power Generation -
InPower program group. Click on Setup, to launch the Setup dialog.

In this example the user will define a new site for a remote network application.

17.5.8 Site Setup
Click on the Site Setup tab to access the Site Setup dialog. Click on the Add button, to display
the Create Site dialog (Figure 200).

17.5.9 Create Site
Enter the following information in the dialog to create a new remote site:

Site Type - Select Network from the drop down list.
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Network - Use the drop-down list and select the name for the network you want to connect to.
(IF the network name is not present in the drop-down list, cancel the setup and import the
network site database first.)

Site Name - Enter the name as it appears in the preceding Network name.

Location - Enter Remote, from the drop-down list.

Telephone Number: Enter the telephone number of the phone line connected to the modem at
the site location.

SLTA Password: This feature is typically not used. If the SLTA has a password, enter it here.

Click on the OK button to save the new site. This establishes the site, in network applications it
is not necessary to create devices for the site because the devices that are at the site are
imported from the network database.

FIGURE 200. CREATE SITE DIALOG

FIGURE 201. TYPICAL REMOTE NETWORK CONNECTION SETUP

17.5.10 InPower Communications Setup
After setting up InPower for either a local or remote network site, the Communications setup
needs to be completed.
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Click on the Communications setup tab, then establish a Lon Network Connection for Local or
Remote, or both if you plan to make local and remote network connections.

Local: Click on the drop-down arrow and select SLTALON1 from the list (or use PCCLON1 if
using PCC-10 card). Click on the Apply button (Figure 202).

Remote: Click on the drop-down arrow and select SLTALON1 from the list (or use PCCLON1 if
using PCC-10 card). Click on the Apply button.

Click on the OK button when finished.

FIGURE 202. NETWORK COMMUNICATION SETUP

17.6 Network Connection Example
Start InPower and connect to the port (typically the site name created in Site Setup). All of the
devices on the network will be displayed in the Device Explorer directory (Figure 203).

If the connection is not made, check the SLTALink Manager, to view the status of the
connection of the service PC to the gateway. Launch the SLTALink Manager from the Echelon
folder in the Start - Programs menu, or from the Taskbar.

If the service PC is not connected to the gateway, select the gateway device from the
Select/Action menu pick, in the Link menu, and click on the Connect Now button.

If the gateway is connected, and the network site still does not open, make sure the network is
operating. It may be necessary to resynchronize the network using LonMaker for Windows.

In this example, the network settings for the Controls Communication Module - Genset (CCM-G)
are accessed over the network. Open the Adjustments folder, and then open the Network
folder (Figure 204).

This section describes how to use each of the adjustable parameters, in the CCM-G Network
directory.
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Network Wink: Use this feature to test a network module. Click on the Value cell and select
Active to send a test signal to the device. The service led will wink when the message is
received, indicating that the network connection and the network module are working.

InPower Timeout: If displayed, do not adjust, this parameter will be removed.

Site ID: The site ID must consist of no more than seven characters. The characters can only be
a combination of upper case letters, numbers and underscores. Do not use spaces, special
characters, or lower case letters for the Device Site ID.

Device Name Tag: The Device Name Tag is used when sending system data. Provide a
different name for each device on the network (up to 16 characters).

(Network) Test Interval: Use to set the send time for the network test interval. The default 10
second interval is recommended.

Minimum Send Time: Use to set the send time for the analog data network variables. The
default 2 second interval is recommended.

Network Configuration: Displays the device network application. Self installed devices read
Local (factory default) and are not available to InPower for adjustment or monitoring. Devices
that are self installed are configured using the dip switches on the device.

When the self-installed feature is not used, the configuration is External and the device is
available to InPower.

After making any necessary adjustments, click on the Save Trims button, on the toolbar, to
write the settings to the device.

FIGURE 203. NETWORK CONNECTION
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FIGURE 204. CCM-G - NETWORK FOLDER

17.6.1 Setup Dialout
The Dialout group of parameters allows the customer to configure the dialout settings for remote
monitoring of devices on the network. Use these settings as follows:

Redial Attempts: Used to set the number of dialout retries, if the first alarm dialout fails while
attempting to deliver a dial out message. The default setting 10, is the recommended setting. A
setting of zero, is equal to one attempt.

Redial Delay: Enter the time delay between dialout attempts. The default, 60 seconds, is the
recommended setting.

Dialout Site 1 thru 5: Enable the number of remote monitoring sites (hosts) that you want to
send alarm messages to. Click on the value cell and select Enabled from the drop-down list.

Dialout Break: When enabled, this feature breaks a current connection after two minutes in
order to complete a dialout.

Connection Timeout: After a dialout command has been sent to the modem, this feature
specifies how long to wait for the site to connect to the remote monitoring location. The default
setting is 60 seconds.

If the site does not connect with the remote monitoring location, it will dialout to Host 2, Host 3,
etc. (if additional hosts are enabled) until it connects. If it still does not connect, it will repeat the
process, beginning with Host 1, based on the number of retries that have been set.

After making any necessary adjustments, click on the Save Trims button, on the toolbar, to
write the settings to the device.
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In this example, InPower is connected to an Annunciator over the network. Open the
Adjustments folder, and then open the Setup LED's and Horn folder (Figure 206).

The LED Index (number) for each LED is listed in the first column. The Color, Horn and Flash
columns are all adjustable to the desired type of annunciation. The Status column indicates if
the input is active.

To change the setting for the color, the horn or to enable the LED flash setting, Click on the
value cell for the desired item. The item selected will be displayed in the edit box, in the upper
right of the dialog. Click on the drop-down arrow and a list of the choices will be displayed. Click
on the desired option. Click on the check mark to enter the selection in the Data Table. Repeat
this process until all of the desired settings have been chosen.

Click on the Save button, to update the Data Table changes. Click on Close, when you are
finished adding fault codes or making changes.

After making any necessary adjustments, click on the Save Trims button, on the toolbar, to
write the settings to the device.

FIGURE 205. CCM-G - SETUP DIALOUT
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FIGURE 206. ANNUNCIATOR - SETUP LED'S AND HORN

In this example, InPower is connected to a DIM module, with an expansion board, over the
network. Open the Adjustments folder, and then open the Activate Delays folder (Figure 207).

The first column displays the first eight relays from the DIM and the second eight relays (9
through 16) on the expansion board. This feature adds a delay between the time the input
becomes active and when the relay is energized. Entering a delay time (in seconds) into the
value cell for the relay, and saving the change, activates the delay.

To activate or change a delay, double click on the Value cell for the desired relay, the current
value will be highlighted. Enter the desired delay time in seconds.

Click on the Save Trims button, on the toolbar, to write the new value to the device.
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FIGURE 207. DIM - ACTIVATE DELAYS
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18 Help
Use the Help menu to find information about using InPower, to find Service and Support
information, and to find out about the installed InPower product type and software version.

18.1 Search for Help On...
The Help - Search for Help On... feature allows searching for help on a specific topic or keyword
(standard Windows Help format). Access this feature by clicking on the Help menu, then click on
Search for Help On... .

18.2 Contents
The Help - Contents feature provides access to the list of subjects in the InPower help file
(standard Windows Help format). Access this information by clicking on the Help menu and then
clicking on Contents.

18.3 How to Use Help
The Help - How to Use Help feature displays the standard Windows Help Topics dialog. Use
this feature to find answers to basic Windows operation questions. Access this information by
clicking on the Help menu, and then click on How to Use Help.

18.4 Service and Support
The Help - Service and Support feature lists information about where to call for InPower product
support. To view this information, click on the Help menu, then click on Service and Support.

18.5 About Device Explorer
The Help - About... feature initiates the About Device Explorer box. This box displays the
product type and software version. The expiration date for the software is also shown. To view
this information, click on the Help menu, and then click on About....
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19 Glossary
Applet - A sub-set of software functions that may be included in one or more Tools. They
provide the building-blocks from which the Tools are constructed.

ATS - Acronym for Automatic Transfer Switch.

Automatic Voltage Regulator (AVR) - An electronic unit used to control the output voltage of a
genset.

BIT - Acronym for Built-in Test.

Calibrating - The process of reprogramming a device. This requires the ESDN version of
InPower.

Calibration - Term used to describe the program and factory settings for a device.

Calibration Table - Name used to refer to a Data Table, XY Table, or XYZ Table that contains
one or more calibration variables.

Calibration Variable - Data that is stored in the controller's non-volatile memory, and which
may not be altered after sale by either a customer or service technician.

Capture File - A capture (.cap) file contains all of the trim values, monitor values, and table
values of a given device (e.g. Generator set). This file can be thought of as a “template” for
configuring other devices of the same type, or it can be used as a backup file.

Channel - A channel is the physical communication media that connects the devices and the
properties of these media (such as transmission speed).

CSV File - Comma Separated Value file (same as a comma delimited file). The file format used
by InPower to save datalog information. Allows the file to imported into Microsoft Excel.

Data Table - Data table is a structure containing a variable in each of the columns. The data
cells are viewed and edited in spreadsheet format.

Device - As used in InPower, refers to any one of a series of application controllers used in
Power Generation applications. These include: Generator-drive engine controllers, Genset
controllers and Automatic Transfer Switch controllers.

Electronic Control Module (ECM) - The hardware residing on an engine which carries out all
the engine management functions (e.g. timing, fueling).

Electronic Software Database & Network (ESDN) - A worldwide Cummins corporate
database of released electronic software. It provides calibration files reprogramming devices.

Genset Open Architecture Link (GOAL) - A proprietary protocol developed by PGG to support
the communications functions of Power Generation Group controls.

Graphical User Interface (GUI) - A term used to describe the way in which a user interacts
with the software program.

HBF - Acronym for High Blowby Flow.

Initial Calibration - Manually select software to download.

InPower - Name given to the Power Generation Products based service tool. This tool is similar
to INSITE in function, but it has a significantly different architecture.

MON - A communications protocol for one device connected to the service tool using RS-485
and RS-232 serial communications. All devices can communicate with the service tool.
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MONNet - A communications protocol for more than one device connected to the service tool
using RS-485 communications only.

Network Connection - This term is used to describe a connection using the MONNet protocol
and an RS-485 adapter.

Parameter - This term is used with InPower to refer to properties whose values determine the
behavior of a device. With InPower there are two main types of properties; trims that have a
range of numeric values, and settings that consist of a small number of predefined values such
as On or Off.

Physical Connection - This term is used to describe a connection using the MON protocol and
no RS-485 adapter.

Port - As used in InPower, it refers to the channel by which a connection can occur. Port
connections can occur with COM ports, or with Simulator or Capture files in the InPower
directory structure.

PowerCommand® Control (PCC) - A microprocessor based genset monitoring, metering and
control system with integrated AVR and engine governing.

Protocol - Protocol is a language that each node on a network knows how to speak and
interpret. The protocol is what allows devices to exchange messages with one another.

Save Trims - Term used with InPower to indicate the process of permanently storing parameter
changes to a device.

Site - The name of a connection setup (COM1, COM2, etc).

TAPI (Telephony API) - A programming interface that allows Windows client applications to
access voice services on a server. Designed to provide interoperability between PCs and
telephone equipment.

Template - 1. View template in InPower describes how to display data table information. 2.
Template can also describe the Capture (.CAP) file that contains trim values that can be used to
configure multiple-devices (e.g. genset controllers).

Tool - A set (or bundle) of software applets that are targeted at a specific customer or end-user
function.

Trim - Data that is stored in the controller's non-volatile memory, but which may be altered after
sale by either a customer or service technician.

Update Calibration - Automatically updates software, saves user information, and transfers to a
new control.

Volatile/Non-volatile Memory - The contents of volatile memory is lost following a loss of
power to the controller. Data stored in non-volatile memory is retained.

204 901-0108 (Issue 10)





Copyright © 2013 Cummins Power Generation, Inc. All rights reserved.
Cummins, the "C" logo, and "Our energy working for you." are trademarks of
Cummins Inc.
InPower is a trademark of Cummins Inc.


	Table of Contents
	1. InPower™ Software License Agreement
	2. Introduction
	2.1 Warning
	2.2 InPower
	2.2.1 Commercial Products
	2.2.1.1 Interface Harness Kits for Commercial Products

	2.2.2 Consumer Products
	2.2.2.1 Interface Harness Kits for Consumer Products

	2.2.3 Null Modem Cable Configuration

	2.3 About This User's Guide
	2.4 Supported Devices
	2.5 System Requirements
	2.5.1 Recommended PC
	2.5.2 Administrative Rights

	2.6 Program Directories Installed with InPower
	2.6.1 Monitor
	2.6.2 Strip Chart
	2.6.3 Data
	2.6.4 Captured Files
	2.6.5 Simulator

	2.7 Start Menu Group Shortcuts
	2.7.1 Readme File

	2.8 User Interface
	2.9 How to Get Service
	2.10 Notification of Tool Expiration

	3. Setup
	3.1 General Setup
	3.2 Unit of Measurement
	3.3 User Setup - System Administration
	3.4 Capture File Options
	3.5 Site Setup
	3.6 Create Site
	3.7 Device Setup
	3.8 Communications Setup
	3.9 PCC 1300 and PCC 1301 InPower Setup
	3.10 PCC 1302 InPower Setup
	3.11 PCC 2300 and PCC 3300 InPower OEM Setup
	3.12 PCC 3100 InPower Setup
	3.13 PCC 3200 w/CAN (PCC 3201) InPower Setup
	3.14 MCM 3320 InPower Setup
	3.15 Monnet InPower Setup
	3.16 HMI InPower Setup

	4. InPower Basics
	4.1 How to Start InPower
	4.2 The Main Window
	4.2.1 Main Window Example

	4.3 Menu Descriptions
	4.3.1 Port
	4.3.2 Device
	4.3.3 Edit
	4.3.4 View
	4.3.5 Help

	4.4 User Interface
	4.4.1 Keyboard Access
	4.4.2 Toolbar
	4.4.2.1 Toolbar Example

	4.4.3 Dialog Boxes
	4.4.4 Mouse Menu Functions

	4.5 How to Terminate InPower

	5. Genset Service
	5.1 Commercial Genset Service
	5.1.1 Connecting to a Genset
	5.1.1.1 Connecting to PS 0500
	5.1.1.2 Connecting to PCC 1100
	5.1.1.3 Connecting to a Genset with a PCC 1300 Control
	5.1.1.4 Connecting to a Genset with a PCC 1301 Control
	5.1.1.5 Connecting to PCC 1302
	5.1.1.6 Connecting to a Genset with a PCC 2100 Control
	5.1.1.7 Connecting to PCC2300 and PCC3300
	5.1.1.8 Connecting to a PCC 3100 Genset
	5.1.1.9 Connecting to a PCC 3200 Genset


	5.2 Consumer Genset Service
	5.2.1 Connecting to a Genset
	5.2.2 Connecting to an HQD Inverter/Charger, Transfer Switch, or Display and an RV Inverter and GSAA
	5.2.3 Connecting to Marine Devices
	5.2.3.1 Programming A Marine Control
	5.2.3.2 Programming A Marine Display
	5.2.3.3 Programming A Network Interface Module (NIM)


	5.3 Starting InPower
	5.4 Genset Adjustments
	5.4.1 Adjustment Basics
	5.4.2 Adjustment Features
	5.4.3 Making Adjustments
	5.4.4 Saving Adjustments

	5.5 Adjustment Examples
	5.6 Test
	5.6.1 Commercial Gensets
	5.6.2 Consumer Gensets
	5.6.3 Override Requests
	5.6.4 Override Commands
	5.6.5 Override Status
	5.6.6 Set High Idle
	5.6.7 Inputs
	5.6.8 Manual Operation
	5.6.9 Outputs
	5.6.10 Fault Simulation
	5.6.11 Self Test
	5.6.12 Speed Override
	5.6.13 Single Cylinder Cutout Test


	6. ATS Service
	6.1 ATS Service
	6.1.1 Connecting to An ATS with the Original Digital Display
	6.1.2 Starting InPower

	6.2 ATS Adjustments
	6.2.1 Adjustment Basics
	6.2.2 Adjustment Features

	6.3 Service Replacement Controls
	6.3.1 Making Adjustments
	6.3.2 Saving Adjustments

	6.4 Adjustment Examples
	6.4.1 Controller Mode
	6.4.2 List of Parameters Requiring the Refresh Controller Feature
	6.4.3 Exerciser Clock
	6.4.4 Exception Table
	6.4.5 Time Delays
	6.4.6 Voltage Adjustment - For Display
	6.4.7 Feature Enable
	6.4.8 PTC Settings

	6.5 Test
	6.5.1 Test - Remote Features
	6.5.2 Test - Setup Features
	6.5.3 Test - S1 Protection (PTC Test)


	7. Master Control Module Service
	7.1 Connecting an MCM3320
	7.2 Configuring the MCM3320

	8. Monitor
	8.1 Monitor and Datalog
	8.2 Monitor Dialog
	8.2.1 Monitor Dialog Features
	8.2.2 Adding Parameters
	8.2.3 Saving Parameters


	9. Faults and the Fault Information System
	9.1 Commercial Device Fault Information
	9.1.1 Fault Information Window
	9.1.2 Clearing Inactive Faults
	9.1.3 Snapshot
	9.1.3.1 Devices That Do Not Support Snapshot

	9.1.4 Fault Information System
	9.1.4.1 Fault Code Diagnostics
	9.1.4.2 Fault Code Overview
	9.1.4.3 Troubleshooting Steps
	9.1.4.4 Symptom Based Diagnostics
	9.1.4.5 Additional Information
	9.1.4.6 Component Listing
	9.1.4.7 Specifications
	9.1.4.8 Theory of Operation
	9.1.4.9 Wiring Diagrams
	9.1.4.10 Glossary


	9.2 Consumer Device Fault Information
	9.2.1 Fault Information
	9.2.2 Advanced Fault Information
	9.2.3 Fault History
	9.2.4 Fault Occurrences
	9.2.5 Fault Bypass Info
	9.2.6 Clearing Inactive Faults
	9.2.7 Consumer Device Fault Information

	9.3 ATS Faults
	9.3.1 Clear Faults
	9.3.2 Event History Log
	9.3.3 Event Records


	10. Event Handler
	10.1 Receiving Events
	10.1.1 Devices That Cannot Receive Events

	10.2 Displaying Events
	10.2.1 Alarms Popup
	10.2.1.1 Columns in the Alarms Popup

	10.2.2 Event Detail
	10.2.2.1 Columns in the Event Details Dialog



	11. Strip Chart
	11.1 Strip Chart
	11.1.1 Example of a Strip Chart
	11.1.2 Starting the Strip Chart Feature

	11.2 Creating a Custom Strip Chart
	11.2.1 Adding Parameters
	11.2.2 Parameter Properties Dialog
	11.2.3 Sampling Rate Dialog
	11.2.4 Strip Chart Menu Bar Functions
	11.2.5 Context Menu Features
	11.2.6 Chart Customization Dialog
	11.2.7 Printing a Strip Chart
	11.2.8 Viewing Logged Data


	12. Capture File
	12.1 PCC 1100 Limitation
	12.2 Capture File
	12.3 Creating a Capture File
	12.3.1 Creating a Capture File Automatically

	12.4 Viewing a Capture File
	12.5 Writing to a Device

	13. Simulator
	14. Reports
	14.1 Creating a Report
	14.2 Support Reports

	15. Event Configuration
	15.1 Devices That Do Not Support Event Configuration
	15.2 Fault Effect
	15.3 Notification

	16. Remote Communication
	16.1 Remote Connections
	16.2 Remote Site Setup
	16.2.1 Site Setup
	16.2.2 Create Site
	16.2.3 Device Setup
	16.2.4 Communications Setup

	16.3 Remote Connection with InPower
	16.4 Dialout Configuration
	16.5 Modems
	16.5.1 Modem Configuration Strings

	16.6 Remote Monitoring

	17. Network Applications
	17.1 Network Configuration
	17.2 PCC 2100
	17.2.1 Custom Annunciation
	17.2.2 Custom Relay Events
	17.2.3 Device
	17.2.4 Dialout
	17.2.5 Fault Settings
	17.2.6 PCC 2100 Events and Faults Configuration

	17.3 PCC 3200
	17.3.1 Custom Annunciation
	17.3.2 Custom Outputs
	17.3.3 Device
	17.3.4 Dialout
	17.3.5 Fault Settings
	17.3.6 PCC 3200 Events Configuration

	17.4 PCC ATS
	17.4.1 PCC ATS Event Configuration

	17.5 Network Connection Setup
	17.5.1 Gateway Settings
	17.5.2 Alarm Settings
	17.5.3 Importing the Network Site Database
	17.5.4 Local Network Site Setup
	17.5.5 Site Setup
	17.5.6 Create Site
	17.5.7 Remote Network Site Setup
	17.5.8 Site Setup
	17.5.9 Create Site
	17.5.10 InPower Communications Setup

	17.6 Network Connection Example
	17.6.1 Setup Dialout


	18. Help
	18.1 Search for Help On...
	18.2 Contents
	18.3 How to Use Help
	18.4 Service and Support
	18.5 About Device Explorer

	19. Glossary

